Introduction to MicroWorlds Pro

A Logo-Based Hypermedia Environment

Irene Smith & Sharon Yoder

@ SKyIES Publishing

Copyright © 9/21/2000 Irene Smith and Sharon Yoder.

This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 Unported License.
About the Authors

Dr. Sharon Yoder has taught mathematics and computer science at the junior high and high school level for 15 years. Her most recent public school experience was as a secondary computer science teacher and computer coordinator involved in developing system-wide computer curriculum and planning teacher inservice training.

In addition, she has taught mathematics, computer science, and computer education at a number of universities in northeastern Ohio, including Kent State University, the University of Akron, and Cleveland State University. She worked closely with the Cleveland State University’s College of Education to develop the college's computer programming courses for teachers. After a year as an education specialist for Logo Computer Systems, Inc., for the last ten years, Sharon has taught a variety of computer education courses at the University of Oregon. At present she focuses her time on teaching technology courses for the preservice teacher education courses at the University of Oregon.

For the past several years, she has conducted workshops and presented papers at conferences nationwide and has been involved in a number of book-publishing projects, including The Beginners Guide to Stagecast Creator, A Beginners Guide to Home Page, Lookin’ Good—an Introduction to Document Design, and Introduction to AppleWorks 6.0. In addition, she has been a frequent contributor to Leading and Learning with Technology. She is a frequent presenter at regional and national technology in education conferences.

Dr. Irene Smith has been a high school and junior high educator for 20 years in the public school system in British Columbia. She earned her Ph.D. in computer education from the University of Oregon and has worked as a technology consultant and teaching assistant in Eugene, Oregon. Irene has taught courses at the University of Oregon and is a frequent presenter at regional and national computer conferences. She worked with the International Society for Technology in Education on the Intel project The Journey Inside: The Computer
conducting training workshops, developing training material, and editing *The Journey Inside* newsletter. At present, she is working at the University of Oregon's College of Education as an instructor.
# Table of Contents

**Introduction** ........................................................................................................ 1

1. Overview for Teachers ......................................................................................... 2
2. Overview for All Learners .................................................................................... 2
3. What Do I Need to Begin? .................................................................................... 3
4. Brave New Worlds ................................................................................................. 5
5. The Working World of *MicroWorlds Pro* .......................................................... 6
   New Projects .......................................................................................................... 8
   *Exploring the MicroWorlds Pro Menu Bar* .......................................................... 10
      *File Menu* ........................................................................................................ 11
      *Edit Menu* ....................................................................................................... 11
      *Text Menu* ...................................................................................................... 12
      *Pages Menu* ..................................................................................................... 13
      *Help Menu* ...................................................................................................... 14
6. Getting Some Help ................................................................................................. 14
   *MicroWorlds Help Topics* .................................................................................. 15
   *Vocabulary* ......................................................................................................... 16
   *Last Message* ..................................................................................................... 18
   *Show Balloons* ................................................................................................... 19
7. Exploring the Tab Area ......................................................................................... 19
   *Project tab* ......................................................................................................... 20
   *Processes tab* .................................................................................................... 21
   *Graphics tab* ..................................................................................................... 22
8. Using the Graphics tab ......................................................................................... 22
   *Editing Brush Shapes and Turtle Shapes* ............................................................ 24
9. The Toolbar ........................................................................................................... 25
   *Layout Buttons* .................................................................................................. 26
   *Object Creation Tools* ....................................................................................... 26
   *Object Editing Tools* ......................................................................................... 28
10. Tips and Techniques ............................................................................................. 28

**Chapter 2 ♦ Creating Images in MicroWorlds Pro** ................................. 31

11. Make a Masterpiece ............................................................................................ 38
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Introduction to <em>MicroWorlds Pro</em> Scripting</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>This book belongs to Giselle Gilbert</em></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Drawing With the Turtle</td>
<td>40</td>
</tr>
<tr>
<td>13</td>
<td>Saving and Printing Projects</td>
<td>45</td>
</tr>
<tr>
<td>14</td>
<td>Tips and Techniques</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 3 ❖ Working With Shapes</strong></td>
<td>49</td>
</tr>
<tr>
<td>15</td>
<td>Using Shapes</td>
<td>49</td>
</tr>
<tr>
<td>16</td>
<td>Creating and Editing Shapes</td>
<td>52</td>
</tr>
<tr>
<td>17</td>
<td>Using Logo Words With Shapes</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td><em>Make a Masterpiece</em></td>
<td>59</td>
</tr>
<tr>
<td>18</td>
<td>Tips and Techniques</td>
<td>59</td>
</tr>
<tr>
<td>19</td>
<td>Creating a Button</td>
<td>63</td>
</tr>
<tr>
<td>20</td>
<td>Editing Buttons</td>
<td>65</td>
</tr>
<tr>
<td>21</td>
<td>Using Buttons in Projects</td>
<td>66</td>
</tr>
<tr>
<td>22</td>
<td>Tips and Techniques</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 4 ❖ Working With Buttons</strong></td>
<td>63</td>
</tr>
<tr>
<td>23</td>
<td>Creating Additional Turtles</td>
<td>74</td>
</tr>
<tr>
<td>24</td>
<td>Using Multiple Turtles to Create Backgrounds</td>
<td>76</td>
</tr>
<tr>
<td>25</td>
<td>Controlling Turtles with Buttons and Logo</td>
<td>77</td>
</tr>
<tr>
<td>26</td>
<td>Putting Logo Commands on Turtles</td>
<td>81</td>
</tr>
<tr>
<td>27</td>
<td>Tips and Techniques</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 5 ❖ Multiple Turtles</strong></td>
<td>73</td>
</tr>
<tr>
<td>28</td>
<td>Creating and Using Text Boxes</td>
<td>87</td>
</tr>
<tr>
<td>29</td>
<td>Manipulating Text Boxes</td>
<td>93</td>
</tr>
<tr>
<td>30</td>
<td>Using Text Boxes in Projects</td>
<td>97</td>
</tr>
<tr>
<td>31</td>
<td>A MultiPage Project</td>
<td>99</td>
</tr>
<tr>
<td>32</td>
<td>Tips and Techniques</td>
<td>101</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 6 ❖ Working With Text Boxes</strong></td>
<td>87</td>
</tr>
<tr>
<td>33</td>
<td>Using Logo to Put Text in Text Boxes</td>
<td>103</td>
</tr>
<tr>
<td>34</td>
<td>Using Text Boxes to Contain Logo Code</td>
<td>106</td>
</tr>
<tr>
<td>35</td>
<td>Tips and Techniques</td>
<td>110</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 7 ❖ More With Text Boxes</strong></td>
<td>103</td>
</tr>
<tr>
<td>36</td>
<td>Working With Sounds</td>
<td>113</td>
</tr>
<tr>
<td>37</td>
<td>Using the Melody Editor</td>
<td>115</td>
</tr>
<tr>
<td>38</td>
<td>Using the Note Command</td>
<td>118</td>
</tr>
</tbody>
</table>
# Table of Contents

39. Adding Movies to Projects ................................................................. 119
40. Tips and Techniques ............................................................................. 122

**Chapter 9 ❖ Working With Sliders .................................................. 125**

41. Creating Sliders .................................................................................. 125
42. Editing Sliders ...................................................................................... 128
43. Using Sliders in Projects ................................................................. 130
44. Tips and Techniques ............................................................................. 134

**Chapter 10 ❖ Working With Colors and Pictures ............................. 137**

45. Sharing Graphics ................................................................................ 140
46. New Shapes Ready-made Colors .................................................... 144
47. Using Logo Code With Colors ......................................................... 147
48. Generating Random Numbers ........................................................... 149
49. Using Color in Projects .................................................................... 150
50. Tips and Techniques ............................................................................. 152

**Chapter 11 ❖ Using the Procedures Tab ............................................ 155**

51. Writing Procedures ............................................................................ 155
52. More Than One Procedure ............................................................... 159
53. Procedures That Use Procedures ...................................................... 163
54. Using Sound and Music in Projects ................................................. 167
55. Procedure Trees ................................................................................ 168
56. Tips and Techniques ............................................................................. 170

**Chapter 12 ❖ Designing Complex Projects ..................................... 173**

57. Designing Projects ............................................................................ 173
58. Navigation .......................................................................................... 177
59. More Advanced Use of Pages ............................................................ 181
60. Sharing Projects ................................................................................ 182
61. Tips and Techniques ............................................................................. 183
62. Looking Ahead .................................................................................... 185

**Appendix 1 ❖ Tools, Techniques, and Logo Words ......................... 187**

63. Toolbar ................................................................................................. 187
64. Graphics tab tools ............................................................................... 189
65. Button Techniques ............................................................................... 190
66. Media Object Techniques (Video, Melodies, QuickTime Movies, and Recordings) ................................................................. 191
67. Slider Techniques .............................................................. 192
68. Text Box Techniques ...................................................... 192
69. Turtle Techniques .............................................................. 193
70. Object Editing Popup Menus .............................................. 194
71. Logo Words ................................................................. 195

Appendix 2 ❖ MicroWorlds Pro Vocabulary ............................ 199

72. Grpahics ........................................................................ 199
73. Objects ............................................................................ 199
74. Text Editing ...................................................................... 200
75. Screen Management ....................................................... 200
76. Words and Lists .............................................................. 200
77. Disk Access ...................................................................... 200
78. Flow of Control and Logic ............................................... 201
79. Workspace ...................................................................... 202
80. Time .............................................................................. 202
81. Sound ............................................................................. 202
82. Special ............................................................................ 202

Index ..................................................................................... 203
Welcome to MicroWorlds Pro. MicroWorlds Pro is the newest version of software from Logo Computer Systems, Inc (LCSI.) This software, like their older products—Logowriter and MicroWorlds—are based on a powerful version of the Logo programming language.

The Logo language, originally developed at the Massachusetts Institute of Technology (MIT) in 1968 by Seymour Papert and his colleagues, is not difficult to master. Since this first language, several versions of Logo have been developed by a number of software companies. This latest version of the language combines the best features of the earlier ones and adds considerable new steps as well. With no previous background in programming, you will soon be successful in extending your Projects to include elements based directly on the Logo language.

MicroWorlds Pro provides unlimited fun and learning for students from the upper elementary level through adults. The software includes a versatile set of tools for conveniently integrating graphics, sounds, music, and text into computer-generated Projects. The software provides you with objects such as Turtles, Buttons, Text boxes, and Sliders. Combined with the included Logo language these options provide you with one of the most versatile multimedia authoring environments available today.

In this book, you will learn how to travel the world of MicroWorlds Pro to create your own products. You will learn about the structure of MicroWorlds Pro and how to use the various tools and objects that make up the environment included. As you work you will undoubtedly learn a bit of Logo programming.

If you are interested in further developing your skills in programming in the Logo language and extending your skills in using MicroWorlds Pro, you will want to locate a second book MicroWorlds Pro—Hypermedia Project Development and Logo Scripting. This second book is written specifically to build on the ideas and concepts you will master as you complete the examples included here. This book is also available from SKyIES Publishing.
Overview for Teachers

If you are a teacher or a teacher of teachers, this book will help you learn the MicroWorlds Pro environment in depth. However, there is much more to the software than just learning to use it. Because MicroWorlds Pro was developed by a company deeply committed to the Logo philosophy (which is best explained in Seymour Papert’s book Mindstorms: Children, Computers, and Powerful Ideas), you should balance your learning and/or teaching of MicroWorlds Pro with learning about and/or applying the Logo philosophy.

Although this book is not as technical as a reference manual, it does contain detailed explanations to help you understand how MicroWorlds Pro works. It also includes an introduction to the Logo programming language. This book is designed to help you learn about MicroWorlds Pro beyond a surface level.

If you are a teacher of younger students, you should keep in mind that this book is in no way designed to model the way you should teach MicroWorlds Pro in the classroom. Your teaching should encompass the exploratory discovery learning emphasized in the Logo philosophy. You will probably not want to teach a formal lesson each day.

On the other hand, if you are teaching older students—for example, in a computer science class—you may want to use a more structured approach or perhaps combine the two approaches. Regardless, you should be aware that there is nothing magical about the sequence in which topics are presented in this book. There are many appropriate paths for learning about MicroWorlds Pro. You may choose to flip back and forth focusing on the topics as they attract your interest.

Overview for All Learners

This book isn’t intended to give you an entertaining read. Instead, it is written to teach you MicroWorlds Pro in a structured manner. The major portion of the book is divided into short chapters, each of which focuses on a particular tool, object, word, or idea. There are any number of examples and demos that you should replicate as you experiment in the MicroWorlds Pro environment. Working with the software at your computer while reading makes a great learning situation.

You will find yourself doing structured problem solving as you explore the ideas. Many of these ideas could be easily used in other environments as well. As you work through this book, make a conscious effort to transfer what you learn about MicroWorlds Pro to other computer situations and problems that you face.
This book contains material you will want to flag as reference material. For example, the appendices summarize all the techniques and Logo words used in this book. In addition you will find a list of Logo primitives available in MicroWorlds Pro. (The word primitive refers to a word that Logo “knows.”) It is not necessary to memorize all the keys and techniques needed to work with MicroWorlds Pro or all the Logo primitives. With the assistance of the online Help included in the software and ready access to this book, you can quickly research the information you require.

MicroWorlds Pro introduces some special vocabulary that all users will need to know. In this book, references to MicroWorlds Pro Projects and Pages are capitalized, as are references to MicroWorlds Pro objects—Turtles, Buttons, Sliders, and Text boxes. First-level and second-level menu options are boldfaced, along with references to Logo codes, commands, and procedures when they appear in regular text and when they are part of the name of MicroWorlds Pro objects. Italics are used for technical notes and for the first occurrence of important terms and concepts. Logo code and other material to be entered in the Command Center are shown in Monaco type.

What Do I Need to Begin?

To use this book, you should be comfortable with the operating system of your computer (Mac OS or Windows). You should know how to save and load files, how to use pull-down menus, how to click and drag, how to double-click, and how to select using dialog boxes.

This book is for use with MicroWorlds Pro—regardless of the type of computer you are using. The software is almost identical on both platforms. While most of the screen shots are taken from the Macintosh you will be told if there is significant differences on the PC and a screen shot will be included.

On the Macintosh, MicroWorlds Pro requires System 8.5 or above, 32 megabytes (MB) of random access memory (RAM) with virtual memory set to at least 40 MB and a 100 MHz (or faster) PowerPC processor. QuickTime 4 is needed to be able to manipulate MP3 sounds files and you will find the QuickTime installer included in the Extras folder included on the CD. In addition the software requires about 100 MB of storage space on the hard disk.

On the PC the requirements are similar. You can use Windows 95, Windows 98, Windows NT or Windows 2000 for your operating system. You will need 16 MB of RAM and at least 20 MB of free hard drive space. In addition, you need to be sure you have the monitor set to run in High Color (16-bit) or higher and at a resolution of 800 x 600 or
higher. The display needs to be set to small fonts. The default install
connects you to Internet Explorer 4.0 but you can change this to
Netscape Navigator. On the Macintosh, there is an option provided on
the Help menu to make this easy.

In addition, MicroWorlds Pro will want to make use of the mouse
and a Sound Blaster or compatible sound card. Details about both the
required and the optimal settings for running MicroWorlds Pro are
found in the Read Me file that is found in the folder in which you
installed MicroWorlds Pro.
Chapter 1

Getting Started With MicroWorlds Pro

This chapter is designed to get you started using MicroWorlds Pro. But before you become engrossed in playing with the software, you might ask yourself the question, “Why am I learning MicroWorlds Pro?” Is it the learning process itself that most interests you? Do you enjoy learning and you are learning MicroWorlds Pro just for the fun of it? Or do you have more pragmatic reasons?

As you monitor your progress in learning MicroWorlds Pro, think about your learning processes. What things are easy for you to learn and what things offer a greater challenge? This type of thinking is part of “learning to learn.” It is a huge part of the Logo philosophy and is encouraged in any Logo based environment. MicroWorlds Pro is an excellent environment in which to practice learning to learn.

Brave New Worlds

To begin your work with MicroWorlds Pro, first be sure that the software is installed on the hard drive of your computer. (To install MicroWorlds Pro, see the instructions that came with your MicroWorlds Pro package.) For most users, the easy install option is the correct choice at this point.

If you are using a Macintosh, locate the MicroWorlds Pro icon in the MicroWorlds Pro folder on your hard drive.

Double-click on this icon to start MicroWorlds Pro.

If you are using a PC, use the Start menu to locate the application. If you do not see it listed, move to My Computer icon on your desktop. In the Programs folder you should be able to locate a LCSI folder where the application is stored.
As the application opens you will see a colorful “splash screen.” In a few seconds you see the opening screen of a new project. For now, let's simply spend time moving from world to world by examining a few samples included with the software.

You can explore the capabilities of MicroWorlds Pro by exploring the sample projects that come with the software. Select Open Project from the File menu and locate a folder labeled Projects stored in the MicroWorlds Pro folder.

Spend time playing with the various examples. They illustrate the power and excitement of the MicroWorlds Pro environment. Later—as you learn more about MicroWorlds Pro—you may want to return to these Projects to see how they are constructed. Notice that some of the choices are just Projects—for example Cards and Fractal. Others have several documents in a folder, so you must open a folder to locate the Project.

The Working World of MicroWorlds Pro

You are now ready to move from visiting the worlds created by others to becoming the maker of your own worlds. After examining several samples you will be bursting with ideas of things you want to try. By the time you have worked your way through the ideas in this book, you will have even more ideas to try. Don't feel you must know everything at once. Learn each step along the way and keep thinking about how you might use the idea or modify the idea to add even more interest to the Projects you want to complete.
Let's start by examining the typical opening screen. You can either quit MicroWorlds Pro and restart or move to the File menu and select New Project.

Take a few moments to examine this opening screen. At the top of the screen you see a menu bar. It has menu choices, such as File and Edit that you may have seen in other applications. Some items will be less familiar. The Text menu is similar to the usual Font menu with options for adjusting the appearance of text. The View menu lets you control the screen display. The Pages menu gives you a way to handle Page choices such as naming and duplicating. In addition, the Pages menu allows you to navigate through the Pages in your Project.

The Help menu includes the standard Show Balloons feature on the Macintosh. The Macintosh version also gives access to a dialog box allowing you to choose which Internet Web Browser (Netscape Navigator or Microsoft Explorer) you might wish to use with MicroWorlds Pro. The PC version uses the standard rectangular “tips” that appear if you hold a pointer over an item on the screen. Both the Macintosh and the PC versions give you access to MicroWorlds Pro’s extensive application specific Help features.
New Projects

Just below the menu bar is a Title bar that appears at the top of the MicroWorlds Pro Page. If you click and drag on the Title bar, you can move the MicroWorlds Pro window around on the screen. Documents created in MicroWorlds Pro are called Projects.

If you are on a Macintosh, in the middle of the Title bar, you see the title of your current Project, “Untitled.” Both the Macintosh and PC versions of the software display the Project title and the name of the open Page in the Status bar found in the lower left corner of the window.

![Untitled: page1](image)

Each Project consists of one or more Pages. Thus, when you open a new Project in MicroWorlds Pro, you are on the first Page—Page1—of an Untitled Project.

When you open a new Project, it is a good idea to immediately give it a name. Select Save Project As from the File menu
and enter a name of your choice in the **Save Project As** dialog box.

The Title bar and Status bar of your first Page changes to show the Project name.

The white area below the Title bar is called the Page. In *MicroWorlds, Pro* each new Page comes with absolutely nothing in it.

Below the Page is a special window called the **Command Center**.

This area allows you to place the I-beam insertion point allowing you to enter text. The area will automatically scroll for you so you will not run out of space.

The Command Center is a very important component of the *MicroWorlds Pro* environment. As you progress through this book, you will learn how to write Logo commands and instructions in the Command Center. These instructions can be used to direct Turtle movements and to carry out other activities. Instructions can be easily tested here. Once you have statements exactly as you need you can copy and paste them to a more appropriate place in your Project.
To the right side of the screen, you see an area with an open white box and four tabs along the bottom. This Tab Area gives you access to four choices.

As you click on a tab, the white area above the tabs will change. Each tab provides different options. In the beginning you will focus a great deal of your efforts on the Graphics tab. By the time you complete this book, the tools available in each Tab will be familiar.

The complete set of icons across the top of the window is called the Toolbar. The tools included are grouped for your convenience.

These tools are central to your work with MicroWorlds Pro. You will learn more about objects and the tools for working with them later in this chapter and in subsequent chapters. Eventually you will develop a detailed understanding of each of the tools.

**Exploring the MicroWorlds Pro Menu Bar**

Continue your exploration of the MicroWorlds Pro environment by taking a few minutes to explore the menu bar. Many of the options are familiar but you need to learn where options are located and what unique features are available in the MicroWorlds Pro world.
File Menu

If you pull down the File menu, you will see choices similar to other applications, except that instead of saving or opening files, you save or open Projects.

Also note that if you choose Save Project, the Project will be saved with the name that appears in the Status bar. If you want to change the name of a Project or the location of the stored file, use Save Project As.

Edit Menu

When you examine the Edit menu, you see that you can use either menu choices or keystrokes to Cut, Copy, and Paste.

The menu choices are context sensitive so will change slightly depending on what you are working with in MicroWorlds Pro. The Find/Change choice functions as you expect from your work in a word processing application.

The last two choices in the Edit menu are unique to MicroWorlds Pro. The Stop All choice is particularly useful. When you are working with a Project it is easy to run into problems when you begin to
animate objects. **Stop All** will halt every action you initiated in the Project. **Untrace All** refers a way to turn off a feature that will help you with **debugging**—finding problems and fixing them.

**Text Menu**

The **Text** menu provides options for modifying the appearance of your text. On the Macintosh you have access to the usual choices for formatting text. If you select **Font** you see a list of available typefaces.

![Font Menu Example]

Similarly if you select **Size**, **Style**, or **Color** you see a list of choices.

The **Text** menu on the PC is slightly different. The **Text** menu includes only two items—**Font** and **Color**. However, when you select **Font** you get the standard Windows font menu giving you options for setting the text characteristics.

![PC Font Menu Example]
Technical Note: Your list of type families may differ from the menu just shown. The type families in the Font menu depend on the type families that are installed in your System Folder. See your Macintosh or PC documentation for details on installing type.

Pages Menu

The Pages menu allows you to work with the Pages of a Project. You can create New Pages, Name Pages, or Duplicate Pages. This menu also gives you Transitions—special visual effects applied to the Page as you move from one Page to another.

At the bottom of the Pages menu is a list of the names of the Pages in the current Project. There is a check mark next to the Page currently visible. When a Project contains multiple Pages, you can go to other Pages by selecting them by name from the list.

You will soon find that you want to remove a Page you don’t want. There is no such option provided for you in the Pages menu. Removal of a Page is accomplished from the Command Center. You move the insertion point and enter

remove "Pagename"

where Pagename represents the name you have given the Page in question. When you press the Return or Enter key, the Page will disappear.
Another way to remove Pages is to go to the Project tab. In the list of Pages, locate the one you want to remove. On the Macintosh, click on a Page name while holding down the Control key. A popup menu appears. On the PC, the menu appears if you right click the Page name.

Select **Remove** and the selected Page will be cut from your Project. You will find similar popup menus for the other objects you will place in your Project and they are activated with the same approach.

**Help Menu**

The last menu choice is the **Help** menu. It is important to learn about each of the **Help** menu choices available.

The *Windows* version is slightly different from the Macintosh version. Since Windows does not have the need for the Show Balloons item, the **Help** menu displays only the last three items shown. The next section will discuss these options in detail.

**Getting Some Help**

The creators of your software have taken a great deal of time and effort to provide convenient access to information about each aspect of the software. The online Help is extensive and easy to use.
**MicroWorlds Help Topics**

The first choice in the Help menu—*MicroWorlds Help Topics*—gives you the most general help assistance and is organized into four major categories.

Selecting a category provides you a more detailed menu for accessing specific topics that you might wish to read.

Notice that *MicroWorlds Pro* is making use of Netscape Navigator (or Internet Explorer) to display the Help options.

---

*Technical Note: If you have worked with the Help menu and go back to your Project to access Help a second time, you may receive the message that the Netscape Navigator cannot be opened and you may have a memory problem. If this occurs, close Netscape Navigator and try the step again.*

The Help window also contains other choices. **Vocabulary** displays a list containing many of the Logo *primitives* that are
available in *MicroWorlds Pro*. Primitives are words—such as \texttt{remove}—that are part of the Logo programming or scripting language built into *MicroWorlds Pro*. Primitives will help you create instructions to do such things as move your Turtle.

**Vocabulary**

If you select **Vocabulary**, you see this window on the Macintosh.

![MicroWorlds Vocabulary](image)
If you select Graphics from the list of topics you are given a list of words to choose from. Suppose you decide to look at the word **back**, which is the first item on the list. The display changes and you see a definition for the word followed by a Demo—in many cases including animation.

![MicroWorlds Vocabulary: back](image)

If you continue to scroll through the Demo you will see that *MicroWorlds Pro* demonstrates the use of the **back** in a typical application of the primitive. When you reach the end of the scrolling window the syntax of the word is reviewed.

![Syntax](image)

With the power of this **Help** menu, *MicroWorlds Pro* teaches you its special vocabulary. You don’t have to remember the details of new commands. You can look them up whenever you need them. And, relax, *MicroWorlds Pro* never gets annoyed with you even if you have to look up the same thing several times.
Last Message

The Last Message choice on the Help menu allows you to get assistance if you make an error when entering information in the Command Center. If you enter a Logo instruction and MicroWorlds Pro does not understand it, a message appears with some information about this lack of understanding. For example, go to the Command Center and enter the following instruction exactly as shown. When you press the Return or Enter key the highlighted message appears.

Now if you select Last Message from the Help menu, you see the most recent message along with somewhat detailed suggestions for fixing the problem.

As you know from earlier in the book, the syntax for the remove primitive requires the use of a double quote in front of the word. If you correct your instruction

remove "page1"

the error message will not appear and the Page will disappear from your project.
Show Balloons

On the Macintosh, in addition to the option for setting the choice of assisting software for the Help feature, the other choice in the Help menu is the standard Show Balloons or Hide Balloons. As with other applications, the balloon feature provides you immediate access to the name of an item on the screen and sometimes a brief description of what the item provides. For example you might activate:

The balloon help is displayed as long as you keep the pointer on the object. Note that on the PC if you place the pointer over an object and simply wait, a yellow tip box will open for you. This is a standard feature in the Windows operating system. Take some time to experiment with clicking on objects, icons, and Pages to see what information is at your fingertips.

Exploring the Tab Area

At the bottom of the Tab Area you see four Buttons.

Clicking on these tabs changes what appears in the Tab Area. When you first open MicroWorlds Pro, the Procedures tab is open. You will learn more about Procedures later in this book.
Project tab

When you click on the Project tab, you see a list of all of the Pages in the Project. As you learn to add objects to your Pages, they will be listed for each Page.

If you click on the disclosure arrows next to a given Page, you can see the name of each object on the Page—and more, as you will learn later. It is helpful to keep in mind that you can see all your objects listed by examining the Project area.

Each object you add to the Page has a popup menu to be used as a shortcut for manipulating the object. On the Macintosh, hold down the Control key and click on the object. On the PC, right click on the object to access the popup menu. This feature will come in handy later as you are trying to keep track of everything in your Project.

In the Project tab you also find the means to activate Trace—a way of displaying instructions in the Command Center as they are run. Click on the instruction to open the popup menu. The instruction line menu includes the Trace option.

For the example shown, when the Turtle star is activated the following text appears in the Command Center.
When you get further along in the Logo language you will find this feature very useful. To turn off this feature for all objects being traced, select **Untrace All** from the **Edit** menu. To turn off the trace for only one object, reopen the object’s drop down menu and select **Untrace**.

**Processes tab**

When you click on the Processes tab, you see a list of Processes and three Buttons. At this point you probably don’t see any Processes below the Buttons.

If you’ve used any version of *MicroWorlds*, you are familiar with Processes. If you are a beginner, you will learn more about Processes later. For now, think of a Process as some action that can continue independently of other actions in your Project.

Processes were added to the Logo environment with the first version of *MicroWorlds*. The difference is that *MicroWorlds Pro* puts processes in a place that they are more visible and easier to debug.

The three Buttons at the top of the window let you control the Process in order to refine or debug it. Green starts the Process; red stops the Process. Clicking on Yellow runs the Process at a slower speed.
Graphics tab

The Graphics tab opens an area that lets you access the many graphics capabilities of MicroWorlds Pro.

This area contains paint tools, brush shapes, color selections and Turtle shapes.

Using the Graphics tab

At the top of the Graphics tab are the Graphics tools. These are standard tools for drawing simple shapes, filling areas and selecting an area from a background image.
Below the Graphics tools is the Brush Shape palette containing a variety of brushes to use with the Graphics tools.

If you click on a brush shape and then click on a Graphics tool, the tool uses that brush shape.

Note that some of the Brush shapes are designed to fill a shape and others are designed to use to draw or paint lines. A bit of experimenting and you will quickly see how to use them.

The next section of the Graphics tab controls colors. The currently selected color shows in the Color Viewer. Note that you see both the color number and a sample of the color in the Color Viewer.

The top slider is the Shade Slider. It lets you move through the 10 possible shades of each color. The second Slider is the Opacity slider. A low percent means that you can easily see through the color; a high percent means that you can see almost nothing through the color.

At the bottom of the Graphics tab is the Shapes palette. Shapes can be used to costume a Turtle—more about costuming later.
Note that you can scroll through the many shapes that are available in this part of the Tab Area. You will learn more about Turtle shapes later in this book.

**Editing Brush Shapes and Turtle Shapes**

In addition to using Brush and Turtle shapes, the Graphics tab provides you with features that let you create or edit both Brush shapes and Turtle shapes.

Scroll down in the Brush Shapes palette. At the bottom you find some small gray squares. These are places in which you can create your own brush shapes. If you double-click on one either one of the existing Brush shapes or one of the empty Brush shapes, you see the Brush Shape editor.
Clicking on the Radio Buttons under Style changes the choices at the bottom of the dialog box. Clicking on the drop-down menu at the upper left of the dialog box gives you a choice of basic Brush Shapes.

The Diameter slider lets you control the size of the Brush Shape. By manipulating these different selections, you can create a nearly infinite number of Brush Shapes.

You access the Shape Editor in much the same way. Scroll down through the Shapes palette. You see small black dots that represent blank shapes. If you double-click on an existing shape or on one of the empty squares, you see the Shape Editor.

When working in the Shape Editor, you have access to the Graphics tools. You can size, rotate, reshape, modify colors, add color—and even import graphics from outside of MicroWorlds Pro.

**The Toolbar**

Learning to use the icons on the Toolbar along the top of the Page is essential to mastering MicroWorlds Pro. It is important that you learn the names and functions of these icons and Buttons. Work to make their purpose as familiar to you as the tools in your kitchen or your workshop. However, like any other set of tools, it takes time and practice before you can use them all efficiently.
At the top of the Page you see the Toolbar. These tools are used for creating and editing MicroWorlds Pro objects.

The General tools on the left allow you to click on the Buttons to do a number of common tasks: create a new Project, open a Project, save the current Project and print the current Page.

At the far right end of the Toolbar is the Help Button. This accesses extensive Help features described earlier. The Help features open in the Web browser of your choice—see the Help menu. The group of tools just to the left of the Help Button is the General Editing tools. These allow you to do common editing tasks with the click of a Button: cut, copy, paste and undo.

The General Editing tools assist you in completing tasks that you might do in any application such a copying and pasting. The three groups of tools in the center of the Toolbar are MicroWorlds Pro-specific and so we examine these tools in more detail.

**Layout Buttons**

The two Layout Buttons make it easy to switch between two general screen configurations.

- Project Layout Button
- Procedures Layout Button

The Project Layout Button narrows the Tab Area so that the Project area is as large as possible. The Procedures Layout Button makes the Tab Area about half the width of the possible screen area. Note that you can also use the Esc key to move between the Project and Procedure layouts.

*Technical Note: If you manually resize the MicroWorlds Pro screen, then using the Layout Buttons may not make a significant change when you click on them.*

**Object Creation Tools**

The Object Creation tools are used to create objects in MicroWorlds Pro. This set of objects available is extensive. The objects provide you
with unlimited ways to enhance the Pages of your Projects. The greatest difficulty will be to keep from adding more and more objects.

- **Turtle Creation Tool**: creates a new Turtle;
- **Text Box tool**: creates a Text Box;
- **Button tool**: creates a new Button and opens the Button dialog box;
- **Slider tool**: creates a new slider and opens the Slider dialog box;
- **Melody tool**: creates a Melody object and opens the Melody Editor;
- **Recording tool**: creates a Recording object and opens the Record dialog box;
- **Video tool**: creates a video object and opens a dialog box so that you can choose a video;
- **Hyperlink tool**: creates a Hyperlink object and opens the Hyperlink dialog box.
Object Editing Tools

Once you have created objects, then there are a number of tools that are used for working with these objects.

- **Regular pointer**: serves multiple functions—used for activating Buttons, placing the cursor to enter text, moving and selecting objects;
- **Eye tool**: used to edit any object on the Page;
- **Stamper tool**: used to stamp Turtle shapes, transparent text boxes, or a video poster;
- **Magnifier and De-magnifier tools**: used to size Turtles, Buttons and Text boxes; and
- **Stop All tool**: used to bring all action on the screen to a stop.

Now take a few more minutes to become comfortable using the Toolbar. Use the Regular pointer and move around the screen clicking on items and changing the appearance of the window. It will take you little time to realize how easy the MicroWorlds Pro environment is to handle. Are you getting your ideas for Projects in your mind? You will soon be starting with the fun part of the software—making your own Projects.

Tips and Techniques

There is a Tips and Techniques section near the end of each chapter of this book. This section is based on the types of problems people encounter as they learn MicroWorlds Pro. You will find several questions to contemplate before you proceed. These questions will help you to remember the many ideas you have been given in the chapter just completed.
1. Are you comfortable starting *MicroWorlds Pro* and exploring the various menus, toolbars, and other options that the environment presents?

2. Are you beginning to develop a mental model of the *MicroWorlds Pro* environment and able to navigate easily in this environment?

3. Is the *MicroWorlds Pro* vocabulary beginning to become part of your working vocabulary?
Chapter 2

Creating Images in MicroWorlds Pro

If you have worked with any version of Logo in the past, you know that the Turtle can be used as a drawing tool. Students often begin their studies of Logo by learning to use the Turtle to draw a square or a house.

MicroWorlds Pro allows you to draw with the Turtle in the conventional way, but it also has a variety of other powerful tools for creating images. These tools are found in the Graphics tab. Using the Turtle and the Graphics tab tools, you can create any background you can imagine.

It is appropriate to think of a Page as consisting of a background—a static component—on which foreground components, such as moving objects, are placed. Click on the Graphics tab and let’s begin our artistic training. Like a small child learning to write, we will start with a pencil. Select the Pencil tool and then click anywhere on the Page.

You probably already know ‘clicking and dragging’ so go ahead—make your mark in the artistic world. Begin by creating a squiggly line of some kind—click on the Page, hold down the mouse Button, and drag the pointer to leave a trail of color. Move over Leonardo da Vinci.
The first line shows the default setting of a thin line in black. The next two were made after selecting a new pencil tip in the Brush Shapes palette and changing color using the Color Selector.

Next, select the Pen tool and continue your exploration. When you click on the Page, the Pen tool begins the line by ‘gluing’ the end of the line in place. As you drag the mouse pointer, you can move the resulting line in any direction until you release the mouse Button. Once the mouse is released, the entire line is fixed on the background.

Note the difference between the Pencil tool and the Pen tool. You still have all the choices in the brush shapes palette but the Pen tool is restricted to producing straight lines.

As you play with these two tools there are other things to make note of as you work. For instance, watch the changes in the Color Selector window. The Color Viewer is displaying not only a sample of the color you are using but also a number. This number is important since it allows you ways to work with color in more advanced situations in your Projects.

Also, be sure to use the Color Sliders to adjust your color choices. The Shade Slider changes the color; the Opacity Slider changes the transparency of the color.
If you want to make changes to these wonderful images on your Page, click on the Eraser tool and click and drag to remove part of the graphics.

If you want to remove all of the graphics at once, double-click on the Eraser tool. The Eraser tool provides an extremely easy way to modify the elements you place on the background of your Page.

**Technical Note:** You cannot erase the Turtle or any other object using the Eraser tool. Turtles are objects; they are not part of the background on a Page. Objects have special features in MicroWorlds Pro. You will learn more about Turtles and other objects later in this book.

The next two tools in the Graphics tab draw rectangles. They both use the current color and line width. The tool at left—the Rectangle tool—draws a rectangle that is not filled with color.
Click where you want one corner of the rectangle and then drag the mouse until the rectangle is the size and shape you want. Then release the mouse Button. A rectangle in the currently selected color using the currently selected Brush shape appears.

The rectangle on the left is produced with the Rectangle tool set as shown on the right. Check your screen carefully. The pointer changes to a fine cross-hair version.

The second tool is the Filled Rectangle tool. This works much the same way except that the rectangle comes already filled with the color or pattern you have selected.

The next two tools in the Graphics tab are similar to use to the rectangle options. There is an Oval tool and a Filled Oval tool.
When you click to start drawing an oval, you are at the corner of an imaginary rectangle that encloses the oval.

The Paint Can tool is used for filling enclosed areas. Thus, if you draw an irregular figure, a rectangular shape, or an oval shape, you can fill the area inside with the color of your choice. Click on the Paint Can tool, move the paint can to the enclosed area and click.

The color or pattern set for the Paint Can tool is used to completely fill the area. The Paint Can tool will save time as you create backgrounds.

Note that the tip of the paint coming out of the Paint Can tool must be inside the area you want to fill. Note also that if your shape is not closed, the entire Page will fill with color. If this happens, immediately click the Undo tool in the Graphics tab.

Or, select **Undo** from the **Edit** menu if this happens. Be sure that you select **Undo** before you make any other changes to your Page.

The next tool is the Spray tool. You use this tool much as you would a real can of spray paint.
Select the Spray tool. Click where you want the spraying to begin, hold down the mouse Button, and move the mouse to leave a trail of color.

The characteristics of the color pattern can be changed. Select the option you prefer from the Brush shapes and Color Selector.

There are other ways to adjust the results you get using the Spray tool. You can click once to get a cluster of dots on the Page. If you leave the Spray tool in one place—with the mouse Button held down—the “paint” gets thicker. By dragging quickly across the Page the color squiggle on the left was produced. By dragging slowly across the Page the squiggle on the right was produced. The line also shows where the Spray tool was stopped and held in place before proceeding.

Choose the Filled Rectangle tool and create three rectangles, one on top of another so they are overlapped as shown.

If you then click on the Undo tool, the most recent rectangle you drew disappears.
If you click on the Undo tool a second time, the rectangle that disappeared will reappear. Undo only changes the last step you did. For example, if you just erased a rectangle, clicking Undo puts it back.

In the selection of tools used for editing images you will find an icon with a dotted rectangle on it. This is the Selector tool.

Click on the Selector tool. The pointer turns into a small cross-hair icon. Click and drag to form a rectangle around the area you want to work with. The rectangle flashes and dashed lines move around the area you have selected. When you release the mouse Button, handles (black squares) appear at each corner of the selected region.

Now click inside the select area and drag it to a new location.

A rectangular area that has been selected always has handles showing at the corners. If you wish to remove the selected area from the Page, you can press the Delete or Backspace key. If you wish to change the size of a selected area, you can do so by clicking and dragging on a handle. Dragging one of the handles “out” will enlarge the selected area. Dragging a handle “in” will make the selected area smaller.
There is another selection tool that allows you to edit your background. The Lasso tool allows you to select a portion of the image that is irregular in shape. When you click in the selected portion the pointer becomes the ‘sticky’ hand that lets you click and drag the selection to a new location.

This lets you work with portions of an image.

There is one more tool in the Graphics tab that you will want to remember you have available. This one gives you an easy and fast way to match colors as you edit an image. Click on the Color Picker tool.

Move to your Page and click the tool on some portion of your Page. Notice the Color Viewer as you do so. Find a portion of the Page that is a different color and click again. By placing the tool over any particular color you can change the color settings to make use of that particular color. If you want to match the shirt on a second figure to the pants worn by the first figure, this tool makes it easy.

**Make a Masterpiece**

Take a few minutes to practice using the many tools introduced to you. Take your time and see if you can use them to produce the first of
many backgrounds that you will use to enhance your Projects. You might try a scene

![Image of a landscape with a house, trees, and birds.]

or a simpler picture.

![Image of colorful balloons.]  

You might classify this as refrigerator art but with the practice any artist requires to improve, you’ll soon find yourself producing images on the Page that come much closer to the image in your mind.

If you look closely at the last masterpiece you will notice that some of the balloon strings stop too soon. To correct errors such as this you want to move to the Graphics Editor. In the Graphics Editor you can edit individual dots in your painting. Using the Selection tool, select the area you want to edit. When the handles appear around the area, place the pointer inside the selected area and double click. The Graphics Editor will open to display the area you selected.
You can then use the Graphics tools in the Graphics tab to change individual dots in the picture. In no time at all, the gap between the balloon and string can be completed.

Take the time to carefully examine the Graphics Editor options. The most useful item perhaps is the ability to change the magnification of the selected portion. The image can be changed from 100% to a huge 1600% to let you handle the smallest detail for correction.

**Drawing With the Turtle**

You are about to meet *MicroWorlds Pro*’s most famous character—the Turtle. As with many tasks in *MicroWorlds Pro* you have been given a second way to place images in your Projects—by helping the Turtle do the work. In addition, since the Turtle can be trained you can set your Project so the Turtle works as the user watches. Yes, this does require some Logo instructions. However, they aren’t difficult and you
will find that using Logo instructions gives you far more power and versatility than you achieve using menu choices.

The Turtle has a number of roles to play in *MicroWorlds Pro*. One of those is as a “drawing cursor.” Think of the Turtle as carrying a pen. If directed to, the Turtle can use this pen to draw a line as it moves on the Page. For the Turtle to draw a line, its pen must be “down.”

When you help *MicroWorlds Pro* hatch a Turtle the Turtle keeps the cap on the pen—the pen is **up**. With the pen up, the Turtle moves without drawing a line. To explore using the Turtle as a drawing tool, select the Turtle Creation Tool from the Toolbar and click on the Page.

As you move the pointer onto the Page it becomes a pointing hand. When you click the pointer a small black Turtle appears.

Next, move the pointer to the Command Center (the gray area in the lower portion of your window) and click the mouse Button. When you see the I-beam pointer in the Command Center, enter

```
forward 25
```

or

```
f 25
```

Don’t forget to press Return or Enter. Make sure that there is a blank space before the number. If you do not put in a blank space or if you leave out the number, you will get an error message.

You should see the Turtle move up the screen, that is, **forward**. The distance the Turtle moves is referred to as **Turtle steps**. Thus, the Turtle moves forward 25 Turtle steps.
For the sake of our learning this is a great place to deliberately make a mistake.

• What error message do you get if you leave out the blank space between the forward and the number 25?

• What message do you get if you enter forward and press the Return?

• What message do you get if you enter 25 forward?

Since you are only human you will make such errors by accident in the future. Now that you have experienced such errors deliberately and have seen the resulting error messages, you will not be as bothered when you enter something that MicroWorlds Pro does not understand.

This is also a good time to remind yourself of the online Help feature. Did you remember that the last item in the Help menu is Last Message? Did you remember this item assists you in understanding the message you received when you created your mistakes?

When entering text in the Command Center, use capital letters or a mixture of capital and lowercase letters. When entering numbers, be sure you enter a zero (0), not the letter O (“oh”).

You are now ready to have your Turtle draw a line. To put the pen down so that a line can be drawn, enter

pd

This stands for Pen Down. Now enter

forward 25

or

fd 25

Your Page should look like this:
Note that the Turtle drawing is not affected by the color and line width currently selected in the Graphics tab. (To give the Turtle these changes you will need to talk to it using the Logo language. The Turtles do not understand English. You can change these characteristics using the \texttt{setc} and \texttt{setpensize} commands.)

You can turn the Turtle by using Logo instructions. Enter \texttt{right 90} or \texttt{rt 90}

Don’t forget to press Return or Enter key after each instruction. The \texttt{right} instruction turns the Turtle to the right—clockwise—by the number of degrees you specify. Observe carefully how the Turtle turns. It does not draw a line when it turns.

Use the Up Arrow key to move the insertion point in the Command Center until it is anywhere in the last \texttt{forward} command. Press Return. Does your Turtle drawing now look like this?

\begin{figure}[h]
\centering
\includegraphics[width=0.2\textwidth]{turtle_square.png}
\caption{Turtle drawing after turning 90 degrees.}
\end{figure}

You don’t have to reenter an instruction to use it again. Merely place the pointer anywhere in the line already visible in the Command Center and press Return or Enter. Can you finish drawing a square without entering any more instructions?

\begin{figure}[h]
\centering
\includegraphics[width=0.2\textwidth]{turtle_square_completed.png}
\caption{Turtle drawing with a completed square.}
\end{figure}

Many of the Turtle commands come in pairs. Thus, there is a \texttt{back}—abbreviated \texttt{bk}—command that moves the Turtle in the opposite direction from the \texttt{forward} command. There is a \texttt{left}—abbreviated \texttt{lt}—command that turns the Turtle counterclockwise, the opposite of the \texttt{right} command. \texttt{Pd} puts the pen down on the drawing while \texttt{pu} (Pen Up) raises the pen off of the Page.

When you are in the Graphics tab, you can erase the drawing on the Page by using the Eraser tool. You can also double-click on the
Eraser tool to remove all of the drawing from the Page without affecting the Turtle. The Turtle, however, doesn’t directly use the Eraser tool. Instead, it responds to the Logo command **clean** to remove all of the paint from the Page without changing the position of the Turtle. **Clean** does exactly the same thing as double-clicking the Eraser tool.

There is also a **clear graphics** command. If you enter

```
cg
```

in the Command Center, all of the graphics are removed from the Page and the Turtle is returned to the center of the Page, headed upward. Notice that this differs from **clean**. **Cg** changes the location and direction of the Turtle; **clean** does not.

If you enter large numbers after the **forward** or **back** command, the Turtle goes off the Page. For example, if you enter

```
cg
pd
right 80
forward 900
```

you see that when the Turtle goes off the Page on the right, it reappears again on the left at the same distance from the bottom of the Page. This is called **wrapping**.

If you enter

```
10
right 10
forward 400
```
you see that the Turtle wraps around the top and bottom of the Page as well.

This section has covered a number of Logo commands. Eventually you will have used these commands so often that you will have them memorized. For now, make sure that you have experimented with each of the commands. After you have experimented for a while, make a design or drawing by using only the Turtle—don’t use the tools in the Graphics tab. Keep it simple. If you make mistakes, use \texttt{cg} or \texttt{clean} to clear the Page and start again. Recall that the instructions you have entered are still available to you in the Command Center. Use the arrow keys to scroll up and down in the Command Center.

\textbf{Saving and Printing Projects}

There are two ways to preserve your work. One way is to save an electronic version and a second way is to save a printed version.

Develop appropriate saving techniques. Make it a habit to save your work every 10 to 15 minutes. Better yet, save it every time you make a time-consuming change to your Project. Use different names, such as \texttt{MyProject1}, \texttt{MyProject2}, \texttt{MyProject3}, and so forth. If you make a serious error, you can easily go back to the previous version of your Project. When you have the Project completed the way you want it to be, you can delete the unwanted versions.

When using \texttt{Save Project} or \texttt{Save Project As}, only the contents of the Page or Pages making up the Project are saved. Text in the Command Center is \textit{not} saved.

Try printing a picture you have drawn. You can use \texttt{Print Page} from the \texttt{File} menu to print the Page on the screen. You can also use \texttt{Print Project} to print more than one Page from a Project. Note that
your system must be properly configured for use with the printer you are using to print your Project correctly.

**Tips and Techniques**

Spaces are very important when writing Logo instructions. If you get error messages you don’t understand, look carefully at what you entered. For example, you must have spaces between a command like `forward` and the number after it. Learn to think of spaces as significant characters.

Beginners sometimes find the differences between the commands `forward` and `back` and the commands `right` and `left` difficult to understand. `Forward` and `back` are movement commands. They cause the Turtle to take Turtle steps. `Right` and `left` are turn commands. The Turtle doesn’t move at all. Instead it turns around in place, like a ballet dancer spinning on her toe.

When you have put a lot of work into a Page, it is very frustrating to make a major error or accidentally erase your work. Remember that Undo can only “bring back” the last step in your work. Thus, it is very important to get in the habit of saving your file from time to time.

Sometimes you will want to insert a line between two lines in the Command Center. Pressing Return or Enter doesn’t create a new line. Instead, the current line is run and the cursor moves to the next line. To insert a new line, place the pointer at the end of the line before the place you want to insert a blank line. Press Command-L (`⌘-L`) on a Macintosh or Control-L (Ctrl-L) on a PC. A blank line opens up and you can insert an instruction.

Sometimes you might end up with several instructions on one line. For example,

```
cgpuforward 50
```

You can move your pointer to the line and use the Arrow keys and the space bar to insert spaces.

```
cgpuforward 50
```

You can also use Command-L or Control-L to move each of the commands to its own line. Place the pointer after the first instruction and press Command-L or Control-L. The instruction is on a line by itself.

```
cg
puforward 50
```

Repeat this process until each instruction is on a separate line.
When you are finished working with MicroWorlds Pro, always be sure that you save your work. If you leave MicroWorlds Pro using Quit from the File menu, MicroWorlds Pro will prompt you to save. However, if you leave the computer without saving and closing MicroWorlds Pro, someone else may erase or change your work and your Project may be lost.

In this chapter you have learned to write Logo instructions to control movement of the Turtle. A collection of one or more instructions is called a computer program. One of the advantages of having a computer program is the ability to use the instructions again and again. You’ve already done that using the arrow keys to move from one instruction line to the other.

If you only place your instructions in the Command Center, they will disappear when you close the Project. You may want to begin copying and pasting the instructions you want to keep into the Procedures tab. You will learn to organize your instructions into Procedures shortly. For now, just keeping them safe is sufficient.

A mistake in a computer program or a flaw in computer hardware is called a bug. This vocabulary goes back to the very early days of computers when a real bug—a moth—got caught in an early computer, causing it to malfunction. All people who write instructions for computers make mistakes. The processing of detecting and correcting bugs is called debugging.

As you reflect on the concepts you have just completed there are few steps worth reviewing in your mind.

1. Can you remember the distinction between creating images with the tools in the Graphics tab versus using the Turtle?
2. If you are using the Command Center for giving the Turtle instructions and you create an error you receive an error message. Do you remember how to get assistance in understanding the message? If you needed a refresher on the Logo word itself, where would you find help?
3. Making changes as you work is not a negative thing since each step may give you a new idea. Where is the most convenient access to the Undo feature included in the software?
4. Spending time to produce the Page you want is crucial. Do you remember how to save your Project? Did you establish a naming convention that allows for incremental saves in case something goes wrong with the most recent file? Are you keeping track of where the files are stored and giving each Project a name that will mean something to you in the future?
Chapter 3

Working With Shapes

In Chapter 2, you learned how to create colorful graphics on the Pages of your MicroWorlds Pro Projects by using the Graphics tab. You also learned how to let the Turtle place graphics on your Page.

But the Turtles can do even more things. In fact, the best is yet to come. Turtles give you additional ways to make elaborate backgrounds on your Pages. You will remember that there is a Shapes palette in the Graphics tab. This area displays a collection of small images. You can use these images as Turtle “costumes.” That is, a Turtle can be given a shape. The Turtle can then “stamp” a copy of its shape onto the background. This makes it very easy to integrate ready-made images into your backgrounds. Later, you will learn other ways to combine Turtles, shapes and Logo commands to enhance your Projects.

Using Shapes

Start by preparing your MicroWorlds Pro environment. You need to hatch a Turtle (or two or three) and to activate the Graphics tab. Take a few minutes to scroll slowly through all the available shapes at the bottom of the Graphic area so you have some idea of what is available. In addition, make note of the empty positions in the window. You will learn to use these to edit the included shapes or to paste in images from other sources that you want to use as shapes.

Use the Regular pointer—the arrow Button—to click on a shape of your choice. Next, move the pointer onto the Page. The pointer changes to a pointing hand—seen earlier. This pointing hand is used frequently as you manipulate shapes and work in the Shapes palette of the Graphics tab. Move the pointing hand so that it is on top of the Turtle.
When you click the mouse, the Turtle shape changes to the shape you selected. The pointing hand can also be used to move a Turtle. Just click and drag the Turtle to any desired location on the Page. Notice that the pointer changes to open hand pointer during the moving steps.

You can use the Turtle like a rubber stamp and stamp pad. Click on the Stamper tool located just below the regular pointer. Then click on the Turtle.

As you click, you see marks appear below the Stamper tool. A stamp of the Turtle shape has been placed on the Page, exactly underneath the Turtle.

To see the image the Turtle stamped you must move the Turtle. You can select click on the Turtle with the Stamper tool and click and drag. If you prefer, select the regular pointer from the Toolbar before you click and drag to move the Turtle.
Learning to use the Stamper tool for this task allows you to stamp many copies of the same shape at different locations on the Page.

Turtle stamps are painted onto the background. Like any other paint graphic, Turtle stamps can be removed by using the Eraser tool or modified by using the tools in the Graphics tab.

You can change the size of the Turtle using the Magnifier and De-magnifier tools located in the Toolbar beside the Stamper tool. Since the size of the Turtle can change, the images that you stamp can be of different sizes. The Magnifier tool—with the plus sign—makes the Turtle and Turtle shape larger; the De-magnifier tool—with the minus sign—makes the Turtle and Turtle shape smaller.

To see how this works, clear the graphics from the Page. Remember there are two quick ways to do this. You can click on the Command Center and enter clean or cg or you can go to the Graphics tab and double-click on the Eraser tool. Also, turn the Turtle back to its usual drab black costume by clicking on it with the Turtle Creation Tool.

Find a new Turtle shape to give your Turtle the latest fashion—whatever shape appeals to you. Isn’t it great that you don’t have to ask the Turtle what it would like to wear? Next, apply the shape to the Turtle. Use the Stamper tool to stamp an image of the Turtle shape. Move the Turtle to the right. Choose the Magnifier tool with the plus sign on it and click on the Turtle several times.
Each time you click on the Turtle with the Magnifier tool, the Turtle shape gets larger. Stamp this larger shape with the Stamper tool. Move the Turtle to the right again.

Note that you can hold down the mouse Button with either the Magnifier or Stamper tool selected and the pointer changes to an open hand. You can then move the Turtle to any location on the Page.

Next, select the De-magnifier tool with the minus sign on it. Click on the Turtle a number of times. The Turtle gets smaller. You can even make the Turtle shape smaller than it was originally.

Next select a different shape from the Shapes palette. Click on the Turtle. The Turtle shape changes, but the size of the Turtle shape stays the same.

Note that you must click on the Turtle itself to change the shape or the size. Once a Turtle shape is stamped on the Page, it is a part of the background of the Page just as if you had drawn it there using the Graphics tab tools. Of course, once a Turtle shape is stamped, you can use the Graphics tools to modify it.

**Creating and Editing Shapes**

There are empty shapes in the Shapes palette that can be used to create your own shapes. In addition to creating your own shapes, you can modify the shapes that come with *MicroWorlds Pro*. 
Select a shape you want to modify—either one of the original shapes or one of the blank shapes and double-click on it. You see an expanded version of the shape you have selected in the Shape Editor. For example, if you select the butterfly2 shape, you see

The Shape Editor is much like the Graphics Editor you used in the last chapter. You can use the Graphics tab tools to modify the shape. Adjusting the level of magnification using the drop-down menu on the left lets you edit in an easy to control pixel-by-pixel way.

If you modify an original shape, such as the butterfly above, the original shape will no longer be available in your Project. Later you will learn how to restore original shapes if you accidentally modify them. You will also learn how to copy new shapes into other Projects. However, it is always good idea to make a copy of a shape and modify the copy rather than the original. If you have already started to modify one of your original shapes, such as the butterfly, stop. Click on the Cancel Button on the upper right and move back to the Shapes palette.

Again select the shape you want to modify by clicking once on it. Select Copy from the Edit menu. Then click on one of the open spaces in the Shapes palette and click the mouse Button. Go back to the Edit menu and select Paste.
The shape you copied now occupies the square that was previously empty.

Now double-click on the shape to edit the copy that you just created. It is time to investigate the special tools included in the Shape Editor. Along the top you see a number of icons.

Starting at the left of the Shape Editor window you see the magnifying options on the drop-down menu. This magnification setting doesn’t change the actual size of the Shape—it just lets you see a magnified version to work with. Take some time to change the settings so you are comfortable with the various levels of details you can see.

The next two icons allow you to flip the image. The first completes a horizontal flip and the second completes a vertical flip.

The next Buttons in the Shape Editor allows you to rotate a shape. On the left is the clockwise rotation Button and on the right is the counter-clockwise rotation Button. Between the two Buttons is a white box showing the rotation amount. The arrows access several built-in rotation amounts. To customize the rotation, enter a number of your own choice in the white box.
Again, place a shape into the Shape Editor and investigate the results of various rotation settings.

| Original Shape | Clockwise 45 | Counter Clockwise 45 | Clockwise 12 |

You can also use the tools in the Graphics tab to change a shape. You can change the colors, add dots, or remove sections of the shape. Note that the lines you draw in the Shape Editor are affected by the current line width.

Rather than editing a shape that is provided, you can create your own shapes. Double click on one of the small dots represented in a blank square to open the Shape Editor. Use the tools in the Graphics tab to select colors, draw shapes or lines, and correct errors.

Take the time to use the box for naming your shape. Click in the Name box and enter a name of your choice. A short name is best since you may want to use the name in your future work. We called our Shape OopsFace.
Technical Note: You can put spaces in the names of shapes, but spaces make it more difficult to use Logo commands with shapes. Many people use a period (.) where they would normally leave a space in the name of a shape. Another option is to use capitals—OopsFace—so the name can be easily read.

You can also change the shape and size of a shape. Thus, if you select the OopsFace shape and click on the black handle in the center of the rectangle you can extend the space reserved for the shape. This shape is now 79 pixels long. Into the extra space you can add to the image in some way.

Experiment with modifying the size and dimensions of one of your shapes.

Technical Note: You can put spaces in the names of shapes, but spaces make it more difficult to use Logo commands with shapes. Many people use a period (.) where they would normally leave a space in the name of a shape.

In addition to creating your own shapes “from scratch,” you can copy graphic images from elsewhere and paste them into the Shapes palette. These graphics can be part of drawings on the Page, graphics from another application, or graphics from a set of clip art. You will learn more about using graphics in shapes later in this book.

**Using Logo Words With Shapes**

As you undoubtedly anticipated, MicroWorlds Pro lets you use Logo commands to work with Turtle shapes. You can see the name and number of a shape using Balloon Help on the Macintosh or Tips on the PC. Since these can help you with activating Turtles, this is a useful technique to keep in mind. You can also click on an item in the Shapes palette and see information about it in the status bar. The name,
number and size of a shape appear after the small balloon in the Status bar.

You can then use either the name or the number of the shape to change the shape of the Turtle. The command for changing the Turtle’s shape is `setsh` (for SET SHape).

Place a Turtle on the Page and then move to the Command Center. Enter the following instructions in the Command Center:

```
setsh 79
```
or

```
setsh "rose"
```
Either instruction will cause the Turtle to take on the shape of the rose. Notice that when you use the name of a shape, you put one quotation mark in front of it. This is the way you tell Logo that you are using the name of a shape rather than a number.

If the name of your shape has a space in it, you can use vertical bars when using `setsh`. For example, if your shape name is “smile face,” you enter

```
setsh "|smile face|
```
to use this particular smile face Shape.

You can also change the size of the Turtle by using the `setsize` command. The original size of a Turtle shape is 40. Thus,

```
setsize 20
```
makes the Turtle smaller, while

```
setsize 80
```
makes the Turtle larger.

*Technical Note: The Turtle can be no smaller than 5 and no larger than 150, and it can be increased or decreased in size only by whole units. Shapes cannot have fractions or decimals in their size.*

You can stamp the Turtle shape on the Page by using the `stamp` command. Simply enter

```
stamp
```
and a stamped image of the current Turtle shape is placed on the Page.
Commands can be combined to create designs on the Page. For example, if you go to the Command Center and enter:

```
setsh "moon
setsize 40
stamp
forward 50
setsh "star
stamp
forward 50
setsize 20
stamp
```

you see:

As noted earlier, using Logo instructions allows you to accomplish most of the things you can do using the tools built into MicroWorlds Pro.
Make a Masterpiece

Now that you know how to use the Graphics tab tools and the Shapes palette, combine your skills to create a colorful background using a combination of these options. Be brave and put the Turtle to work as well. The Turtle is patient and is quite happy waiting for your directions. You do not need to hurry. After all, it is a Turtle.

Tips and Techniques

If you change the original shapes in a Project and decide you want them back you can simply open a new Project. The original shapes will be there. Copy them to the clipboard, move back to the other Project and Paste them back into the Shapes palette. You can also use Import shapes from the File menu. In addition to restoring the Shapes palette you can also add new shapes to the palette from the collection of shapes included with the software. A discussion of this feature is included in Chapter 10.

Logo provides a method of placing a new image into the Shapes palette. To use the Logo command your image must be in one of the supported graphics formats—BMP, JPG, GIF, PCX or Targa for the PC and Pict or Jpeg on the Macintosh—and must be stored in the same folder as your current Project. If you have the ideal image but it is not currently in the correct format you may be able to resave the image in the required format from the original software or a graphics program.

In the command center enter

Loadshape "cougar.jpeg" 8
In this instruction, cougar.jpeg is the name of the image and 8 is the number of the shape determined by its placement in the Shape palette.

The number is necessary to let *MicroWorlds Pro* where to place the image you are loading.

If you are using the Turtle to stamp a variety of shapes on the Page, you may lose track of the location of the Turtle. Trying to keep track of the Turtle if you have stamped several copies of the Turtle shape is never simple. However, if you are having trouble, use the Eye tool. When you click on the Turtle wearing the shape, the Turtle dialog box will appear. If there is no response, you are clicking on a stamped shape.

Another quick way to find the “real” Turtle is to use Logo commands to change the shape of the Turtle. For example, you can go to the Command Center and enter

```
setsh 0
```
or
```
setsh "Turtle
```
The Turtle shape will appear on the “active” Turtle.

In this chapter you learned how to stamp a Turtle costume onto a Page. You may be thinking from the analogy of stamp pad and stamp. When you look at the Page just before stamping, you see the Turtle costume. When you look at the Page just after stamping, you see exactly the same thing. While this analogy may help it isn’t exactly correct. Until you move the Turtle dressed in the shape you are not able to see that your stamp was placed correctly.

There are a number of new concepts in this chapter that you should stop and review for yourself. Think about some of the following before you continue to the next chapter.

1. When you are producing images for your Page you have the options of using icon choices or using instructions in the Command Center. How do you decide which approach is best for any situation?
2. You learned to make changes to the Turtle costumes and occasionally you will find you’ve messed up the original shape. The software is designed to prevent you from making any shape changes
permanent to the application. Instead, they will only appear in the Project you were working in. If you need to restore the original shapes can you do so?
Chapter 4
Working With Buttons

In previous chapters you learned how to create a background for a Page and how to use a costumed Turtle to stamp an image on that background. However, the Turtle itself always “floats” above the background. If you move the Turtle around, it covers images drawn on the background.

The large Turtle is “above” the background scene—the stamped flowers and cloud.
The Turtle is one of the many kinds of objects that can be used in MicroWorlds Pro Projects. All of these objects are layered in front of, or “on top of” the background of the Page. Furthermore, the objects themselves are independent and will be layered, one on top of the other.

In this chapter you will learn about a type of object called a Button. Buttons are used to cause action of some kind on the Page. For example, you can make a Button that will cause the Turtle to move or change its shape.

Creating a Button
To create a Button, simply click on the Button tool in the Toolbar and then click on the Page where you want the Button to appear.

The first thing you will see is the Button dialog box.

Take notice of the items included in the dialog box and click on OK.
The Button appears where you clicked on the Page.

Notice that the name that appears on the Button is the word(s) that appear in the Instruction box.

Technical Note: If you have used a hypermedia environment, such as HyperCard or HyperStudio, this way of naming Buttons will seem strange at first. Buttons are named by using Logo instructions. Later you will learn that nearly any name you choose can become a Logo instruction. In the future, you will more creative than naming your Buttons as shown in this example.

Enter the following Logo instruction in the Instruction box of the Button dialog box.

`forward 25`

Be sure the dialog box is set for the action to occur once. Then click OK. The dialog box disappears, and the name of the Button is now the same as the instruction you entered. It is only partially visible.

You need to select the Button object. Hold down Command (⌘) (Macintosh) or Control (PC) and click on the Button. Or, click and drag around the Button with the regular pointer. Once the selection is complete, the four black handles are visible. Click on one of the black handles and drag to resize the Button.

This Button is now ready to help you control the action of your Turtle. Any time you click on it, the Turtle will respond and move forward 25 Turtle steps.

When you create a Button, it is placed at the location on the Page where you click your mouse. But you can move the Button anywhere on the Page at any time. Click on the Button and hold the mouse Button down. The pointer changes to a hand and you see the outline of the Button. PC users, you may need to move the Button just slightly for the hand pointer to appear. With the hand pointer, click and drag the Button.
When the outline of the Button is where you want it, release the mouse
Button. The Button now appears in the new position.

Buttons must have Logo instructions on them to perform an action.
When you click on a Button, the Logo instructions on it are run. If the
text on the Button is not correct Logo instructions, you see an error
message in the Command Center if you click on the Button.

Editing Buttons

You can change the instructions on a Button at any time by editing
the Button. You access the dialog box using the Eye tool. Click on the
Eye tool.

Now click on the Button you want to edit. Note that the pointer
changes to the eye icon. The Button dialog box appears, and you can
change the instructions that appear on the Button.

Perhaps you want to add more instructions, such as
forward 10 right 30
When you click OK, you see

Sometimes you will want a copy of the Button you are working
with. Select it by using one of the two methods described earlier. When
the handles appear, select Copy from the Edit menu. Then select Paste from the Edit menu. A copy of the Button appears, giving you two identical Buttons. You can also use the Copy and Paste tools that appear in the Toolbar. Note that any Logo words in the Instructions box of the original Button are also in the Instructions box of the copy.

Sometimes you will want to remove Buttons you have created. First select the Button. When the handles appear, press the Delete or Backspace key. A second way to remove a Button is to use the Scissors tool. Click on the Button with the Scissors icon. It will disappear from your Page.

The Scissors tool can also be used to remove other objects, such as a Turtle or a Text box. As an alternative, use Remove on the drop down menu for the object from inside the Project tab.

**Using Buttons in Projects**

Now that you have learned how to create Buttons, take some time to explore ways to use Buttons in your *MicroWorlds Pro* Projects. You have seen that you can create Buttons that use Logo instructions. You can easily create a Page that has a number of Buttons that can be used to make drawings.
For example, you might begin with Buttons that cause the Turtle to move and turn. Then you would need to add Buttons to raise and lower the pen and to clear the Page. You have already seen the instructions you need to complete the Page shown below.

In terms of good Page design, it would be good to place a line between the Button area and the graphics area. You could place a paint line with the Pen tool. However, if you use the cg Button, the line will be erased. Instead of a line, you could use a Button without anything in the Instruction box to act as a divider. Make the Button long and narrow and position it just above the other Buttons.
Turtle movement can add to a Project without having to draw as it moves. With a background created using your Graphics tab tools and Shapes palette the scene can be set to use one or more of Turtles dressed appropriately. Start by preparing a background scene. Note that the Car shape is the actual Turtle; the other shapes are stamped on the Page.

Suppose you want to make the Turtle—dressed up as a car—to move across the screen. You can add a Button that will make the Turtle move. For example, you might have it move five Turtle steps at a time. If you then click on the Many Times radio Button, the Turtle will move five steps repeatedly until you click on the Button again.
Remember, once the computer starts to follow the instructions on a Button, it will continue to do so until you stop it. You may be startled to see your car driving into space.

You do need to stop that car. There are three ways to stop the Logo code on a Button. You can simply click on the Button to stop it. You can select **Stop All** from the **Edit** menu. You can click on the Stop All Button on the Toolbar. Using Stop All will stop all the action in *MicroWorlds Pro*, not just the action initiated by clicking on Buttons.

The **forward 5** Button with the Many Times Button selected in the dialog box will cause wrapping. This means the Turtle car will go to the top of the screen and then reappear at the bottom, move again to the top, and so forth. This will continue until you stop the action.

*Technical Note: If you put very large numbers after the *forward* instruction, the Turtle will move very fast. Using smaller numbers gives you more control over the speed of the Turtle.*

How do you manage to teach that car to use the street rather than pretend to be a spaceship? The situation is caused by the direction the Turtle is facing when you instructed it to move **forward**. Your Project will make more sense if the direction of movement is consistent with the Turtle shape.

The direction of the Turtle can be adjusted before you apply the instructions you included on the Button. Any time you hatch a Turtle, it is facing to travel upwards on your Page. But, you have already seen
that a Logo instruction can change this direction. Go to the Command Center and enter

`left 90`

Another useful trick is to remember you can click on the head or leg of the Turtle shape and drag in a circle to change the direction the Turtle is facing. The Turtle will spin but not move from the position it is in. However, if the Turtle is already wearing a Turtle costume, this option is not helpful. You will first have to remove the costume, then turn the Turtle and finally replace the costume.

Your Turtle direction has been adjusted by the Logo instruction you entered in the Command Center. If you now click on the `forward 5` Button, your car will drive from right to left across the screen.

Perhaps you want your shape to move only part of the way across the screen and then stop. The `repeat` command may help you accomplish this task. Edit your Button instructions. You might change the Button dialog box to be

```
Name:   button1
Instruction: repeat 50 [forward 5]
Do it:   ◯ Once
           ◯ Many Times
```

Notice that the in addition to the change of instruction the Button was also changed to Once rather than Many Times. Did you remember to click on the Eye Tool to open this dialog box to edit the instructions?
Examine the `repeat` command carefully.

- It must be followed by a number.
- The number must be followed by a list of instructions contained in square brackets `[ ]`.

Experiment with `repeat` to be sure you understand how it works. You might want to try entering some `repeat` instructions in the Command Center and observe the Turtle action on the screen. For example, enter

```
cg
repeat 90 [forward 80 right 178]
```

These instructions will take the Turtle `forward 80 right 178` a total of 90 times. If you didn’t have the Turtle’s pen down, add the `pd` instruction in the Command Center and run the instructions again. Rather nice, don’t you agree?

Clear your screen and try another experiment.

```
cg
repeat 18 [forward 20 right 45 back 10 left 25]
```

or

```
cg
repeat 360 [forward 1 right 1]
```

`Repeat` can be useful when you want to control the number of times an action occurs.

### Tips and Techniques

Have you made more than one Button on a Page at one time? If not, do so now and move one over the other. This will help you to see the layering of objects that occurs *MicroWorlds Pro*. If you have a Turtle and a Button, you will see the same layering occur if you move one over the other.

As you create Turtles, they will be closer to the background than any other object. Turtles are layered upwards as you continue to add new ones. Sliders occupy the next level. However, Sliders are stacked front to back as they are created. The next objects in place are the Buttons. They layer as the Sliders with the newer ones appearing closer to the background and Turtles than the older ones. The Text boxes occupy their own layer closest to the front of the Page. You cannot place a Text box behind a Turtle, Button or Slider. If necessary, you can move an object to the ‘newest’ position in the layering by cutting it from the Page and pasting it back in place.

When you work with different Turtle shapes you may not remember which way the Turtle is facing. To keep the motion appropriate to the
Turtle shape, you may need to recheck the direction. You can give the Turtle back the standard shape by entering

```
setsh 0
```

in the Command Center. When you have adjusted the direction you can change the shape back.

You may realize that the Turtle, even using the standard Turtle costume, has disappeared. If you are exploring with color you may have turned the Turtle color into a color that blends with the background. Use the `setc—set color—command. Enter `setc 9` to change the Turtle to black or `setc 1` to set the Turtle to white.

You have seen the value in using the `repeat` command. However, keep in mind the requirement of the square brackets `[ ]` rather than the more usual parentheses `( )`. Since computers are incredibly talented at doing the same thing over and over, taking advantage of it gives you great additions for your Projects.

Buttons do require some thought and planning. However, they are powerful in making your Projects fun and interesting for others. They are a way to give the user of the Project some control of what happens on the screen. This interaction adds an engaging factor to any Project.

As you review for yourself the new concepts in this chapter there are several points to keep in mind.

1. You may want to move a Turtle shape in an appropriate direction requiring you to change the Turtle direction. Do you remember how this is accomplished? There is one additional tip to make this easier.

2. Turtles like to move on the screen and the choices are endless. Do you remember how to vary the distance the Turtle moves?

3. You have been introduced to several new Logo words and although you do not need to memorize them having them handy might be a good idea for the next few chapters. Stop to make a list of all the Logo words you can remember.

4. Remember that any instructions placed in the Command Center will be gone when you reopen the Project. Instructions placed on Buttons or Turtles will be saved with the Project.
Chapter 5

Multiple Turtles

Turtles play a central role in MicroWorlds Pro. You have already seen that the Turtle can be used in a number of different ways. You can change the shape and size of the Turtle and use it to stamp images on the background of your Pages. You can use Logo instructions to move the Turtle so that it can use its pen to draw on the background. You can use the Turtle to create animation.

So far, you have worked with a single Turtle, changing its shape and size as needed. However, in MicroWorlds Pro you can have as many Turtles as you like. There are several ways you can use more than one Turtle. For example, one Turtle can be shaped like an airplane and fly across the sky, while a second Turtle shaped like a dog runs along the ground.

In this chapter you will explore the idea of creating multiple Turtles on a single Page. You will learn how to “drive” more than one Turtle by using Logo instructions and Buttons. You will also learn how to program Turtles to behave as you wish. As you might imagine, it is necessary to have a few more Logo steps to control a herd of Turtles.

It is best to take your time working through the examples in this chapter. Since handling more than one Turtle at a time will play an essential role in many of your Projects you need to be sure you are ready. While you add to your knowledge base about MicroWorlds Pro, you will again practice many of the things you already know. Be sure you understand and are successful with each technique as it is given to you.
Creating Additional Turtles

Using the Turtle Creation tool, create one Turtle on a new page.

![Turtle Creation Tool Dialogue Box]

This Turtle is given the name t1. Click on OK and close the dialog box.

Technical Note: You have seen drop down menus from the Project tab. There are similar menus available in the Page. Hold down the Control key or use the right mouse button and click an object on the Page. Selecting Edit from the drop down menu opens this same dialog box.

You are now ready for more Turtles. You can use the Turtle Creating tool to create additional Turtles. You will need to move back and forth between the tool and the Page. Each time you select the tool and click on the Page a new Turtle will be visible.

![Turtle Image]

It might be faster to select the Turtle and use a Copy and Paste approach to getting more Turtles on the Page.

![Turtles on Page]

Since you can easily move the Turtles to a new location, you might want to create several at once and place them on the corner of the Page until you need them.

Each Turtle on your Page has its own dialog box. Use the Eye tool and click on one of your new Turtles.
This example is from the newest Turtle on the Page. It has the name t4. Each time a Turtle is added to the Page the name is sequentially related: t1, t2, t3, t4, and so forth.

As you may have guessed, you can easily remove a Turtle from the Page. Select the Turtle so the handles show and use the Delete or Backspace key. Or, select the Scissors tool on the Toolbar and click on the Turtle object to remove it.

If you remove a Turtle the names of all other Turtles visible remain unchanged. However, if you create a new Turtle, it will be given the name previously used by the one you Delete or Backspaced. For example, if you delete t2 and are left with t1, t3 and t4. The next Turtle you hatch will have the name t2.

When you copy the Turtle the original and the copy are identical except for their names. MicroWorlds Pro will automatically give the copy of your Turtle its own name. For every other characteristic—shape, heading and so on—the two Turtles are identical. This is referred to as inheritance, a key concept of MicroWorlds Pro objects. If you use the Turtle Creation Tool to add Turtles to the Page, this does not occur. New Turtles can inherit properties only if they are created as a copy of a Turtle.

Turtles can be moved on the Page. Click on the Turtle and hold down the mouse Button. The hand pointer will appear. This will let you move the Turtle. This is exactly the same method you used earlier to move Buttons.
Using Multiple Turtles to Create Backgrounds

One way you might want to use multiple Turtles is as Drawing tools. Suppose you want to create a Page that will allow a user to create a scene with houses, trees, and flowers. You can create a deciduous tree Turtle, an evergreen tree Turtle, a flower Turtle, and a couple of building Turtles. Place these Turtles in a row across the bottom of the Page.

Next, use the Graphics tab tools and complete a background.
The Turtles you placed earlier can be used to stamp their images on the background to create a completed scene.

![Image of a completed scene with Turtles stamping images.](image)

The Turtle shapes are replaced at the bottom of the Page ready for further changes should you wish to make them.

**Controlling Turtles with Buttons and Logo**

Start with a new Page containing only one Turtle. Make the Turtle a shape and size of your choice. Choose some shape that you would like to move across the Page. Now go to the Command Center and enter

```
repeat 10 [forward 5]
```

The Turtle moves up the Page. If you want the Turtle to move left or right on the Page, you’ll need to enter

```
left 90
```

or

```
right 90
```

Experiment until you have the Turtle going the direction you want.
If your Turtle is moving too fast, you can use the **wait** command to slow it down. For example,

```
repeat 10 [forward 5 wait 3]
```

causes the Turtle to pause for 3/10 of a second between each **forward** command.

Now, create a second Turtle. Choose a shape and size for it. Turn the Turtle so it is heading in an appropriate direction and is moving the way you want it to move.

As you worked with your new Turtle, several things happened. Did you notice that the instructions you were using caused only the second Turtle to move? How do we get the first Turtle to move? Try clicking the first Turtle and then click in the Command Center to run the **repeat** instruction. Press Return or Enter and watch to see which Turtle moves. The Turtle you clicked on moves. Click on the different Turtle and repeat your steps. Clicking on a Turtle makes it the active one. The instructions are automatically given to the active Turtle.

There is also a Logo command to tell a particular Turtle to follow a set of instructions. Recall that the first Turtle you create on a Page is named **t1**; the second one is named **t2**. If you enter

```
talkto "t1
repeat 10 [forward 5 wait 0.1]
```

the first Turtle moves. Notice that there is one double quotation mark (") before the name of the Turtle.

There are two shorter ways to address a particular Turtle. The short form of **talkto** is **tto**.

```
tto "t1
repeat 10 [forward 5 wait .1]
```
You can also use just the name of the Turtle followed by a comma.

t1, repeat 10 [forward 5 wait .1]

Practice having the first Turtle and then the second Turtle move. Later in this book you will learn that you can use this technique to communicate with other MicroWorlds Pro objects.

Another way to give instructions to Turtles is by using Buttons. Create two Buttons. Put instructions on one Button to move the first Turtle.

Then put instructions on the second Button to move the second Turtle.

Recall that you can change the size of a Button. Select the Button by using Command (⌘) or Control key and clicking on the Button. Click and drag on a black handle to resize the object.

Once both of the Buttons are the size you want, you can select both of them at the same time to move them into position. Hold down the Command (⌘) or Control key. In addition hold down the Shift key and click on the first Button. Continue holding down all both keys and click the second Button. Both Buttons are now selected. Place them where you want them on the Page.
If you now click on the first Button and then quickly click on the second Button, both Turtles will move at the same time. Making two things happen at the same time is called launching independent processes.

Making your Page easy for others to use and understand is important. The Buttons will make more sense to someone else if you give your Turtles names. Use the Eye tool and click on one of your Turtles. Change its name in the dialog box that appears.

Do the same thing to change the name of the other Turtle. Next, change the instruction lines in the Buttons so that they use the new Turtle names. Now others can more easily use your Page.

Be sure you understand how to work with multiple Turtles. Add a third Turtle and Button and complete the appropriate directions.
Putting Logo Commands on Turtles

When you create a new Turtle, a dialog box appears much like the box you use to add Logo instructions to Buttons. You opened the dialog box a moment ago to give each Turtle a meaningful name. Instead of leaving the instructions on the Button as shown in the previous example the Turtle dialog box can be used.

This dialog box belongs to the Turtle named **bus** and contains the same instruction given earlier. Placing the instructions in the Turtle dialog box means that if you click on the Turtle the instructions will be followed. Try it.

At the moment the instruction is run once and the repeat command is used to have the Turtle move forward several times. Change the setting at the bottom from Once to Many Times and then click on your Turtle again.

Since doing something Many Times is repeating the action, the instruction line has been changed.

You should now have the Many Times radio Button selected for each of your Turtles. Now if you click on the bus, it will continue to move until you click on it again. If you click on the car while the bus is moving, both Turtles will continue to move at the same time. To stop a Turtle, click on it. To stop all of the Turtles, choose **Stop All** from the **Edit** menu or use the Stop All Button on the Toolbar. Of course, you can use **repeat** instructions on the Turtles if you want them to move a specific number of Turtle steps.

Each of the Turtles you have moved so far has not changed its shape while moving. You can also use more than one shape for a Turtle to give the effect of animation. Create a new Turtle. Give it one of the bird shapes.
Now put the following instruction in the Instruction box in the Turtle dialog box.

```
Name: bird
Instruction: setsh "bird1 forward 2 setsh "bird2 forward 2
Do it: 0 Once 0 Many times
```

Take the time to go to the Shapes palette and look carefully at the shapes bird1 and bird2. They are slightly different.

When you click on the Turtle and it changes from one shape to another, the bird appears to fly. Remember that to stop the motion of the Turtle, you can click on the Turtle itself or you can use Stop All from the Edit menu.

When you create Buttons with a lot of instructions on them, they can become ugly and large. If the instructions are rather complex, they also can be confusing for other people to use. One solution to this problem is to use Turtles as if they were Buttons.

You already know the steps to create a Turtle shape to fit your own specific needs. Select one of the empty shapes from the Shapes palette. Double click the empty shape to open the Shape Editor. Create an icon that will help the user of your Page know that this is where you click to make the bird fly.

When the shape is complete, be sure to name it. Create a new Turtle and give it the shape you just created. Edit the dialog box of your new
Turtle that will be used to control the bird. Put the instructions on it to make the bird shape fly.

![Turtle dialog box](image)

Now when you click on the Turtle called Fly (which onscreen is the word Fly) you see a bird fly across your Page.

![Bird flying across Page](image)

As it moves, its shape changes, giving the appearance that the bird is actually flying. Oops. Something wrong? Did you perhaps neglect to change the direction of the Turtle you dressed as the bird before you let it fly away?

### Tips and Techniques

When a Turtle doesn’t move as you expect it to, check its name. Perhaps you are not using the correct name to address the Turtle. Perhaps you made a typographical error. Check both the Turtle dialog box and the list of instructions carefully.

Remember that you can cause all action on the Page to stop immediately by using Stop All from the Edit menu or the Stop All Button found in the Toolbar.

It is easy to become confused when working with more than one Turtle. You can lose track of which Turtle you are addressing. To find
the name of the active Turtle, use the Logo word **who** with the word **show**. If you enter

```
show who
```

the name of the active Turtle appears in the Command Center. In the Logo language, the word **who** reports the name of the Turtle. The word **show** puts this name in the Command Center.

Be careful when designing Turtle Buttons that have white backgrounds. If your shape is enclosed like you did with your Fly Turtle shape you can click anywhere within the square to activate the instructions in the Turtle dialog box. However, if you design the shape

```
FLY
```

you must click on the black dots to activate the Turtle instructions. The solution to this problem is to fill the background with a light color.

```
FLY
```

This chapter has given you many new ideas and skills. You have had the opportunity to glimpse some powerful features included in *MicroWorlds Pro* and are probably already thinking about how you might use them in a Project. As you review your learning there are several things you will want to consider.

1. Turtles are wonderful creatures and a great addition to your Projects. Can you add, Delete or Backspace, copy, and change their shapes? Can you remember the steps needed to customize a shape? Did you take the time to review the concept of **inheritance** that is so helpful when working with objects?

2. With multiple Turtles on the Page working with them becomes challenging. Can you remember how to find their names, dialog boxes, and so on? Can you determine which Turtle is active?

3. You know that you can use one Turtle to activate another. Do you remember the instructions that allow you to do so? And the naming that makes this easy to do?

4. You probably realize that most of today’s microcomputers have only one central processing unit that carries out the instructions you specify. However, an increasing number of computers have two or
more processing units. You can imagine having one processor carrying out the instructions for one Turtle and a second processor carrying out the instructions for a second Turtle. This would be an example of parallel processing. There is a more complete discussion of parallel processing in the second book in this series, *MicroWorlds Pro—Hypermedia Project Development and Logo Scripting*.

In our examples where more than one Turtle is active at any given time, the software is able to pretend it has access to parallel processing. This smooth emulation certainly works effectively and is central to much of the special attraction of *MicroWorlds Pro*. 
Chapter 6

Working With Text Boxes

You now know how to create colorful background scenes. You can now use two kinds of objects—Turtles and Buttons—that are layered on top of a background scene. For example, you know how to make a Button so that when a person clicks on the Button, a bird-shaped Turtle flies across the scene.

Background scenes and animation are very useful aids to communication. However, written words are also important. In this chapter you will learn about a third MicroWorlds Pro object—Text boxes. Text boxes are used to put words and numbers on the Page. Text in Text boxes behaves like text in a word processor—it can easily be entered and edited.

Text boxes have another use. You can enter a list of Logo instructions into a Text box and then have the computer automatically carry out this list of instructions.

Creating and Using Text Boxes

Get a new Project or Project Page. To create a Text box, click on the Text box tool.

When you move the mouse pointer onto the Page, the pointer changes to look like a pen.
If you click the mouse Button a Text box that looks like this appears at the location of the pointer:

![Text box example]

However, if you *click and drag* the pen pointer, you can make the Text box any size you want. Later in this chapter you will learn how to change the size of an existing Text box.

![Dragging text box example]

When you first create a Text box or when you place the pointer in a Text box and click the mouse Button, a vertical insertion point appears. This is the *text insertion point*. This is the point at which text will appear if you begin keyboarding.

Enter a sentence or two into the Text box.

![Example text]

Notice that the Text box behaves like a word processor. Complete words automatically jump to the next line. This is called *word wrap*. Notice that you can move around in the text by using the Up, Down, Left, and/or Right arrow keys. The vertical insertion point moves
around. Try moving the mouse pointer and clicking in the text. The vertical insertion point is placed at the location of the mouse pointer when you click the mouse Button.

Notice that if you begin entering text where you place the insertion point, the text moves to the right to accommodate any words you add. Try pressing the Delete or Backspace key. Letters are erased from right to left. Continue to experiment with changing the text.

Although you are probably familiar with word processors, here are some reminders of problems that can occur when you are deleting text:

• Sometimes words become “glued” together. With the pointer between the words, press the space bar to separate them.

• Sometimes words jump from one line to the next. This happens because you have Delete or Backspaced the invisible space between the words.

• If you put the insertion point on a blank line and press the Delete or Backspace/Backspace key, the blank line will disappear. This happens because you have Delete or Backspaced the invisible “carriage return” character. Simply press the Return or Enter key to replace it.

• If you put the insertion point on the first character of a paragraph and press Delete or Backspace/Backspace, the paragraph moves up to join the one before it. Again, the invisible end of paragraph return character was deleted. Press Return or Enter to put it back.

You can also Cut, Copy, and Paste text in Text boxes. In fact, you can copy text from other sources—other word processors or the Scrapbook—into Text boxes. To select text that you want to Cut or Copy, use the mouse to click and drag to highlight the text.
Then select **Cut** or **Copy** from the **Edit** menu. Move the insertion point by using the mouse. **Paste** the text at the new insertion point.

![Text box example](image)

Take some time to be sure you know how to **Cut**, **Copy**, **Paste** and modify text in Text boxes.

In addition to editing the words you place in Text boxes, you can change the formatting of the text. If you select a block of text, you can use the **Font** menu to specify a different type family. When you start *MicroWorlds Pro*, type is entered into Text boxes using Arial type. This is not a good choice, particularly if you have more than one or two words in the Text box.

If you are a Macintosh user, you find the choices **Font**, **Size**, **Style**, and **Color** on the **Text** menu. On the PC only two items are displayed—**Font** and **Color**. To format text, PC users must first choose **Text** before adjusting font, size, and style.
Select a block of text. Choose a type family—in our example New Century Schoolbook. The selected text changes.

You can also change the size of the selected text.

Notice that if you now click in the Text box, scrolling arrows will appear on the right side allowing you to access all the text in the Text box.

Note that some typefaces will look “jaggy” in some of the sizes available. For example, the text below is in Athens.
The type is unpleasant to look at or to read.

You can also change the type style.

Again, some size/style combinations will look “jaggy.”

You can also select a color for the text, either before you begin entering text or when you are editing. When you select Color from the Font menu on the Macintosh, you see the following dialog box. Select a color of your choice by clicking on a square in the grid.
When you select **Color** on the PC, the choices seem extremely limited. However, if you click on the Define Custom Colors Button included you are given access to a much wider range.

With these options you can use any color in the rainbow.

The current settings for typeface, type size, and type color remain the same when you create a new Text box. Of course, you can change any of these settings at any time you want.

**Manipulating Text Boxes**

Text boxes are *MicroWorlds Pro* objects. They can be manipulated in much the same way that you manipulate Buttons and Turtles. Most of the steps you have already learned can be applied here. In addition, the tools you used earlier to change Buttons and Turtles work with Text boxes.

To select a Text box, you can

- Click and drag around the Text box using the arrow-shaped pointer.
- Click and drag across the border of the Text box (PC users this must be the left edge of the box.)
- Hold down the Command (⌘) or Control key and click on the Text box.
When you select a Text box, handles appear. You can then change the size of the Text box by clicking and dragging on one of the handles.

The text in the box adjusts to the new shape of the Text box.

When a Text box is selected, you can use Cut, Copy, and Paste from the Edit menu to make a copy of a box. When you copy a Text box, the text in the box is copied along with the box itself.

The copy appears behind the original and slightly lower and to the right. If you click on the copy it will move in front of the original Text box. These objects, like Turtles and Buttons, are in layers. The most recently selected Text box will sit on top of the others. Also, Text boxes always stay in front of Turtles and Buttons.
You can also move a Text box to a new location on the screen. If the Text box is selected—if the handles are showing—you can click anywhere in the Text box to drag the box to a new location. In the beginning, you may find clicking the Text box name if it is visible the most convenient place to click.

If the Text box is not selected, the technique for moving it differs slightly. Pick a Text box that is not selected. Move the regular pointer very slowly from outside the Text box, across the border around the Text box, and into the interior of the Text box. You see the pointer change from the regular pointer to an open hand to an I-beam. When the pointer is the hand shape, you can click, hold down the mouse Button and drag the Text box to a new location on the Page.

When the pointer changes to an I-beam, you can add or modify text in the Text box.

To remove a Text box, first select it. When the handles appear, you can press the Delete or Backspace key. You can also use Cut from the Edit menu or the Scissors tool from the Toolbar. Remember that when you delete a Text box, you are also deleting the text that is in that box.

You can modify a number of characteristics of Text boxes. Use the Eye tool and click on the Text box to open the dialog box.

Text boxes—like Turtles—have names. You can change the name of a Text box by entering it in the Name box of the Text box dialog box. By default, MicroWorlds Pro displays the name you give to the Text box. If
you do not want it to show, deselect the Show Name option in the dialog box.

All of your Text boxes to this point have displayed both the text and the outline of the box. There are many instances where this is distracting. While having the Text box is an excellent way to include text, you may want the Text box to be Transparent. The text can still be read but you no longer see the borders defining the Text box.

Of course, the Show Name setting had to change as well.

Before you do anything else try to edit the text you have in the transparent Text box. You’ll find it can’t be done. However, you can there is a way to solve this problem. Use the Eye tool to open the Text box dialog box and remove the transparent setting.

With the box visible, make whatever changes you wish. Set the box to transparent once again.
An opaque Text box covers any background you may have created.

As you design your Page you will need to plan ahead. Placing the Text box appropriately makes your Page easier to use. In some cases, switching the Text box to transparent solves the problem for you. A transparent box can even put text on top of the active Turtle. Text boxes that are transparent can be selected or moved in the usual way.

You may need to print the Pages in your Project. If your Page has text in a field now showing scrolling areas, only the text that is visible prints.

There is a way to see the entire text in a Text box if you need to do so. Once again, Logo commands to the rescue. Go to the Command Center. Enter the name of the Text box and use the Return or Enter key.

text1

The entire contents of the Text box will immediately appear in the Command Center. If you need to you can copy and paste the text from here into a word processor for editing and correction. Then Copy and Paste it back into the Text box.

Using Text Boxes in Projects

One obvious way to use Text boxes in Projects is to use them as labels for pictures, diagrams, charts, or graphics. For example, suppose you want to use MicroWorlds Pro to create a report on an animal. The large Turtle shown in the next illustration was imported from some clip art. Details on how to use clip art are given in Chapter 9.
You might start with a title for your report.

Then you could add Text boxes giving more information. If you have a number of Text boxes that should look alike, create one Text box. Decide on the type family, type style, and other properties of the Text box. Then make as many copies of the Text box as you need.

The copies will each inherit the characteristics of the original, because a Text box is an object in *MicroWorlds Pro*.
You can use transparent Text boxes to put labels onto the background.

A MultiPage Project

Perhaps all of the Projects you have worked on so far are single-Page Projects. The Turtle Project started here can be improved by using multiple Pages.

For example, you might want to add three Pages—one each for the shell, legs, and head. When you do this, you want to make it easy for the user to move from this opening Page containing the main drawing to a Page containing a more detailed drawing and information about a part of the Turtle, such as the head.
One way to move from Page to Page is to use Buttons. The Page containing the main drawing of the Turtle will contain three Buttons, each of which moves the user to a different Page. Because the names of the Pages become Logo commands, naming the Pages Shell, Legs, and Head will result in a Page that looks like this:

Putting the Page name “Legs” in the Instruction box of the Legs Button will cause the Legs Page to appear when the Legs Button is clicked. In addition, the Buttons can act to label the drawing and the transparent Text boxes are not needed.

Another approach would be to make Turtles that act like Buttons to link to other Pages. In the Shapes palette, you can create a Turtle shape that gives the user of your report a cue to click for more information.

Recall that when you are working with small Turtle shapes, like the dot shown above, you must click on the “colored” part of the Turtle to
select or move it. If you make your Turtle shape too small, it may be hard to click on it.

Each of these dot-shaped Turtle Buttons can be put next to one of the labels. For each of this little Turtles put the appropriate Page name in the Instruction box. Clicking on the dot next to each label leads to a Page where there is more information about the topic.

Finally, a Text box can be used to prompt the user to click on the appropriate spot on the Page to get more information. A border can be added to make the Project look more complete.

Tips and Techniques

Text created in other word processors can be copied and pasted into Text boxes in *MicroWorlds Pro*. Thus, you could prepare a report and use the word processing tools, such as a spell checker, to check your work. Then copy the text into a Text box. However, the formatting from the word processor will not be preserved when you copy and paste text into a Text box.

When you are creating a Project, you are designing a communication to be used by yourself and/or others. As you continue to increase your knowledge of using *MicroWorlds Pro*, you should
continue to think about design. Several suggestions have been given in the examples. By now, you recognize that to produce the Projects you have in your mind will take time. Ending up with a Project that does not communicate effectively is not a great idea. As you reflect on the latest steps you’ve made take the time to consider these ideas.

1. Creating a Project that has several Pages is challenging but satisfying. In addition to thinking of making the most of the communication on each Page you need to consider the Project as a cohesive unit. Helping the user of your Page to understand how the Project is structured is important. Helping the user understand each option available on a Page is part of the design challenge. Try to think in terms of how the user will see or react to the elements on your Pages.

2. One of the design concerns not mentioned earlier is the concept of audience. Before you spend time working on a Project, stop to think about the needs of the person(s) you hope will use the Project. What is suitable for small children is hardly going to work for adults and vice versa.

3. MicroWorlds Pro combines dynamic and static elements to communicate your message. Each object adds to the message. Don’t slide into the habit of adding them simply because you can. If you can’t clearly explain why you have a particular element on a Page, it probably doesn’t belong there.

4. In a later chapter you will find more detailed information on designing hypermedia documents—the non-linear document containing a variety of media—that are so easily produced in MicroWorlds Pro. The chapter includes several shortcuts and tips to create a cohesive and consistent Project.
Chapter 7

More With Text Boxes

Throughout your explorations in MicroWorlds Pro, you have been reminded that the online Help menu is ready and waiting for your use. Even if you use it to find the name of a tool or shape, it is helpful to remember you have it handy. However, there is nothing magic about the Balloons or Tips. In this chapter you will learn more about putting text into Text boxes—this is what is happening when you access Help Balloons or see Tips.

Using Logo to Put Text in Text Boxes

Once again, instead of relying on menus, pointers, and tools you have features in the software that easily extend the possibilities. Taking the time to develop you understanding of a few more Logo terms will give you greater flexibility in producing Logo instructions.

In the previous chapter you learned how to enter text directly into a Text box. You can also put text into Text boxes by using Logo instructions. The new term is print or pr.

Create a new, empty Text box on your Page. Go to the Command Center and enter

\begin{verbatim}
print [This is some sample text to put in a Text box.]
\end{verbatim}

or

\begin{verbatim}
pr [This is some sample text to put in a Text box.]
\end{verbatim}

Understand that the Logo word is print. This word needs something to respond to so anything you enter enclosed in square brackets—[ ] not by parentheses ( )—is used by the command. Once the instruction is given, the words between the brackets appear in the Text box.

\textit{Technical Note: Text cannot be added to invisible Text boxes by using Logo instructions. The Text box must be “active.” Also, spaces at the beginning or end of text between square brackets will be ignored by Logo. Techniques for including spaces in text with Logo commands are}
discussed in MicroWorlds Pro—Hypermedia Project Development and Logo Scripting, the book written to extend beyond this book.

You can clear all of the text from a Text box by moving to the Command Center and entering

cleartext

or the abbreviation
c

If you have more text in a box than can be displayed, this command will remove it. The Text box will be completely empty.

A third command for working with text in Text boxes is insert. Remove any text from your Text box and enter

insert [This is some sample text to put in a Text box.]

The text appears in the Text box. Insert and print are very similar. Print puts a carriage return character after the text, while insert does not. That is, if you enter

print [Use print to add some text.]
print [Use print to add more text.]

you see

However, if you clear the text from the box and then enter

insert [Use insert to add some text.]
insert [Use insert to add more text.]

you see
**Insert** does not move the insertion point to the next line; **print** does move the insertion point to the next line. In fact, **Insert** did not even put a space between the two blocks of text.

Note that if the text you put in a Text box using **print** or **insert** will not fit into the box, you may see partial lines of text.

If you give *MicroWorlds Pro* some time, the Text box will adjust to add the scrolling arrows needed to access the contents of the box.

Because Text boxes are objects and have names, you can have text appear in a Text box by using its name. Suppose you have two Text boxes, **text1** and **text2**, on your Page. If you then enter

```plaintext
text1,
print [hello]
text2,
insert [Use insert to add some text]
insert [Use insert to add more text]
```

you see
If you enter
\texttt{text2, ct print [bye]}
all of the text in the second box will be removed, and the word “bye” will appear in it.

**Using Text Boxes to Contain Logo Code**

Text boxes can be used to contain Logo code. You can run Logo code that is in a Text box from the Command Center. Suppose you have two Text boxes, each with different Logo instructions in them. Hatch a Turtle so you have one of those friendly creatures to direct.

Go to the Command Center. Enter
\texttt{run parse text1}
The Turtle moves to the center of the Page, goes forward 50 Turtle steps, and turns to the right.

If you enter
\begin{verbatim}
run parse text2
\end{verbatim}
the Turtle returns to the center of the Page, goes back 50 Turtle steps, and turns to the left.

If you have difficulty seeing what occurs, you can have the Turtle leave tracks as it moves. You already know that to have the Turtle create a trail for you the pen needs to be down. So, you might add a \texttt{pd} command to your instructions. This makes the results of the instructions more obvious.

\textbf{Technical Note:} The Logo word \texttt{parse} changes the contents of the Text box into a Logo list. \texttt{Run} needs a list to function correctly. There are more details about Logo grammar in the second book in this series, MicroWorlds Pro—Hypermedia Project Development and Logo Scripting.

\section*{Using Text Boxes in Projects}

In Chapter 4 you saw how to create an “Instant Logo” by using Buttons. In that example, a user clicked on Buttons to cause the Turtle to move. You can also use a combination of Buttons and Text boxes to create an even more flexible Instant Logo.
Suppose you want to have a number of Buttons that the user can click on to cause the Turtle to take various actions. In this example, the Turtle named \texttt{t1} is to be controlled by clicking on the Buttons.

First, create a Text box and put a Logo instruction in the box. Then place a new Turtle—here named \texttt{t2}—directly below the box.

```
forward 5
```

Put Logo instructions on this Turtle that will run the instructions in the Text box.

```
Name: \texttt{t2}
Instruction: \texttt{t1, run parse text1}
Do it: \checkmark \texttt{Once}
```

Now create a Turtle shape that can be used to tell the user where to click. In this example, the “Go Fd” is the Turtle shape that was created. It is now a Turtle Button.

```
forward 5
```

```
Go Fd
```
Add as many Text boxes and Turtle Buttons as needed for your version of an Instant Logo program. You will probably want to cluster them at the bottom of the Page. Remember to create a separating line by using a long narrow Button or Text box.

One advantage of creating an Instant Logo program by using this technique is that the contents of the Text boxes can easily be changed. For example, the user can change the turns to 5 degrees or the forward or back distance to 20 Turtle steps.

More elaborate commands can be added. For example, instructions to draw shapes could be added. You could add a Square Turtle Button to draw a square. You could add instructions to change color and pen size for the Turtle to use. Or you could include some generic Do It Turtle Buttons for more complex commands. Clicking on this Button

```
repeat 4 [fd 100 rt 90]
```

Square
causes a square to be drawn. From the options in your new world see how quickly you can produce a copy of this image.

Tips and Techniques

When you enter text into a Text box using the print instruction, an invisible carriage return is placed at the end of the text. If you were manually entering text the invisible character is created when you use the Return or Enter key. However, if you use insert, no such return character is inserted. This can be confusing when you are working with text in a Text box. Always keep in mind that there may be invisible characters in a block of text in a Text box.

Keep in mind that you must use the name of an object followed by a comma (,) when you want that object to respond to Logo instructions. If you forget the name and the comma, the current active object will respond to the instructions. To remind yourself of the names you can use the Command (z) or Control key and click on the object. Select Edit from the drop down menu to display the name or to change instructions.

As you reflect on other ideas in this chapter you will begin to feel there is an advantage to using a word processing editor in conjunction with your MicroWorlds Pro Project. Organizing and editing text that gets placed in Procedures or Text boxes is a time saver. You can place instructions in a Text box and then execute these instructions from elsewhere by using the run parse command. This is convenient if you are working with a long set of Logo instructions. You can even hide the instruction set by setting the Text box to be invisible.
Having another application open to create the Turtle shapes used to label the directions in the interactive Logo world is another way to save time and effort. The ones in the included example are copied and pasted from an *AppleWorks* document into the Shapes palette of the Graphics tab. These labels are much neater than those created using the Graphics tab painting tools.

Remember you have encountered similar shapes in your earlier work. Creating word shapes in the Shape Editor requires you to place a border around the word or flood the shape with a contrasting color. Using the **Copy** and **Paste** approach avoids this problem since this includes white pixels to fill in the shape. The borders in the example were added to enhance the clarity of the Page design.
Chapter 8

Sound, Music, and Video

*MicroWorlds Pro* provides a rich environment for exploration, learning, communication and problem solving. You now know how to use to create Projects that include colorful images, animation and text.

This chapter adds another dimension—sound—to communication. In this chapter you will learn how to use existing sounds, create your own sounds, and compose music. In addition, you can import movie clips to enhance your Projects. Each of these items is another type of object and they share many characteristics of the other objects you have already studied.

**Working With Sounds**

You are no doubt aware that there are sounds built into your computer. Make sure that the sound is turned on so that you can hear it. Check the Sound Control panel settings.

If you have a microphone on your computer system, you can add sounds of your own. Click on the Recording tool and then click on the Page. You see the Recording dialog box.

If you have an external microphone, be sure it is plugged in. Click on the Record Button, and record a sound or a short message. When you are finished, click on Stop. Use the Play option to check the sound file.
If you are satisfied, you are ready to save it. Once you click OK the following dialog box becomes available

Like other objects, MicroWorlds Pro lets you give the sound a name. In addition, you need to choose the format from the drop down menu.

Click on the sound object to hear the sound. You can also enter the name of the sound in the Command Center to hear it.

It is best to name your sound with a single word. However, if there is a space in your sound name, you can still run it from the Command Center or a command. Suppose you named your sound “Hello Goodbye.” To play this sound from the Command Center, enter !Hello Goodbye!

You can edit a sound object by the usual method of clicking on the sound object with the Eye tool. You see the sound object dialog box.
You can change the name of the sound object in the box provided. In addition you have the usual options of Show Name and Visible. If you make a sound invisible, no icon appears. However, any sound recorded into a Project becomes a command in *MicroWorlds Pro.* Simply enter the name of the sound in the Command Center greetings You then hear your sound. Of course, you can use Buttons to control sound as well or put them on Turtles.

Technical Note: When you record a sound to a file, it is stored outside of your Project and can be played inside the Project. See your MicroWorlds Pro User’s Guide for details. Make a note to ensure that sound files are stored in the same folder as your Projects and taken along if you move your Project file to a different computer.

### Using the Melody Editor

Creating music in *MicroWorlds Pro* is extremely easy, even for those with no musical training. To create musical sounds, you select the Melody tool.

When you click on the Page, you see the Melody Editor.
There is an insertion point at the top of the Melody Editor. This area is where your composition is placed as you create the song. Each note is entered in the song by clicking on a piano key in the Melody Editor piano keyboard. Use your pointer and click on several of the keys on the keyboard. Notes appear next to the insertion point. The color of each note matches the color above the piano key you clicked.

At this point, use the Play Button available in the Melody Editor to play your song. If it is similar to our example, plug your ears.

The Melody Editor is a sophisticated music environment. You use it to compose and edit; you use it to listen and modify; you use it for trial and error music practice. If you have a music background you'll find this a comfortable familiar world. If you do not have such a background just relax and enjoy. Anyone is capable of producing something that is pleasing to the ear.

Use the keyboard to add notes to your song. Use the Play Button to hear the combination of notes you add. Use the Stop Button to stop the notes from playing. Adjust the volume of the song with the Slider (relax, another object introduced in detail later) on the left. Adjust the tempo or speed of the song with the Slider on the right. Select the instrument used to play the song from the options on the left just above the keyboard.

These instruments are from left to right: piano, harpsichord, vibraphone, guitar, violin, clarinet and kalimba.

Often you song needs to have a pause—music rests—and they are added using the icons directly under the piano keyboard.
The longest pause is on the extreme left moving to shorter and shorter pauses as you move to the right. And, of course, music consists of notes that sound for varying lengths of time.

The Melody Editor is set to use a quarter note—highlighted in yellow—unless you change the selection.

You can choose selections measured relative to the time the quarter note sounds. From left to right:

• a whole note (4 times as long as a quarter note),
• a dotted half note (three times as long as a quarter note),
• a half note (twice as long as a quarter note), or
• an eighth note (half as long as a quarter note).

You can edit the notes you enter much as you edit text. Place the insertion point in your music. Click on the piano keyboard to insert notes. Move the insertion point to a new position and enter more notes. Use the Delete or Backspace key on your computer keyboard to Delete or Backspace notes.

You can also cut, copy, and paste a single note or group of notes. Select some notes by clicking and dragging.

Then use the Edit menu to Cut, Copy, or Paste.

When you are satisfied with a melody, you can either use the name already in the Melody Editor—Melody1, Melody2, Melody3, and so forth—or you can give it a name of your choice. The name becomes a command that you can enter in the Command Center or add to objects or procedures. If you use your names, keep them short and preferably one word. When you are finished creating a melody, you see a Melody object on the Page.
Continue to explore the Melody Editor. Create some tunes. Try making interesting sounds as well as musical tunes. Save any music or sounds you particularly like. Above all, enjoy this unusual software feature and make your world rock.

You can remove recording and melody objects that you have added to your MicroWorlds Pro Projects with the Scissors Tool. If the object is invisible, you can use the remove command. For example, to remove a sound Melody1, enter

remove "Melody1"

Be sure to include the quotation mark (" ) in front of the name.

Using the Note Command

You can also create musical sounds from the Command Center by using the note command. Enter the following in the Command Center:

```plaintext
note 60 10
```

You hear a musical note. Try changing each number after note. What does each one do? Did you discover that the first number is the pitch of the note? The larger the number, the higher the pitch. The second number is the length or duration of the note. The larger the number, the longer the note is played.

The duration of a note is measured in 10ths of a second.

```plaintext
note 60 10  (plays for 1 second)
note 60 30  (plays for 3 seconds)
note 60 5   (plays for 1/2 second)
```

To compute the length of a note, multiply the second input number to note by 1/10. The numbers of the notes are the MIDI note values. MIDI, which stands for Musical Instrument Digital Interface, is a widely used standard for working with digitized music. The following table gives the note values for a number of octaves.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>A#</th>
<th>B</th>
<th>C</th>
<th>C#</th>
<th>D</th>
<th>D#</th>
<th>E</th>
<th>F</th>
<th>F#</th>
<th>G</th>
<th>G#</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>34</td>
<td>35</td>
<td>36</td>
<td>37</td>
<td>38</td>
<td>39</td>
<td>40</td>
<td>41</td>
<td>42</td>
<td>43</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>46</td>
<td>47</td>
<td>48</td>
<td>49</td>
<td>50</td>
<td>51</td>
<td>52</td>
<td>53</td>
<td>54</td>
<td>55</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>58</td>
<td>59</td>
<td>60*</td>
<td>61</td>
<td>62</td>
<td>63</td>
<td>64</td>
<td>65</td>
<td>66</td>
<td>67</td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>69</td>
<td>70</td>
<td>71</td>
<td>72</td>
<td>73</td>
<td>74</td>
<td>75</td>
<td>76</td>
<td>77</td>
<td>78</td>
<td>79</td>
<td>80</td>
<td></td>
</tr>
</tbody>
</table>
Using this chart, you would play a C scale—the white notes on the piano—for the octave starting with middle C by using the following inputs to note:

- note 60 10
- note 62 10
- note 64 10
- note 65 10
- note 67 10
- note 69 10
- note 71 10
- note 72 10

There are no flats in this chart. If you have music that uses flats, you need to know, for example, that A sharp is the same note as B flat. Black notes on a piano represent sharps and flats. You then use the chart accordingly.

You can also change the instrument used to play your songs by using the `setinstrument` command. For example, to use the violin sound, enter

```
setinstrument "violin
```

You can also use your own sounds with the `setinstrument` command. Notice that this change does not apply to any songs you have already recorded and saved. However, it does provide an interesting option when you are using Logo commands to handle the music in a Project.

### Adding Movies to Projects

In addition to adding pictures and sounds to your *MicroWorlds Pro* Projects, you can add video clips. Select the Video tool
and click on the Page. You see an Open dialog box. In the *MicroWorlds Pro* folder locate the folder labeled QT VR. Choose the file Lakeside—one of three files available for your use. Click on Open to open the movie.

You see the first frame of the movie—called a *poster*. This poster functions as a movie object in your Project. To make the movie play, use the controls that appear along the bottom of the poster. Since this movie is a QuickTime Virtual Reality format, the controls may be less familiar to you.

*Technical Note: On the PC, even though a movie in VR format appears to add correctly, the format is not supported by the software.*

The following movie is a standard .mov format more common to PC users. The steps to add it to the Project are identical. Select the Video tool, click on the Page, and browse your hard drive to locate the file. Click on open. The movie poster will appear.
Notice the familiar movie controls along the bottom.

To access the movie object dialog box, select the Eye tool and click on the displayed movie poster object.

![Movie Object Dialog Box](image)

These are the usual choices you make for any object you create.

Note that movies are stored as separate files. The frame you see in your Project—the poster—links your MicroWorlds Pro Project to the file containing the movie. When you move your Project to a different location, you must move the Movie file as well. See your User’s Manual for details as to where MicroWorlds Pro looks for movies associated with a Project.

Movie files also provide you with another way to add special images to your background. Place a Movie object on the Page and then select the Stamper tool. Click on the visible movie frame. Before you can see the results you must move the Movie object. Click and drag the object in the usual fashion.

![Movie Stamp](image)

On the right is the Pink Elephant Movie object included in the MicroWorlds Pro QT VR folder. The other two images were stamped from this movie onto the background.
Tips and Techniques

When naming objects, remember that it is much simpler to use names using one word. If you want to use more than one word, use a period to connect the words or use mixed case to make the name readable. For example, you might name a sound my.sound or MySound.

Remember that all of the objects discussed in this chapter behave much like the objects you have already learned about. You can select them using Command (⌘) or Control and clicking the object. Black handles will appear on the corners of the object. When you click on an object with the Eye tool, you see an associated dialog box. In each case, the name of the object becomes a command that can be entered in the Command Center.

Even if you are not “musical” you can write music using the Melody Editor. With some simple sheet music and a chart to translate the symbols on a musical staff into frequencies, you too can be a composer.

The note command can be used for sound effects as well as music. Experiment with small and large numbers for the frequency to get very low notes—

```plaintext
setinstrument "clarinet
note 20 100
```

and very high notes—

```plaintext
note 110 30
```

and rapidly changing sounds—

```plaintext
note 30 1
note 31 1
note 32 1
note 33 1
note 34 1
note 35 1
note 36 1
note 37 1
```

The very low and very high numbers in the table of MIDI note values may not play as expected. Their sound depends on the instrument you are using, the duration, the volume, and the computer you are using. You may need to experiment with your computer to get the effect you want.

Because of the unexpected behavior of very high and very low notes, the sounds you can make using the note command can be more varied that those you can make using the Melody Editor.
Many people say, “Oh, I’m not musical. I can’t use Logo to make music.” In fact, it is much easier to use a computer to make music than it is to play the piano or other instruments. To get started, find some beginning instrumental music. You might ask the music department in your school for some simple music in the key of C. Match the notes on the music with the following chart and enter them by using the Melody Editor.

You now know how to combine Pages of colorful backgrounds with text, sound, and animation. The Pages need not be used in a sequential manner, and often there is no linear sequence on a particular Page or in a Project. This characteristic is used to define a hypermedia environment. It is a powerful environment for communication and for creation.

Increasingly, young children are being immersed in hypermedia environments for entertainment and learning purposes. At one time, the hardware and software to create and use hypermedia was expensive. Now it is reasonably priced and widely available. Moreover, the tools, such as MicroWorlds Pro, for creating hypermedia documents have become easy to use. Thus, many grade school students are learning how to create hypermedia documents. As you have seen learning to communicate in a hypermedia environment is challenging.

As you reflect on the learning you have done in this chapter—and rest your ears from the cacophony of sound—you might want to consider the following ideas.

1. You have made a start in incorporating movies and music into your Projects. You might spend some time locating a collection of your favorite music and movie clips. Another reminder about objects—add them only if they enhance the communication.

2. Most people never attempt to compose an original piece of music. Perhaps they can actually hear music in their mind but do not
know the musical notation language well enough to write it down. And, many people that can compose music don’t actually have the skills to play an instrument to test the composition. *MicroWorlds Pro* removes any such excuses. So, if you have never done it, go ahead and try. In today’s world, few people want to listen to Beethoven anyway.
Chapter 9

Working With Sliders

You now know how to create complex MicroWorlds Pro Projects. These Projects can communicate with a user via colorful background scenes, text, and moving Turtles. Moreover, the user can control some of the actions in the scene by using the Buttons you have provided. However, the user’s control is limited by the commands you include on Buttons and Turtles. Unless the user is familiar with Logo programming, it is not easy to vary such things as the amount a Turtle moves or turns.

This chapter introduces yet another type of MicroWorlds Pro object—a Slider. A Slider is an object that represents a numerical value. The person using the MicroWorlds Pro Project can control this type of numerical value. By moving the bar on the Slider the user controls how many times some action is to occur, how large a turn angle is to be, how long a waiting time is to be, and so on.

Creating Sliders

To create a Slider, click on the Slider tool in the Toolbar.

Move the mouse pointer onto the Page. The regular pointer changes to the shape of a hand holding a slider.
Click where you want the Slider to appear. The Slider dialog box appears.

![Slider Dialog Box]

For now click OK and the Slider object appears.

![Slider Object]

Notice that a Slider has a name and a range of possible values. The minimum value is automatically set to 0, while the maximum value is set to 99. You can change the range by clicking in the Minimum or the Maximum box and entering in different values. Slider values must be whole numbers in the range of -9998 to 9998 inclusive.

Examine the Slider. The name of the Slider appears on the left and a number—by default 50—appears on the right. The initial value for a slider is always the middle of the Slider range, in this case halfway between 0 and 99.

A Slider is an object that represents a numerical value. Click on the bar in the middle of the Slider. Drag it to the right. The numerical value of the Slider increases, and you see something like this:

![Slider Dragged Right]

Drag the bar to the left. The number gets smaller.

When you use a Slider, the name of the Slider represents the numerical value it has at any given moment. This value is indicated by the position of the bar on the slider and displayed as a number next to the name of the Slider.
If a Slider has a large range of possible values, such as 0 to 500, you may find it difficult to use the bar to get exactly the value you want. However, each time you click on the left side of the slider bar the value will decrease by one.

![Slider Image]

If you click to the right side of the bar on the Slider, the value will increase by 1 each time you click.

You are ready to use your Slider. Use the Turtle Creation tool to place a Turtle on your Page. Go to the Command Center. Enter `forward slider1`

The Turtle moves forward the number of Turtle steps currently indicated on the Slider. Move the bar. Click on the `forward` instruction in the Command Center again. Press Return or Enter. The Turtle moves a distance specified by the new setting on the Slider.

Next, create a Button. Put the `forward` command on the Button and set it for Many Times.

![Button Image]

Now click on the Button.

![Turtle Image]

The Turtle begins to move. Now click and drag the bar on the Slider. As you move the bar to the left, the Turtle moves more slowly. As you move to the right, the Turtle moves very quickly. Remember that you can stop the Turtle's movement by clicking on the Button a second
time. Later in this chapter you will have the opportunity to explore a number of different ways to use Sliders in Projects.

**Editing Sliders**

Most of the techniques you used to modify and work with Buttons and Turtles also work with Sliders. For example, if you want to move a Slider to a new location, click on the Slider and hold down the mouse Button. The pointer changes to a hand.

![Slider](image)

Now drag the Slider to the new location.

Recall that there are two techniques for selecting other MicroWorlds Pro objects. These same techniques work with Sliders. You can hold down the Command (⌘) or Control key and click on the Slider. Or, with the regular pointer, click and drag around the Slider.

![Slider Selection](image)

When you release the mouse Button the Slider handles appear.

![Slider Handles](image)

Notice that, as with Turtles, these handles are grayed. You can only change the size of Turtles by using the Magnifier or De-magnifier tools. You cannot change the size of Sliders at all. However, when you have it selected you can manipulate it in other ways.
Once the slider is selected you can make copies of it. Use **Copy** and **Paste** from the **Edit** menu. Or, use the Copy and Paste tools from the Toolbar to make your copies.

To remove a Slider, select it and then use **Cut** from the **Edit** menu or press the Delete or Backspace key. The Scissors tool on the Toolbar can also complete this step for you.

As with other *MicroWorlds Pro* objects, you can change the properties of a Slider at any time. Select the Eye tool from the Toolbar and click on the Slider. The Slider dialog box reappears.

Notice that you can change the name of the Slider as well as the minimum and maximum values. You can also display or hide the name of the Slider.
Using Sliders in Projects

Sliders can be used to create Projects that allow the user to easily modify what is happening on the Page. For example, suppose you have a background that includes a lake, a grassy hill, and a sky. Once you have your background completed, you will add a Turtle, a Button and a Slider. Place the Turtle on your lake and give it the shape of a boat. In addition, name it boat. Make any necessary adjustments to the direction of the Turtle before you give it this shape.

Create a Slider called “b.speed” and make its range be from 0 to 150. Place the Slider at the bottom of the Page. Add either a Turtle or a Button to control the action. On the Button you will use both the Turtle name and the Slider name. Set the Button dialog box to the following settings.

![Button dialog box]

Be sure that you check the Many Times Button.

Test your Page to be sure that the boat is moving the way you intended. Make sure that when you change the number on the Slider the speed of the Turtle boat changes. If your thinking is similar to ours, the range of the Slider is inappropriate. Use the Eye tool to reopen the dialog box. Reset the numbers from 0 to 10. Is that better?
Let’s continue with this Page. There are simple steps to make the Page more inviting. Remove the Button used to control the Boat. Hatch a new Turtle and give it the instructions you had previously placed on the Button. Place the Turtle in the lower portion of your Page and give it the same boat shape that appears on the Page.

Click on the Turtle boat with the Eye tool and make sure your instruction set is correct.

At this point stop and hatch two more Turtles. Place the first Turtle in the green part of your background and name it car. Set the direction to match the image of the car in the Shapes palette. Apply the car shape to the Turtle. Place the second Turtle at the bottom of the Page. Set the instructions to be similar to those you placed on the Turtle boat. Finally, add a second slider named c.speed with a range of 5 to 100. Your Page should now look somewhat like the following one.

You can then test the Turtle car. Did you decide to slow it down by adjusting the maximum value to a lower number?

When the car is working correctly, try moving both the boat and the car at the same time. Change the speed of one of them. Then change
the speed of the other. Fun even if it challenges the coordination. You may want to use the Eye tool to access a Slider dialog box and make further adjustments to the numbers controlling the speeds.

While we are having fun, let’s try one more step. On the same Page, let’s repeat our steps to have a bird fly across the sky. You already learned how to animate the bird by giving it shape changes. To control this animation, let’s place another Slider and another Turtle at the bottom of the Page. The Turtle to control the flying should have the following in the dialog box:

![Turtle Dialog Box]

Test your Turtle bird. Did your bird happen to land in the lake? After several tries, a ‘new’ bird is now flapping its wings and moving quite nicely from left to right on the Page.

As a last effort to provide a friendly user interface, let’s add some instructions in a Text box. This will let the user know they can experiment with moving the objects on the Page.
Earlier in this book, you saw that you could use Turtles, Buttons, and Text boxes to create versions of the classic Instant Logos. Sliders can also be used to create even more flexible versions of Instant Logos.

Another well-known Logo exploration is the use of “dynamic” Turtles. In general, dynamic Turtles, once set in motion, remain in motion. While they are moving, you can change their direction. This idea is easy to implement in MicroWorlds Pro. Adding Sliders to a dynamic Turtle environment makes the explorations much more flexible.

Create a Page that has a **right 10** Button, a **left 10** Button, and a **cg** Button on it. Each of these Buttons should run only once.

Next, create a Slider call “Speed.” Finally, add a **forward Speed** Button that is controlled by the Speed Slider.

Be sure the pen is down. Enter

```
pd
```
in the Command Center. Now click on the **forward** Button. Adjust the speed of the Turtle by using the Slider. Then use the turn Buttons to control the direction of the Turtle.

If you still have some sense of sanity, add a track and practice keeping the Turtle on it. It may not take you long to shed that last bit of sanity you were maintaining. For more sophisticated versions of the dynamic Turtle microworld add factors of gravity and friction to the Turtle’s movement. The user can then explore a wider variety of motions.

### Tips and Techniques

When creating Sliders, it is best not to make the difference between the minimum and maximum value any larger than needed. Sliders with larger ranges are harder to control. Use only the range that is needed for your Project. Since this isn’t always obvious as you create the Slider, take the time to test and adjust the numbers.

You surely noticed that when examples in this book have a large number of objects on the Page, a separate section is set aside for those objects controlling the action. Using some kind of dividing line between the controlling objects and the action objects makes the Page more attractive and easier to understand. It was a typical design element in hypermedia documents.

A Slider is really a variable—a mathematical term you may or may not have used. Here in *MicroWorlds Pro* a variable is a simple idea. In computer programming, a variable is a computer memory location that has a name and can contain a value that may be changed. When you
move the small bar on the slider, you send a new number into the memory location for the computer to use in the instruction.

As you reflect on the work you completed in this most recent chapter there are several issues needing your attention.

1. You have spent considerable time exploring the concept of a Slider. You need to remember three important ideas about Sliders.
   • Every Slider has a name.
   • Every Slider represents a numerical value.
   • Moving the bar that appears on the Slider changes the value represented by the Slider.

2. You will learn, with practice, to keep the range of values on a Slider at a range appropriate for its use. Most errors are made by letting the maximum value become far too large to be useful.

3. As you become more skilled with using MicroWorlds Pro, you will start becoming more aware of design options for your Projects. You were introduced to several techniques that allow your Projects to communicate effectively with the user. Continue to think about how another person will react to the Pages you create. Providing a clear, unambiguous interface for the user should be the goal you set for every Project you create.

4. The Slider options can add considerable flexibility to your Logo code. If you think of the following instructions:

```logo
cg
pd
repeat 5 [forward 30 rt 72]
```

The instruction draws a pentagon (a five-sided figure). Notice that three different numbers are specified in this piece of Logo code. There is the number of repetitions (5), the distance of movement (30), and the angle of turn (72). Experiment with drawing shapes by using different numbers of repetitions, distances, and angles.

This experimentation is easy if for each number you establish a Slider with a range of values. Instead of having to re-enter any code, you simply stay on the Page and move the Sliders. You will soon find that you can draw interesting and beautiful polygons.
Chapter 10

Working With Colors and Pictures

Until now, we have introduced only a small part of the power of the Logo programming language. The emphasis has been on learning to use the menus, the Toolbar, the Tab Area, and the little bit of Logo completed in the Command Center.

For many of the functions you have completed, the menus and Logo language provide the same or similar opportunities. However, this chapter introduces you to some additional Logo instructions. The Turtle is much more capable than you have seen to this point. By adding to your grasp of the Logo language, you’ll soon be directing your Turtle to do new tricks.

The emphasis in this chapter is on working with colors and patterns. You will learn how to have the Turtle draw with a wide range of line widths and a color that you specify. You will also learn how to fill shapes with patterns. You will learn to extend your use of Logo to accomplish tasks that are not available from the menus or Buttons in the MicroWorlds Pro window.

To explore how you can use Logo instructions with colors, get a new Page. Be sure there is a Turtle on the Page. Go to the Graphics tab and select a color. Use one of the Graphics tools to create an image on the background. With the pointer over the image, hold down the Control key and click the mouse Button. From the menu that appears, select Edit color—in this example Edit green.
This same option is available for any object on your Page. However, each object will have a slightly different set of options in the menu that appears.

Once you have made the correct menu selection a new dialog box will appear. This one is similar to those you have seen earlier.

![Instructions for: green](image)

The dialog box indicates that two different things can be done with the color you have selected. First, when the mouse is clicked on this color on a Page, the Mouse instruction will be carried out. Second, when the Turtle is moving on a Page and “goes over” the color you have selected, the Turtle instruction will be carried out.

Start by placing a Text box on the Page and hatching a Turtle. In this example, the color green will be selected. In the dialog box set things so the Mouse instruction and the Turtle instruction will each put some text in the Text box. For the Mouse instruction, enter the Logo code

cleartext print [Mouse Button clicked]

For the Turtle instruction, enter in the Logo code

cleartext print [Turtle landed on the rectangle.]
Draw a rectangle on the Page in the color you have selected. Now, move the arrow-shaped pointer to the colored rectangle and click. You see

Next, click on the Turtle and drag it over the color. Nothing happens. The Turtle must move onto the color through the use of Logo instructions. Place the Turtle “below” the colored rectangle on the Page and enter

\[
\text{pu forward 50}
\]

You see

Note that the pen must be up for this technique to work. If the pen is down, the Turtle “senses” only the line that it is currently drawing.

You no doubt have explored the colors in the Graphics tab. Did you notice that there are 10 shades of each of the 14 colors, in addition to black and white? MicroWorlds Pro gives you a total of 142. When you open the Graphics tab and click the pointer on a color, you will see that each of the colors has a name and a number.
The color and number are both displayed in the Color Viewer in the Color Selection area. The balloon help that shows the name and number is located in the Status bar along the bottom of the MicroWorlds Pro window.

Notice that the naming and numbering structure is organized. All shades of red are given the name red. However, each shade has a unique number. Did you notice that the colors are grouped? For example, the reds are numbered from 10 to 19. That is, there are 10 shades of red. Similarly, the blues are numbered from 100 to 109. (Black is color number 9; white is color number 0.)

When you attach Logo instructions to a color, you are actually attaching the instructions to a family of colors—all of the shades of that color. Suppose, for example, that you attach instructions to color number 12, a shade of red. That code is now attached to all of the shades of red, from 10 through 19. When you decide to use Logo instructions to work with colors in MicroWorlds Pro you must plan your Projects carefully so that you only use colors with attached instructions where you want some action to occur.

Sharing Graphics

You can share the graphics created in MicroWorlds Pro with other applications. You can also use graphics created by other applications and clip art in MicroWorlds Pro. You use Logo instructions to import and export Pict or Jpeg graphics on the Macintosh. You can import or export BMP, JPG, GIF, PCX or Targa files on a PC. If you want to save an entire background to use in another application, enter

savepict "picture.name"

On a Macintosh, you can save the picture in Pict or Jpeg format. On the PC you can save pictures as BMP, JPG, GIF, PCX, or Targa. The files can be located in your MicroWorlds Pro folder/directory or in the folder/directory where you open Project is stored. Displayed as an icon, your picture file was look something like the following.

Once you have your graphic file saved, you can use appropriate software to further edit or modify the image. It may be necessary to use a menu option such as Load or Import rather than opening the
file. The *MicroWorlds Pro* picture should appear in your other application.

For this example, the following *MicroWorlds Pro* Page was used.

![MicroWorlds Pro Page](image)

On a Macintosh, the following instructions were entered in the Command Center.

`savepict "soccerGame"`
The result of the instruction was located in the same folder as the Project containing the selected background. The application AppleWorks 6.0 was opened and the Pict image was imported into a draw document. After resizing the image so it would fit the Page, the following is what appears in the AppleWorks draw document.

This demonstration will help you recognize the difference between the appearance of a MicroWorlds Pro Page and the background on the Page. It is the backgrounds that are responding to the instruction. You can only copy background graphics to another application. You cannot copy Turtles, Text boxes, Buttons, or Sliders.

If for some reason, you want an image that also includes these elements, you can use Export Page Image from the File menu. The objects themselves do not copy but a bitmap image of them is included in the graphic that is saved. This lets you reproduce the exact appearance of a Page if needed.

You can do the reverse—bring a picture created in a different application into MicroWorlds Pro for use as a background. In the Command Center enter

loadpict "picture.name"

If the graphic file has been saved with blanks in the name, you must use vertical bars around the name.

loadpict "|picture name|

The vertical bar is usually found above the backslash (\) on the keyboard.

For this example, an AppleWorks 6.0 draw document was created and saved as a Pict file on a Macintosh. The image was stored in the
same folder as the active MicroWorlds Pro Project. Into the Command Center was placed the instruction

loadpict "polarBear"

and immediately the Page shows the selected image.

This flexibility of creating backgrounds has just given you an artistic power the Masters of the Art World would envy.

**Technical Note:** The image file must be in the same folder/directory as the active MicroWorlds Pro Project. Note also that the colors in an imported picture may change to match the colors available in MicroWorlds Pro.

As noted earlier, you can use an approach of **Copy** and **Paste** to move images from one application to another. If your computer has sufficient memory, this approach is quick and easy. However, you may need to use a temporary storage area. On the Macintosh, the Scrapbook provides the option. On a PC, you might use Paint included with the Windows operating system.

This approach requires you to use the Selection tool in the Graphics tab.

- Click on the Selection tool in the Graphics tab.
- Click and drag to select the part of the Page you want.
• Choose Copy from the Edit menu.
• Open the Scrapbook from the Apple menu or Paint in the Accessories menu of Windows.
• When the application opens, select Paste from the Edit menu.

Your image will appear. Close MicroWorlds Pro. Open a different application and reverse your steps.

**Technical Note:** If your graphic is large, you may only see part of it. However, all of it will now be in the Scrapbook. If your computer has sufficient memory, go directly from MicroWorlds Pro to the application of your choice.

### New Shapes Ready-made

Earlier you learned to modify and create shapes using the Shape Editor in the Graphics tab. However, the options for shapes go far beyond what you have seen. Using similar steps to moving background images into a Project, you can move images into the Shapes palette of the Graphics tab. For anyone that finds the concept of ‘original’ art too big of a challenge, these steps are a great option. In addition, MicroWorlds Pro anticipates that you will more shapes and has included an extensive collection.

First look at the steps needed to use the additional shapes included in MicroWorlds Pro. These images are optimized for use in your Projects. In addition, they are conveniently organized and easy to use. The shapes stored are stored in a Shapes folder located inside the MicroWorlds Pro application folder. Go to the File menu and select Shapes on the Import option.
This gives you a standard browse window to locate the folder containing the shapes files.

The Shapes folder contains a number of files—each one containing many shapes related to the name of the file. In this example the Transportation file was selected. All of the shapes relate to this topic.

On the left are the shapes contained in the Transportation file and on the right is the Shapes palette from your current Project. Move to the right and click on the square where you want the shape to be stored.
Move to the left and click on the shape you want. Click on the arrow Button in the center and a copy of the selected shape immediately appears in the Shapes palette of your Project. Here, the action is set to replace the red arrow with the small boat.

Take care as you use this feature. Replacing a shape means you no longer have it included in the active Project. In addition, once the shape is pasted into the Shapes palette, the selection square automatically moves to the next square. Unless you are careful, you may find you have pasted over shapes you intended to use.

The other method provides greater customization of images. Open some of the clip art you have available or find an application that includes a library of clip art. Find an image you would like to have available for use in a MicroWorlds Pro Project.

This image would be fun to include in a Project for children about fish and scuba diving. Use the application tools or menus to Copy the image to the clipboard. Then move back to your MicroWorlds Pro active Project. Click on an empty square in the Shapes palette and paste.

Your shape is now available to dress a Turtle for swimming or to be stamped into the background scene.
It is extremely easy to make an error in these steps. If the **Paste** step produces this shape from the same image you have a problem.

If you create two Turtles side-by-side and give each one of the new shapes the Turtle appearances are very different.

The Turtle shape on the left is the result of pasting directly into the Shapes palette. The Turtle shape on the right is the result of pasting directly into the Shapes Editor. In addition, the Shapes Editor was set to display at 1000%, adding to the problem.

The ease with which you can move new shapes into the Shapes palette increases the options beyond belief. If you have an image you created at some other time or located in your favorite clip art collection, you may be able to instantly have it included in your Projects. Just be sure to check for copyright restrictions when appropriate.

**Using Logo Code With Colors**

You have used the Graphics tab to put graphics on the Page, but you have also learned that you can use a number of instructions to cause the Turtle to draw on the Page. For example, if you go to the Command Center and enter

```
pd
repeat 4 [forward 100 right 90]
```

a square is drawn on the Page with the narrow line width and in black. This line width and pen color is independent of the settings that you have selected from the Graphics tab.
There are Logo instructions to control the line width and color that a Turtle uses. You can change the line width by using the `setpensize` command. For example, enter

```logo
cg
setpensize 20
repeat 4 [forward 100 right 90]
```

You see

![Square drawn with setpensize 20](image)

By using `setpensize`, a wider variety of pen widths is available than those available in the Graphics tab. You can use any width between 1 and 100.

You can also set the color of the pen. You can use either color names or numbers. For example,

```logo
cg
setc 55
setpensize 20
repeat 4 [forward 100 right 90]
```

is the same as

```logo
cg
setc "green
setpensize 20
repeat 4 [forward 100 right 90]
```

When you use a color name, the directions are less flexible. You will always get exactly the same shade of red, blue and so on. If you use a
number, you can have the Turtle utilize exactly the shade of color you want. In addition, with the numbers you do not use the quotation mark.

You can use the **fill** command to fill most or all the Page by putting the Turtle on an open spot on the Page and entering

`fill`

If you have a shape that is open, the fill command will also fill inside of the shape.

![Image](image.png)

*Technical Note: When you use the **fill** command, the Turtle disappears since the area fills with the same color as the color of the Turtle. In the above drawing, the color of the Turtle was changed.*

To fill the background on a Page with color, use the **setbg** (set background) command. For example,

```
setbg "red`
```

fills the entire background with red. Note that this differs from **fill**. **Fill** fills the open area; **setbg** fills the entire background.

**Generating Random Numbers**

You know how to tell a Turtle to move a specific number of steps or turn a specific angle. Suppose you want the number of steps or the angle of the turn to be a random number. This is easily accomplished by using the **random** primitive in Logo.

The Logo primitive **random** is used to create random numbers. Random numbers have no apparent pattern. **Random** is different from the Logo primitives you have seen so far. If you enter

```
rando...
This response occurs because `random` is a `reporter`. A reporter returns a value; it reports the value back to Logo. Repeat the statement

`random 50`

a number of times. It is likely that each time you do so, you will get a different number after “I don't know what to do with... .”

To use the `random` reporter, you must tell Logo what to do with the number it produces. For example, try entering

`forward random 50`

Watch carefully as the Turtle carries out this movement. Continue to observe carefully as the Turtle carries out this instruction a number of times. Do you see the Turtle move different distances at different times?

`Random 50` reports to `forward` some number from 0 to 49 and then the Turtle moves `forward` that number of Turtle steps. That is, if `random 50` reports the number 37, the Turtle follows the instruction `forward 37`. If `random 50` reports 11, the Turtle moves `forward` 11 Turtle steps.

`Random 6` reports a random number from 0 to 5. The instruction

`forward 2 + random 6`

moves the Turtle forward a random number of steps, that is, from 2 to 7 steps.

**Using Color in Projects**

The ability to attach Logo code to colors provides a powerful way to have things happen on a Page of your Project. Earlier in the book you saw a Project in which a car moved across the Page. You might use the same technique to create a race.

But, if you know exactly how fast two racers are moving before the race begins, you will know the outcome of the race. One way to introduce some uncertainty into the race is to use `random`.

Place a Turtle on the Page and choose a shape to use in your Turtle race. Add a Button to start the race. On the Button, put

`t1, forward random 5`
and be sure to select the Many Times Button.

Next, select a color for the finish line. Draw the finish line and add instructions to cause the race to stop.

Stopall is the command that stops all action on the Page. Test your racer to be sure that it stops when expected.

Next, add a second racer. Modify the Logo instructions on the Button to read

t1, forward random 5 t2, forward random 5
Line your racers up and click the Button. The racer that reaches the finish line first will cause the race to stop.

Since the Turtle senses the color only from the center of his ‘tummy’ the Turtle must extend slightly over the line. When you create Projects using this option, keep in mind the placement required.

**Tips and Techniques**

You are beginning to realize that the Turtle is completely dependent on your smarts and does no thinking for itself. Remember that you can have Logo instructions on a *family* of colors—by using a color name such as blue—or on a shade of color by using the color numbers. Also, be aware that `fill` and `setbg` work in different ways although this may not be obvious on a given Page.

The Shapes palette is one of the best parts of the software for offering unlimited options and fun. It does have its drawbacks though. When you decide to select and modify a shape you may still want the original. So, develop the habit of using Copy and Paste first so that your modifications are made to a copy of a given shape.

Pasting new images into the Shapes palette also requires care. Make the decision of how and where you want the shape pasted. There are advantages to having the image drop directly into the Shapes palette. However, in the Shape Editor you can change the size of the space defining a shape. This lets you have some control over the size of the image used to costume your Turtle. Which approach meets your needs?

If you have difficulty transferring graphics between applications, check the documentation of your other applications. Only Pict and Jpeg graphics can be transferred in and out of `MicroWorlds Pro` on a Macintosh. Only BMP, PCX, JPG, GIF, and Targa can be used on a
PC. Also, the naming convention of no spaces will avoid problems. You can use spaces but it adds a layer of complexity you can easily avoid.

When you export one of your backgrounds or import a picture file to use as a background, keep your files organized. If you place everything you need in the same folder, you will have little or no difficulty. There are ways to adjust the pathway used by *MicroWorlds Pro* for completing these actions. However, that is better left for another book.

When you are working with color from the Command Center it is easy to lose the Turtle. If the Turtle suddenly disappears, try changing the color of the Turtle with `setc`. Often the Turtle is simply sitting on a background area that is the same color as the Turtle itself.

After you set a pen color or pen width, those values remain the same until you change them. To get the Turtle back to its original state, enter
```
setc 9
setpensize 1
setsize 40
```
The original Turtle is colored black, draws with pen size 1, and has size 40.

You can fill any closed area with any color you want. Be careful, however, that the area is really closed. Otherwise the color may leak out all over the Page. Should you get an unexpected result, remember that you can use *Undo* from the *Edit* menu or choose the Undo tool in the Toolbar.

When you use the `fill` command, Logo examines the dot under the center of the Turtle. Thus, if you enter
```
pd
forward 50
fill
```
the `fill` command will not work because the center of the Turtle is still over the last dot drawn by `forward 50`. Generally, if you can click and drag the Turtle to another location, `fill` will then work.

Using `random` is a bit like drawing numbers “out of a hat.” You cannot predict what numbers will turn up next. If this is a new idea for you, spend some time experimenting with the instructions
```
pd
cg
forward random 50
```
until you develop insight into the random movements that this code produces.
Again you are ready to reflect on the ideas you’ve just learned. Once again you have extended your understanding that *MicroWorlds Pro* let’s you complete many tasks in two different ways—by using menu and Toolbar choices and by using Logo code. While you may be finding the challenge of learning Logo is taking a lot of energy, persist. Having the choice let’s you produce Projects customized beyond what you can do with only menus and on-screen tools.

You probably want to recheck your understanding of the Logo term `random`. In addition, you might want to recheck the options of instructions on a particular color on your Page. And yes, it is possible to combine the `setc` option with the `random` option for a great deal of fun in an interactive Project.
Chapter 11

Using the Procedures Tab

You now know a great deal about *MicroWorlds Pro*. You know how to create backgrounds. You know how to use the many types of objects: Turtles, Buttons, Text boxes, Sliders, Melody, Recording, and Video. You know how to write simple Logo instructions and sequences of Logo instructions. With these capabilities you can create very complex Projects.

You may have noticed that some of the tasks you want to accomplish in *MicroWorlds Pro* require a lot of Logo code. You put code in the Command Center, on Turtles, on Buttons, and in Text boxes. The code that you put on a Turtle or a Button may be so long that it is not easy to read and edit. The code that you put in the Command Center is not saved when you save your Project.

This chapter shows you how to preserve the Logo commands you have written and helps you learn to use the Procedures tab and to write Logo procedures.

**Writing Procedures**

Click on the Procedures tab found at the far right of the window.

![Procedures Tab](image)

This opens a long white area with the familiar text insertion point in the upper left corner.

On the Procedures tab, you can “store” Logo instructions that you want to use on the Pages of your Project. There is only one Procedures tab for each Project and it can contain only text. The area however, will
continue to scroll to handle additional Procedures in situations where you want to save lots of them.

To understand how the Procedures tab is used, focus on a Page in your Project. Be sure there is one Turtle in the center of the Page. Go to the Command Center. Enter

```
pd
repeat 4 [forward 50 right 90]
```

The familiar square appears. Now return to the Procedures tab and enter

```
to square
repeat 4 [forward 50 right 90]
end
```

In the Command Center, enter

```
cg
square
```

If you have not made any keyboarding errors and the pen is down, this will cause the Turtle to draw a square exactly as you did earlier. Congratulations! You have just written your first Logo procedure.

Go to the Command Center and enter instructions to move the Turtle to a different spot on the screen. Then use your procedure to make another square.

```
right 45
forward 60
square
```

You see that it is easy to use the `square` procedure over and over again. In addition, since you have entered it in the Procedures tab the procedure is available on every Page and available the next time you open the Project.

A procedure is a collection of Logo instructions. Procedures must begin with the word `to` and end with the word `end`. The structure of a procedure is as follows:

```
to name.of.procedure <- title line
  instructions go here <- body of the procedure
end
```

All procedures must be written (or Copied and Pasted) on the Procedures tab. The contents of the Procedures tab are saved with the Project.
Procedures can make your Projects easier to understand. For example, instead of having a Button that has the Logo instructions for a square on it,

```
repeat 4 [forward 100 right 90]
```

you can have a Button that makes it clear that it is to be used to draw a square.

Similarly, if you have a Button that causes a bird to fly across the Page,

```
bird, setsh "bird1 forward 5 wait 3 setsh "bird2 forward 5 wait 3
```

you can simplify your Page by writing a `fly` procedure

```
to fly
  setsh "bird1
  forward 3
  setsh "bird2
  forward 3
end
```

and using the name of the procedure on the Button.

If you selected the Once radio Button when you defined the Button, the bird will flap its wings only once. If you selected the Many Times Button, the bird will continue to fly until you take action to stop it.

While the mechanics of procedure writing are rather simple, the idea embodied in procedure writing is profound. When you create a series of instructions to complete a particular task and then put them
into a named procedure, you have “taught” Logo a new word. This new word behaves exactly as if it were a primitive (see Chapter 1 for a review of primitives). If you don’t look on the Procedures tab, you have no way of knowing whether the instructions you enter in the Command Center consist of primitives or user-defined procedures. The fact that you can easily create procedures that function exactly like primitives is what makes Logo an extensible language.

The Procedures tab can contain many procedures. Each of these procedures must have a unique name. Each new name becomes part of the Logo vocabulary available when you use the Project.

All of the instructions you have learned thus far can be used in procedures. In addition, each new procedure that you write has a name that can be used in writing other procedures. Thus, you now have the tools to write procedures to do many interesting things.

For example, a procedure can change the color and size of the Turtle’s pen:

```logo
to change.Turtle
  setc "blue
  setpensize 15
end
```

Notice that the name of this procedure is two words, but the words are connected by a period. Blank spaces are not allowed in the name of a procedure.

You can use a procedure to put text in a Text box:

```logo
to greet
  text1,
  print [How are you today?]
end
```

You can randomly change the background color to different shades of blue:

```logo
to change
  repeat 10 [setbg (100 + random 10) wait 5]
end
```

You can access other media from procedures. For example suppose you recorded a sound and called it ruff. You can then have a dog on the Page that barks when the user clicks on the dog.

```logo
to bark
  repeat 2 [ruff]
end
```
With these four new procedures on your Procedures tab, you have added four new words, `change`, `Turtle`, `greet`, `change` and `bark` to *MicroWorlds Pro*. Your procedures are what give *MicroWorlds Pro* the ability to understand and use these new words. As you can see, there is no limit to the new words you can add.

Take some time now to experiment with writing procedures. As you work think about how powerful the idea of procedure writing is. You may also want to consider using the Command Center to create and test a procedure. Once you have a procedure as you wish, you can **Copy** and **Paste** it to the Procedures tab.

**More Than One Procedure**

You have now seen how to write a single procedure. The Procedures tab can contain many procedures at the same time. Regardless of where in the Project you make use of a Procedure, the software reaches to the Procedures tab when required.
The Procedures area is likely to contain a number of unrelated procedures.

```
to square
  repeat 4 [fd 100 rt 90]
end

to fly
  setp "bird1
  forward 3
  setp "bird2
  forward 3
end

To bcrk
  repeat 2 [ruff]
end

to greet
  text1,
  print [how are you today?]
end
```

As you continue to add procedures to the Procedures area, it is easy to forget where the various procedures are used. It is a good idea to *document* each procedure as you write it.
Any text between the `to` at the beginning of a procedure and the `end` at the end is considered to be part of the procedure. One way to document your procedures is to put text that explains the use of the procedures between the procedures themselves.

```
<draws square>
to square
repeat 4 [fd 100 rt 90]
end

<animates bird>
to fly
setsh "bird1
forward 3
setsh "bird2
forward 3
end

<use with dog>
To bark
repeat 2 [ruff]
end

<enters text in box>
to greet
text1,
print [how are you today?]
end
```

While the pointed brackets—`<>`—surrounding the comments on the Procedures tab shown in the illustration are not necessary, they are one way to make the documentation more visible.
Another approach to documentation is to separate procedures by the Pages on which they are used.

```plaintext
****Used on all Pagea***
<draws square>
to square
repeat 4 [fd 100 rt 90]
end

****used on zoo page***
<animates bird>
to fly
setn "bird1
forward 3
setn "bird2
forward 3
end

<use with dog>
To bark
repeat 2 [ruff]
end

****used on title page***
<enters text in box>
to greet
_text1,
print [how are you today?]
end
```

Still another way to document procedures is to include comments inside of procedures. Any line beginning with a semicolon (;) up to the next carriage return character is ignored. Thus, comments can be put anywhere inside of a procedure.

to square
;Draws a square
repeat 4 [forward 50 right 90]
end

The Procedures area give you a lot of power. However, it is easy to write so many procedures that you can no longer keep them all in mind at one time. Also, you may be working on a MicroWorlds Pro Project over a period of days or weeks. Thus, it is essential that you develop systematic and careful habits of documenting the procedures you write.
Procedures That Use Procedures

The procedures you have seen thus far are isolated. Each procedure performs some specific task. The procedures are not connected in any way to other procedures in your Project. However, as your Projects become more complex, it is not uncommon to have a group of procedures that work together to accomplish a task. The following example shows you how to write a number of procedures that work together. Once you start grouping procedure inside a new one you have reached a point of writing programs rather than just procedures.

Suppose you wanted to have the Turtle draw a house on the Page and then erect a picket fence next to the house. Instead of using a Turtle shape to stamp a house, this example draws a house made up of a square for the main part of the house and a triangle for the roof.

To begin, be sure one Turtle is visible in the center of the Page and that its pen is down. Go to the Procedures tab and write these procedures for drawing a square and a triangle:

to square
repeat 4 [forward 50 right 90]
end
to triangle
repeat 3 [forward 50 right 120]
end

Return to your Page. In the Command Center, enter

square
triangle

You see the parts of the house, but they are not in the right place.

Enter cg and see if you can figure out the instructions to get the roof in the right place. These instructions should become part of a procedure to get to the roof. One solution might be

to get.to.roof
forward 50
right 30
end
Now go to the Command Center and enter

cg
square
gt.roof
triangle

Does the house look the way you want it to? If not, modify the
procedures until you are satisfied with your house.

These procedures can become part of a **house** procedure:

to house
set.up
square
gt.roof
triangle
end

The set.up procedure includes the instructions below.

to set.up
cg
ht
pd
end

This procedure needs to be completed first so your Page is ready for the
house building efforts the Turtle will complete. Now you can enter
**house** from the Command Center and see the Turtle erect a brand
new house on an empty Page.

The **set.up** procedure was put at the beginning of the list of
procedures in the **house** procedure. However, this does not depend on
having the **set.up** procedure being first in the Procedures tab.
*MicroWorlds Pro* does not care about the order. It will run them
correctly regardless of their order. But you and others will need to read
the code. Having them placed in a logical order will make this easier.

If you have not yet added comments to the Procedures tab, now
would be a good time to do so. Note that you may want to make the
type on the Procedures tab smaller so that you can see more of your
procedures at one time. Access **Font** in the **Text** menu to do so. Also,
you might switch the window by clicking the Procedures Layout
Chapter 11  Using the Procedures Tab

Button on the Toolbar. This reduces the Page size and increases the Procedures tab for you.

When you finish drawing the house, the Turtle is beside the roof. You need to write a procedure to move the Turtle to a position appropriate for creating the fence. Go to the Procedures tab and enter this procedure:

```turtle
to place.fence
  pu
  back 145
  left 30
end
```

The next task is to create the picket fence. This could be done in a different color, perhaps brown. To help the Turtle make a picket fence enter the following code in the Command Center:

```turtle
to make.fence
  pd
  setc "brown"
  setpensize 2
  fd 75
  rt 30
  repeat 20 [rt 120 fd 10 lt 120 fd 10]
  lt 90
  fd 200
  pu
  lt 60
  bk 45
  fill
end
```

Once you test your instructions to verify they are correct, Copy and Paste them into the Procedures tab.

The two procedures can then be combined into a single fence procedure. Enter this procedure on the Procedures tab:

```turtle
to fence
  place.fence
  make.fence
end
```

Now, return to the Command Center. If you enter

```
house
fence
```
in the Command Center, this image appears on your Page.

You can combine these two words so that having the entire image appear is done with one entry. You might use

to construct.both
house
fence
end

When you enter `construct.both`, the Turtle will happily produce the image as shown.

Remember to add appropriate comments to the procedures that you have added so the documentation for your program is complete. And, you might want to place this fence beside the house rather than below the house. Which procedure would you adjust?

Suppose you want to write a program to play a simple tune. You can write a procedure for each of the lines of the song. For example, to play “Three Blind Mice,” you can begin with

to three.blind
note 64 6
note 62 6
note 60 12
end

This phrase is repeated twice, so you can write

to line1
repeat 2 [three.blind]
end

Similarly, the second line can be written as follows:

to line2
repeat 2 [see.how]
end
Can you finish this song? Think of the procedures you would need. Their organization is referred to as a procedure tree. The first part of the procedure tree might look like this:

```
three.mice
  line1
  three.blind
  line2
  see.how
  line3
  line4
  they.all
```

Using some of the words for the song helps you keep track of what procedures play what part of the song. In each of the line procedures used here, a phrase of music is repeated, sometimes with the same words, sometimes with different words.

**Using Sound and Music in Projects**

Creating music and recording sounds as well as using movies in MicroWorlds Pro can be fun and easy. It is tempting to use a lot of sound and music in your Projects. However, you should think carefully about the way you use sounds. What seems fun or clever when you are creating your Project can become annoying or even irritating to the user who must listen to the sound again and again.

What are good uses of sound? Sound can be used to reinforce or verify an action. For example, if you have a Button that moves to another Page of your Project, you might write a procedure such as this.

```
to next.Page
  note 60 10
  Page2
end
```

When the user clicks on the Button, both sound and the change in color of the Button verify that the user correctly clicked on the Button.
Another appropriate use of sound is as an integral part of the content of your Page. For example, you might create a Page of animal-shaped Turtles. Clicking on the Turtle could produce the sound of the animal. For example, this Turtle could produce a recorded sound of a dog barking.

Similarly, an appropriate melody might play as the sun rises on a scene or as a ship sails across a lake.

Generally, you will want to keep sounds brief. Not only can long sounds or movies become annoying, internal sound and graphics take up a lot of the computer’s memory space. You can easily require a lot of disk space if you add too many long sounds to your Projects.

Procedure Trees

The procedure construct.both is the main procedure, or top-level procedure. It uses a number of other procedures. These procedures are called subprocedures of construct.both. A good way to visualize the relationships among procedures is to use a kind of diagram called a procedure tree. A procedure tree shows the relationships among procedures. In a procedure tree, a subprocedure is drawn below the procedure that uses it. For example, the procedure tree for construct.both looks like this:

```
   construct.both
      /       \
   house     fence
     /       /      \     \    
  set.up  square get.to.roof triangle place.fence make.fence
```

Notice that the house procedure, which is a subprocedure of construct.both, has four subprocedures of its own.

The word superprocedure is also commonly used to describe relationships among procedures. For example, construct.both is a superprocedure of house.

To summarize:

- **construct.both** is the main, or top-level, procedure.
• **house** and **fence** are subprocedures of **construct.both**.
• **construct.both** is a superprocedure of **house** and **fence**.
• **set.up**, **square**, **get.to.roof**, and **triangle** are subprocedures of **house**.
• **house** is a superprocedure of **set.up**, **square**, **get.to.roof**, and **triangle**.
• **place.fence** and **make.fence** are subprocedures of **fence**.
• **fence** is a superprocedure of **place.fence** and **make.fence**.

Notice how much easier it is to see the relationships among procedures when using a procedure tree. A list of the relationships is hard to follow, but the procedure tree gives you a visual image of the structure of your program. You should always draw a procedure tree when you are working with more than two or three procedures to accomplish a task.

There are some rules of thumb you should remember when creating a procedure tree:

1. The name of the program (the procedure name you enter to run the program) is at the top of the procedure tree on a line by itself.
2. Each subprocedure of the main procedure is listed on the next level (or line). These subprocedures are listed left to right as they occur in the main program. That is, the first subprocedure is listed on the left, the next subprocedure used is listed to the right of the first, and so forth.
3. A line connects each procedure with its subprocedure(s).
4. Each procedure in the program, along with its subprocedures, is represented according to the rules given in Step 2.
5. If a procedure is a subprocedure of more than one procedure, the procedure name should appear “under” each procedure from which it is called.
6. If a procedure “calls itself,” the name of the procedure appears below the name of the procedure connected by a line, just like any other subprocedure. Procedures calling themselves are discussed in *MicroWorlds Pro—Hypermedia Project Development and Logo Scripting*, the second book in this series.
7. All user-defined procedures—those that you write—should appear in the procedure tree.
8. No primitives—such as **cg**, **forward**, or **repeat**—are listed in the procedure tree.
When you have completed your procedure tree, you should be able to tell exactly what procedures are called from any procedure. You should be able to tell what procedures call any subprocedure. A carefully drawn procedure tree can be very helpful in solving any problems you have with your program.

When you are creating a complex Project, you may want to set aside a Page or so to contain your procedure trees. You should find it easy to draw a procedure tree using Text boxes for the names of the procedures and using tools from the Graphics tab to draw connecting lines. A procedure tree can be a valuable part of the documentation of a Project.

When working with a number of procedures, be sure that each procedure works by itself. That is, after writing any one procedure, test it. As you build up your program, test each procedure as you go. Thus, in the example just given, after you tested square, triangle, get.to.roof, and set.up, you should test house to be sure all the pieces work together properly. Don’t try to write your entire program all at once and then test it by entering the name of the top-level procedure. There are simply too many things that can go wrong in a program that is more than two or three procedures long.

**Tips and Techniques**

As noted earlier in this book, mistakes in computer programs are often called bugs. The process of removing these errors is called debugging. The ideas in this chapter are designed to help you avoid or fix bugs. Keep these ideas in mind as you are working. They will save you a lot of time in your future work.

You will quickly learn that you spend more time debugging your Logo programs than you do writing them. Don’t let that discourage you. Even professional computer programmers spend most of their time debugging. You should consider the time you spend debugging part of the learning process.

When you begin using the Procedures tab you will also want to begin making use of the Processes tab. The Processes tab is included to assist in the debugging of your procedures. Open the Processes tab and examine the contents.
When you click on the Processes tab, you see a list of Processes. The concept of Processes is not new in MicroWorlds Pro. Processes were added to the Logo environment with the first version of MicroWorlds. The difference is that MicroWorlds Pro puts processes in a place that they are more visible and easier to work with and debug.

If you’ve used any version of MicroWorlds, you are familiar with Processes. A Process is some action that can continue independently of other processes. For example, the Turtle in the above example moves forward independent of other actions until the user stops it.

The three Buttons at the top of the window let you control the Process in order to refine or debug it. Green starts the Process; red stops the Process. Clicking on Yellow runs the Process at a slower speed. If you are having difficulty seeing the results of a complex combination of procedures—for example building the house and picket fence shown earlier—slowing the action can help you locate a problem.

When writing procedures for a Project, keep the names of your procedures meaningful and keep your procedures short. It is easy to find yourself adding more and more instructions to a procedure. Soon you have a very long procedure that is hard to debug. Perhaps the name of the procedure no longer describes the function of the procedure. Take time to subdivide and rename procedures as you work. This saves time later when you debug.

Take time to document your programs. Include comments in the procedures themselves if there are lines that might confuse the reader. Identify each procedure and where it is used. Separate procedures into meaningful groups by using comments.

As you think about the many steps you have taken in this chapter, you may recognize that there is tremendous advantage in building on your own or someone else’s work. There is little point in using the keyboard to enter the same five Procedures in each of several Projects. As your comfort level grows, you may wish to establish a Project that
does nothing but hold on your special Procedures. Then you can move
them into the current Project and avoid the tedious task of entering
and testing them again.

As you undertake more complex tasks in MicroWorlds Pro, you will
find that more and more of your time is spent detecting and correcting
bugs. Eventually you will learn that it is better to prevent bugs than to
detect and correct them. Also, it is better to design a program that is
easy to debug. Careful documentation is an essential part of the design
and writing process. These are very important ideas in computer
programming. It takes a great deal of experience and learning to
become skilled at designing and writing programs containing few or no
bugs.
Chapter 12

Designing Complex Projects

Most of the Projects you have created thus far have probably been somewhat short and simple. Thus, you may have been able to accomplish these tasks without doing much advanced planning or thinking about the overall design of the Project.

There is a lot of difference between writing a memo that is a couple of paragraphs long and writing term papers or business reports that are 20 Pages long. You need to approach the tasks differently.

The same is true in undertaking a large MicroWorlds Pro Project. In some ways it is more difficult to scale up a MicroWorlds Pro Project from a single Page to many Pages in length than it is to write a long term paper. In part, that is because a term paper is linear. However, a MicroWorlds Pro Project need not be linear. Also, hypermedia is a more complex communication system than the text-only environment usually found in a term paper.

Designing Projects

In a previous chapter, you saw a number of ways to design a Logo program made up of several procedures. Similar techniques can be used to design Projects. Sometimes you will take a top-down approach. You will know exactly what Pages should be in your Project and how they will be related. At other times you will take a bottom-up approach, designing Pages and adding them to the Project as you get new ideas.

As a Project grows more and more complex, it becomes increasingly important to examine how the Pages of the Project are related. Sometimes your Pages will be in a linear order.
That is, you want the user to move through the Project a Page at a time. You want them to have only one decision to make—they either move to a new Page or they can return to the one they just saw. This isn’t very flexible but it does ensure that every user sees exactly the same information in exactly the same order. For forcing this linear document, each Page probably has a Next.Page Button and a Previous.Page Button on it.

You may want to link the last Page with the first.

In this case, the last Page might have a First.Page Button on it that uses the following Procedure.

```
to First.Page
Page1
end
```

while the first Page might have a Last.Page Button on it.

Sometimes you’ll have a “Menu” Page that allows users to jump to various parts of your Project. You might also allow movement between the Pages of the Project without returning to the Menu Page.

In such a model, most of the Pages have a Menu Button, a Next.Page Button, and a Previous.Page Button. However, this organization scheme begins to become a problem as the Project size increases. The
user will find it difficult to maintain their orientation if the Project has many Pages. Too many choices are no more acceptable than providing no choices for the user.

Technical Note: A Project will open to a Page named “Page1” or to whatever Page is on the screen when the Project is last closed. If you want your Project to open to a particular Page, be sure that Page is named Page1.

The diagrams given here provide maps of the structure of a Project. It is a good idea to draw a map of your Project, perhaps even including a Map Page in the Project as one of the introductory Pages.

In the models just shown, there were a lot of options for moving about in a Project. While such flexibility is possible, it can be confusing for the user. For example, a user is less apt to get lost in your Project if you use the following structure:

Here the user must always return to the Menu Page before exploring other Pages in the Project. This structure is extremely useful for many types of Projects. It provides a document that the user can navigate with little or no problem. This organization may continue down several more levels for a large Project.
The structures just shown are relatively systematic. However, other Projects can have networks like the following one:

A structure such as this could be used for an adventure game or a simulation of a field trip. Each Page could represent a room or a type of ecology.

The other way to use the previous organization is to present a Project where each Page looks identical to every other in terms of placement and appearance of elements. The only changes are to the specific content of each Page. When a Project is designed in this manner, the user is moved from Page to Page without really being aware of the fact. This provides a comfortable and interactive interface that is motivating and engaging to use.

When designing Projects, it is a good idea to think carefully about your users. You need to plan the structure so users can navigate easily and not get lost. How do users know the options about where they are going? How do they know that they have successfully arrived where they wanted to go? What cues do you want them to be aware of and how to you avoid unintentional cues? Provide flexibility, but not so much flexibility that the user can get confused.

Designing your Project carefully saves you debugging time. Invariably, large and complex Projects initially contain errors. You and other users of your Project will find that it doesn't work as expected. If your design has been done carefully, it will be easy to associate the incorrect functioning with particular parts of your Project. You may be able to go directly to the incorrect code on a particular Button or Turtle.
As you begin to work on more complex Projects, return to this section of this book and think about your Project’s emerging structure. What structure will work best for your Project? How can advance planning make your Project easier to develop? If your structure is not like any described here, can you make a diagram of the structure you want to use? Understanding the structure of your Project makes it easier to develop individual parts.

**Navigation**

Another consideration when planning your Projects is how you expect users to move from Page to Page within a Project. Buttons are often used. You might, for example, have a Button such as this on the first Page.

![Animals Button](image)

If the name of the Page to which you want to move is Animals, then clicking the Button moves the user to the correct Page. When the user arrives at the Page, they should be presented with the word Animals as a dominant element on the Page to confirm that the Button did complete the expected action.

Each Page in your Project probably has one or more Buttons on it for moving to another part of the Project. It is important that the Buttons used for navigation among Pages look alike and are in the same place on each Page. For example, these three Pages would probably confuse the user,
while the placement of the Buttons on these three Pages is easier to understand.

There are several options that you may not have explored that will help you create consistent and attractive Projects. You already know that to Copy and Paste Buttons will give you Buttons of exactly the same size. This approach does nothing to assist in consistent placement of the Buttons. The Project tab drop-down menus provide the necessary controls. Open the Button menu and select **Size and Position**.
Rather than trying to drag the objects into position, enter the values you need into this dialog box.

<table>
<thead>
<tr>
<th>Name: button1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size: Width 60</td>
</tr>
<tr>
<td>Position: X -193</td>
</tr>
</tbody>
</table>

When you have the first Button as you wish, copy the width and height onto a piece of paper so you have them handy. For each Button that needs to match the first one, place and size it with number entries.

As you noted earlier, the Project tab provides drop down menus for all objects. The only object that does not include the **Size and Position** option is the Turtle.

In the previous chapter, using sound to enhance Page transitions is mentioned. Recall that you should not overuse sound because it becomes annoying to the user. Be sure to keep transitional sounds short. Sound is an extremely powerful communication system but needs to be used with great care. The exception to ‘too much’ is if your Project is focused on music or speeches where the sound is content rather than enhancement to communication.
In *MicroWorlds Pro* you can also use special visual effects that cause the Page to which you are moving to be displayed in different ways. These effects are called *transitions*. Select **Transitions** from the **Pages** menu. Try choosing the transition in the upper left.

Transitions are activated as you arrive at the Page you were on when the Transition was applied. So, if you are on Page3 when you select a transition, it is not visible until you arrive at Page3 from elsewhere in the Project. Put two Pages into a Project with different background colors in place and test each of these choices.

Transitions can be very powerful. Like sound, you should not overuse them. Think carefully about why you use transitions. For example, always use the same type of transition for similar choices. For example, always use the same transition to move from each item on a menu. Don’t use different transitions on every Page! Generally speaking you try to design so that the transitions do not distract the user of the Project. For some Projects you create there is no suitable transition.

You should always think carefully about all aspects of navigation when you are planning your Project. Don’t add a navigational feature just because it is “neat” or “fun.” Be sure that it actually adds to your Project.
More Advanced Use of Pages

You have learned that you can add Pages to your Projects by selecting **New Page** from the **Pages** menu. You can also create a new Page by entering

```
newPage
```

in the Command Center. The new Page is automatically named Page#, where # is the next available number. That is, if you have only a Page1 and a Page3 and you add a new Page, it will be named Page2.

You can change the name of a Page by using the **Name Page** choice from the **Pages** menu. This step is extremely easy as you can see. You open this dialog box and enter a new name.

![Name Page dialog box]

Since the Page name is used as a Logo command it provides a simple and easy addition to your Project navigation. In addition, keep in mind the way names are handled. Suppose you replace the default name of **Page2** with the name **Title**. This immediately gives *MicroWorlds Pro* the freedom of using the name **Page2** for the next Page you create.

You can also make copies of Pages by using the **Duplicate Page** option on the **Pages** menu. An exact copy of the Page is made, including all of the graphics and objects on the Page. When you duplicate a Page, the next available Page# is used for the name. That is, you end up with two identical Pages, but with different names. This might be useful if you want to use a particular background for a number of Pages. Using **Duplicate Page** is also useful if you want Pages that are only slightly different in background or content.

You have also learned that you can move between the Pages of a Project by using the **Pages** menu. The names of the Pages in a Project are added to the bottom of the **Pages** menu. The name of a Page becomes a command. If your list of Pages includes one called **Fog** you can enter

```
Fog
```

in the Command Center to move to the Page named **Fog**. You can use the word Fog in the instruction line of a Button. Clicking on the Button will move you directly to the Page.
Much earlier in this book you learned how to remove a Page from a Project. You can remove Pages by using the remove command in the Command Center. Entering

```
remove "my.Page"
```

Delete or Backspaces the my.Page Page from the Project. Do use care when using remove. After a Page is Delete or Backspaced, all of the objects and graphics on that Page are gone and cannot be retrieved. If the Page you remove is the only Page left in the Project, it will not be removed. Instead, it will be cleared.

When you open a Project that you have saved, the Page named Page1 is shown on the opening screen. If there is no Page1, the Page that was showing when the Project was last saved will appear. You can control which Page appears by using a startup procedure on the Procedures tab. Suppose you have a Page named Menu that you want to appear each time the Project is opened. Put this procedure on the Procedures tab:

```
to startup
Menu
end
```

When a Project is opened a startup procedure is automatically run. This can be controlled if you create a procedure named startup. The startup procedure just shown will cause the Menu Page to appear. Of course, you can specify a number of different activities to occur in startup. For example, you might also want a tune to be played.

### Sharing Projects

Once you have created a Project, you will often want to reuse parts of your Project in another Project. In this section you will learn how to share the various parts of your Project. You have already learned to use the Import and Export options from the File menu. You can Export shapes, pictures, text and page images. You can Import video, music, pictures, shapes, sounds and text.

You have already learned one way to copy shapes from an old Project to a new one. You start in the old Project and choose Export->Shapes from the File menu. After you give the special export file a name, a special dialog box opens. On the left you will see the shapes in the current Project. Click on a shape to select and use the arrow button in the center to move the shape to the right. Any shape you move is saved in your special file. Next, open the new Project and choose Import -> Shapes from the File menu. Locate and open the file you just created and move the shapes again. This approach is extremely efficient when you want to move only a few select shapes.
If you want to move all the shapes from one Project to another, use the **merge** command. Merge can be used to move Pages, Procedures and shapes. Suppose that the old Project is named `old.Project`. First, make sure you are in your new Project. To merge the shapes from the old document to the new in the command center enter

```plaintext
merge "old.Project "shapes
```

This will move every shape. Be aware that this will overwrite the shapes that were present. Plan ahead so that you do this merge before you spend time creating any new shapes you need for the new Project.

To merge all of the Pages, enter

```plaintext
merge "old.Project "Pages
```

All of the Pages from `old.Project` are now part of the new Project. Duplicate Page names are given generic Page# names.

The previous two steps are powerful and provide a quick shortcut to reusing a great deal of work. However, if you merge Pages that make use of unique shapes you could find you have a problem. Unless you've already merged the shapes, the Page will appear minus the unique shapes previously used. To avoid this problem, think about what you are trying to accomplish and approach the steps correctly.

Using **merge** on procedures causes less difficulty. In the command center enter

```plaintext
merge "old.Project "procedures
```

to merge the procedures on the Procedures tab of the old Project with the Procedures tab of the new Project. The procedures will be pasted into the Procedures tab after any code that is already visible. This means it is possible to end up with more than one procedure having the same name. If you run use a procedure name that is duplicated, the first occurrence is used. To keep your Procedures tab readable, you will want to remove excess code and rename procedures as required.

**Tips and Techniques**

When designing a Project, it might be helpful to have a 3 x 5-inch index card representing each Page. You can sketch your plans on the card and then note on the back of the card the objects that you need to add to the Page. To see the relationships among the Pages of your Project, you can tack the cards to a bulletin board or lay them out on a table. Connecting the cards with pieces of string or yarn can help show the relationships.

If you want particular objects, such as Buttons, Text boxes, Turtles, or Sliders, from an old Project, you can merge the Pages from the old
Project that contain those objects and then copy the individual objects to the appropriate Pages in your new Project.

Two powerful ideas are illustrated in this chapter: overall design of a Project and building on your previous work. As noted earlier, a hypermedia Project can be far more complex than a written paper. For the most part, a written paper has a linear design. All you have to do is decide what comes first, what comes second, and so on.

In a nonlinear document, different users will proceed through the document via different paths. You design for the pathway you feel is optimal and provide cues for the user to follow your suggestion. However, the user decides the final order to be followed.

It is easy to design a Project in which the user will get completely lost. Indeed, there is a special term for this—it is called “lost in hyperspace.” Thus, a great deal of care needs to be given to helping the user understand the overall design and options of the Project. You want the user to proceed through (make use of) different parts of your Project. You want this to occur in a manner that meets both your needs and the needs of the user.

The individual Pages of a complex Project are also a major design challenge. What do you want the user to do on each Page? What directs the user to other Pages? What is the appropriate use of colorful backgrounds in the overall Project? How can your communication with the user make best use of sound and animation?

This chapter explains how to copy all or parts of a Project that you or someone else has created in the past and incorporate the copied parts into a new Project. When you are just writing text, you are generally limited in the amount of copying that you do. There are rules for citing sources of quoted material and guidelines about plagiarism. Generally, students are not encouraged to copy large parts of previous papers into a new paper.

The situation is somewhat different when working on a hypermedia project. First, the environment itself strongly encourages sharing work with other people. In *MicroWorlds Pro*, the shapes and the stamping process are specifically designed to facilitate copying of the graphics in *MicroWorlds Pro*. On a deeper level, the extensible nature of the Logo language is specifically designed to build Logo words that will be used in future projects. Often you will want to share your Projects with other people. Such sharing and cooperative problem solving brings a new dimension to education.

Of course, the usual rules about crediting one’s sources and about plagiarism hold when creating hypermedia projects. If you copy text or graphics from published sources, you should cite these sources.
However, there is a great deal of public domain and commercial clip art. Generally speaking, these graphic images can be used in hypermedia projects without citing the sources.

While you have included many types of media in your Projects by this time, it may be that you have wondered why this book has not included a discussion on HyperLinks—an object that can be included from the hyperlink Button on the toolbar.

This object lets you connect your own work to the contents of web sites that are available through an Internet connection. The object provides you with a dialog box for entering a web address. When the user activates this link, they will be taken directly to the appropriate web site. However, as a beginner there are some problems with this object. How do you know your user has an Internet connection? And are they able to easily and comfortably return from the web site to your Project?

In addition, including outside sources in your Project can be risky. At the rate the Internet changes, your hyperlink object may in fact produce an error if the web address is no longer active. And of course, your Page needs to credit the person that created the linked material as well as finding a way to give the user enough information to make an informed decision about using the link or not.

By now, you recognize that the development of a good *MicroWorlds Pro* Project takes a great deal of time. Think of this time as needing division into several major steps. First, there is the initial conception and overall design of the Project. Here you think about the intended audience and the intended purpose of your Project. Second, there is the implementation, accompanied by ongoing refinement of the design. Third, there is the testing and debugging of the Project. And, you will quickly learn that hypermedia documents are never finished. You’ll always be tempted to make ‘just one more revision.’

**Looking Ahead**

If you have enjoyed your work with *MicroWorlds Pro*, you may want to consider working with the next book in this series, *MicroWorlds Pro—Hypermedia Project Development and Logo Scripting*. You have seen that *MicroWorlds Pro* has many powerful capabilities. You can perform many different tasks in *MicroWorlds Pro* by using the mouse to select a variety of tools. You can also perform many of these tasks using Logo commands.

You can think of writing procedures as a way to ‘teach’ *MicroWorlds Pro* how to do new things. *MicroWorlds Pro* learns the new words you add to the vocabulary of the Logo language. If you found this idea of
writing procedures exciting, you will no doubt enjoy learning more about the many things that you can do with procedures. The in-depth presentation of the programming is found in the next book.
# Appendix 1

## Tools, Techniques, and Logo Words

### Toolbar

<table>
<thead>
<tr>
<th>General</th>
<th>Layout</th>
<th>Creating Objects</th>
<th>Editing Objects</th>
<th>General Editing</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>New Project</td>
<td>Project Layout</td>
<td>Turtle Hatching tool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Project</td>
<td>Procedures Layout</td>
<td>Text Box tool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Project</td>
<td></td>
<td>Button tool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Project Page</td>
<td></td>
<td>Slider tool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Melody Editor tool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sound Recording tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Movie tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Hyperlink tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Selection</strong></td>
<td>Arrow pointer/regular pointer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Editing Objects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Eye tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Stamper tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Magnifying tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>De-magnifying tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>Stop All tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>General Editing</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cut tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Copy tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Paste tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Undo tool</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Special</strong></td>
<td>Help tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Graphics tab tools

<table>
<thead>
<tr>
<th>Creating</th>
<th>Editing</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>Pencil tool</td>
<td>Rectangle Selection tool</td>
</tr>
<tr>
<td>Pen tool</td>
<td>Lasso tool</td>
</tr>
<tr>
<td>Paint Can tool</td>
<td>Eraser tool</td>
</tr>
<tr>
<td>Spray tool</td>
<td>Eyedropper tool</td>
</tr>
<tr>
<td>Rectangle tool</td>
<td>Undo tool</td>
</tr>
<tr>
<td>Filled Rectangle tool</td>
<td></td>
</tr>
<tr>
<td>Oval tool</td>
<td></td>
</tr>
<tr>
<td>Filled Oval tool</td>
<td></td>
</tr>
</tbody>
</table>

**Creating**

- Pencil tool
- Pen tool
- Paint Can tool
- Spray tool
- Rectangle tool
- Filled Rectangle tool
- Oval tool
- Filled Oval tool

**Editing**

- Rectangle Selection tool
- Lasso tool
- Eraser tool
- Eyedropper tool
- Undo tool
**Brush Shapes Palette**

![Brush Shapes Palette](image)

**Color Selector**

![Color Selector](image)

**Shapes Palette**

![Shapes Palette](image)

**Button Techniques**

<table>
<thead>
<tr>
<th>Action</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate a Button so that the Logo code on it runs.</td>
<td>Click on it.</td>
</tr>
<tr>
<td>Copy a Button.</td>
<td>Select the Button and use <strong>Copy</strong> and <strong>Paste</strong> from the <strong>Edit</strong> menu, or Use the Copy and Paste tools on the Toolbar.</td>
</tr>
<tr>
<td>Create a new Button.</td>
<td>Click on the Button tool and then click on the Page.</td>
</tr>
<tr>
<td>Delete a Button.</td>
<td>Select the Button and use the Delete or Backspace key, or Click on the Button with the Scissors tool on the Toolbar.</td>
</tr>
<tr>
<td>Edit a Button dialog box.</td>
<td>Click on the Button with the Eye tool, or Select Edit from the object drop-down</td>
</tr>
</tbody>
</table>
## Tools, Techniques, and Logo Words

| Move a Button. | Select the Button and then click and drag the Button to a new location. |
| Select a Button. | Hold down the Command or Control key and click on the Button, or Click and drag a rectangle around the Button by using the regular pointer. |
| Size a Button. | Select the Button and then click and drag on the handles, or Select Size and Position from the object drop-down menu. |
| Stop a Button from running the Logo code on it. | Click on it, or Select **Stop All** from the **Edit** menu, or Click the Stop All tool on the Toolbar. |

### Media Object Techniques (Video, Melodies, QuickTime Movies, and Recordings)

| Activate a Media Object so that the Logo code on it runs | Click on it. |
| Copy a Media Object | Select the Media Object and use **Copy** and **Paste** from the **Edit** menu. |
| Create a new Media Object | Click on Media Object Tool and then click on the Page. |
| Edit a Media Object dialog box | Click on the Media Object with the Eye Tool, or Select the Media Object Tool and then click on the Media Object, or Select the Media Object and then hold down the Shift key while double clicking on the Media Object with the Regular Pointer. |
| Move a Media Object | Click and drag the Media Object to a new location. |
| Select a Media Object | Hold down the Shift key and click on the Media Object, or Click and drag a rectangle around the Media Object using the Regular Pointer. |
| Stop a Media Object | Click on it. |
from running the Logo code on it

**Slider Techniques**

<table>
<thead>
<tr>
<th>Action</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a Slider.</td>
<td>Select the Slider and use <strong>Copy</strong> and <strong>Paste</strong> from the <strong>Edit</strong> menu, or Use the Copy and Paste tools on the Toolbar.</td>
</tr>
<tr>
<td>Create a new Slider.</td>
<td>Click on the Slider tool and then click on the Page; or Use Copy and Paste from the Edit menu.</td>
</tr>
<tr>
<td>Delete a Slider.</td>
<td>Select the Slider and use the Delete or Backspace key, or Click on the Slider with the Scissors tool from the Toolbar.</td>
</tr>
<tr>
<td>Edit a Slider dialog box.</td>
<td>Click on the Slider with the Eye tool; or Select Edit from the object drop-down menu.</td>
</tr>
<tr>
<td>Move a Slider.</td>
<td>Click and drag the Slider to a new location; or Select Size and Position from the object drop-down menu.</td>
</tr>
<tr>
<td>Select a Slider.</td>
<td>Hold down the Command or Control key and click on the Slider, or Click and drag a rectangle around the Slider by using the regular pointer.</td>
</tr>
</tbody>
</table>

**Text Box Techniques**

<table>
<thead>
<tr>
<th>Action</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a Text box.</td>
<td>Select the Text box and use <strong>Copy</strong> and <strong>Paste</strong> from the <strong>Edit</strong> menu, or Use the Copy and Paste tools on the Toolbar.</td>
</tr>
<tr>
<td>Create a new Text box.</td>
<td>Click on the Text box tool and then click on the Page; or Click and drag on the Page to create a Text box the size of your choice.</td>
</tr>
<tr>
<td>Delete a Text box.</td>
<td>Select the Text box and use the Delete or Backspace key, or Click on the Text box with the Scissors tool.</td>
</tr>
</tbody>
</table>
**Appendix 1 ❖ Tools, Techniques, and Logo Words**

<table>
<thead>
<tr>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit a Text box dialog box.</td>
<td>Click on the Text box with the Eye tool, or Select Edit from the object drop-down menu.</td>
</tr>
<tr>
<td>Edit a transparent (snapped) Text box.</td>
<td>Click on the Text box with the Eye tool and reset the Text box to not be transparent, edit the text and replace the setting.</td>
</tr>
<tr>
<td>Enter text into a Text box.</td>
<td>Click on it so that the vertical pointer appears; begin entering text.</td>
</tr>
<tr>
<td>Make a Text box transparent.</td>
<td>Click on the Text box with the Eye tool and reset the dialog box.</td>
</tr>
<tr>
<td>Move a Text box.</td>
<td>Click and drag the Text box to a new location.</td>
</tr>
<tr>
<td>Select a Text box.</td>
<td>Hold down the Command or Control key and click on the Text box, or Click and drag a rectangle around the Text box by using the Regular Pointer.</td>
</tr>
<tr>
<td>Size a Text box.</td>
<td>Select the Text box and click and drag on the handles; or Select Size and Position from the object drop-down menu.</td>
</tr>
</tbody>
</table>

**Turtle Techniques**

<table>
<thead>
<tr>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a Turtle.</td>
<td>Select the Turtle and use <strong>Copy</strong> and <strong>Paste</strong> from the <strong>Edit</strong> menu, or Use the Copy and Paste tools on the Toolbar.</td>
</tr>
<tr>
<td>Create a new Turtle.</td>
<td>Click on the Turtle tool and then click on the Page.</td>
</tr>
<tr>
<td>Delete a Turtle.</td>
<td>Click on the Turtle with the Scissors tool from the Toolbar, or Select the Turtle and use the Delete or Backspace key.</td>
</tr>
<tr>
<td>Edit a Turtle dialog box.</td>
<td>Click on the Turtle with the Eye tool from the Toolbar, or Select Edit from the object drop-down menu.</td>
</tr>
<tr>
<td>Move a Turtle.</td>
<td>Click and drag the Turtle to a new location.</td>
</tr>
</tbody>
</table>
Introduction to *MicroWorlds Pro*—Scripting

<table>
<thead>
<tr>
<th>Location.</th>
<th>Select a Turtle.</th>
<th>Hold down the Command or Control key and click on the Turtle, or Click and drag a rectangle around the Turtle by using the regular pointer.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Size a Turtle.</td>
<td>Select one of the Magnifier or Demagnifier tools from the Toolbar and click on the Turtle, or Select Size and Position from the object drop-down menu.</td>
</tr>
<tr>
<td></td>
<td>Stop a Turtle from running the Logo code on it.</td>
<td>Click on it, or Select <strong>StopAll</strong> from the <strong>Edit</strong> menu, or Select Stop All tool on the Toolbar.</td>
</tr>
</tbody>
</table>

**Object Editing Popup Menus**

These shortcuts are available regardless of the computer you are using. On the Macintosh, hold down the Control key and click on the Object. On the PC, use the right mouse button to click on the object.

<table>
<thead>
<tr>
<th>MicroWorlds Object</th>
<th>Popup Menu on Page</th>
<th>Popup Menu in Project Tab area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turtles</td>
<td>Edit</td>
<td>Edit</td>
</tr>
<tr>
<td></td>
<td>Animate</td>
<td>Hide/Show</td>
</tr>
<tr>
<td></td>
<td>In front</td>
<td>Freeze/Unfreeze</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Remove</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Text Boxes</td>
<td>Edit</td>
<td>Edit</td>
</tr>
<tr>
<td></td>
<td>Transparent/Opaque</td>
<td>Hide/Show</td>
</tr>
<tr>
<td></td>
<td>Spell</td>
<td>Freeze/Unfreeze</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Size and Position</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Remove</td>
</tr>
<tr>
<td>Buttons &amp; Sliders</td>
<td>Edit</td>
<td>Edit</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Freeze/Unfreeze</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Size and Position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>Melody</td>
<td>Edit</td>
<td>Play</td>
</tr>
<tr>
<td>Music</td>
<td>Cut</td>
<td>Edit</td>
</tr>
<tr>
<td>Sound</td>
<td>Copy</td>
<td>Hide/Show</td>
</tr>
</tbody>
</table>
### Tools, Techniques, and Logo Words

<table>
<thead>
<tr>
<th>Recording Video</th>
<th>Freeze/Unfreeze</th>
<th>Size and Position</th>
<th>Remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hyperlink</td>
<td>Edit</td>
<td>Link</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Hide/Show</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Freeze/Unfreeze</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Size and Position</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Remove</td>
<td></td>
</tr>
<tr>
<td>Programmed Color</td>
<td>Edit <code>colorname</code></td>
<td>Edit</td>
<td>Remove Mouse instruction (if available)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Remove Turtle instruction (if available)</td>
</tr>
<tr>
<td>Page</td>
<td></td>
<td>Edit</td>
<td>Go To</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Transition</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Remove</td>
</tr>
</tbody>
</table>

### Logo Words

<table>
<thead>
<tr>
<th>back <code>number</code></th>
<th>Moves the Turtle number steps backward.</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>cg</code></td>
<td>Clears the graphics from the screen and puts the Turtle in the center of the screen.</td>
</tr>
<tr>
<td><code>clean</code></td>
<td>Clears the graphics from the screen and leaves the Turtle in the current position.</td>
</tr>
<tr>
<td><code>cleartext</code></td>
<td>Removes all of the text from the current Text box.</td>
</tr>
<tr>
<td><code>fill</code></td>
<td>Fills an enclosed area under the Turtle with the current pen color and pen pattern.</td>
</tr>
<tr>
<td><code>forward</code></td>
<td>Moves the Turtle forward number Turtle steps.</td>
</tr>
<tr>
<td><code>ht</code></td>
<td>Makes the Turtle invisible.</td>
</tr>
<tr>
<td><code>insert</code></td>
<td>Puts text between the square brackets into the current Text box—does not add a</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>left number</td>
<td>Turns the Turtle number degrees to the left.</td>
</tr>
<tr>
<td>loadpic &quot;picture.name&quot;</td>
<td>Loads a graphic file into the background of the Page.</td>
</tr>
<tr>
<td>loadshape &quot;picture.name&quot;</td>
<td>Loads a graphic file into the Shape palette at the position given by the number.</td>
</tr>
<tr>
<td>merge &quot;Project.name&quot;</td>
<td>Adds all (or named) Pages, shapes, or procedures from Project.name to currently open Project.</td>
</tr>
<tr>
<td>newPage</td>
<td>Creates a new Page with the name Page#, where # is the next available number.</td>
</tr>
<tr>
<td>note pitch duration</td>
<td>Plays a note with a pitch taken from the table of MIDI values and a duration measured in 10ths of a second.</td>
</tr>
<tr>
<td>parse</td>
<td>Changes a word into a list; used with run.</td>
</tr>
<tr>
<td>pd</td>
<td>Puts the Turtle's pen down.</td>
</tr>
<tr>
<td>print [list to print]</td>
<td>Puts text between the square brackets into the current Text box—adds a carriage return character at the end.</td>
</tr>
<tr>
<td>pu</td>
<td>Lifts the Turtle's pen.</td>
</tr>
<tr>
<td>random number</td>
<td>Reports a number between 0 and 1 minus the number given after random.</td>
</tr>
<tr>
<td>remove &quot;name&quot;</td>
<td>Permanently deletes the named Page from the Project.</td>
</tr>
<tr>
<td>remove &quot;sound.name&quot;</td>
<td>Removes a melody or sound from the current sounds in a Project.</td>
</tr>
<tr>
<td>repeat number [Logo instructions ]</td>
<td>Causes the Logo instructions between the square brackets to run number times.</td>
</tr>
<tr>
<td>right number</td>
<td>Turns the Turtle to the right number degrees.</td>
</tr>
<tr>
<td>run</td>
<td>Runs a list of Logo instructions that follow it.</td>
</tr>
<tr>
<td>savepict &quot;picture.name&quot;</td>
<td>Saves the background as a graphic file.</td>
</tr>
<tr>
<td>setbg &quot;color.name&quot;</td>
<td>Sets the background color to the color.name/color.number.</td>
</tr>
<tr>
<td>setbg color.number</td>
<td>Sets the background color to the color.name/color.number.</td>
</tr>
<tr>
<td>setc &quot;color.name&quot;</td>
<td>Sets the pen color to color.name or color.number.</td>
</tr>
<tr>
<td>setc color.number</td>
<td>Sets the pen color to color.name or color.number.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>setinstrument &quot;name</code></td>
<td>Sets the current instrument to name.</td>
</tr>
<tr>
<td><code>setpenpat number</code></td>
<td>Sets the pen pattern to one of 38 possible patterns.</td>
</tr>
<tr>
<td><code>setpensize number</code></td>
<td>Sets the width of the pen from 1 to 100 pixels.</td>
</tr>
<tr>
<td><code>setsh &quot;shapename</code></td>
<td>Sets the Turtle’s shape to number or name.</td>
</tr>
<tr>
<td><code>setsh number</code></td>
<td>Sets the size of the Turtle—must be between 5 and 150.</td>
</tr>
<tr>
<td><code>show</code></td>
<td>Puts information in the Command Center.</td>
</tr>
<tr>
<td><code>st</code></td>
<td>Makes the Turtle visible.</td>
</tr>
<tr>
<td><code>stamp</code></td>
<td>Stamps an image of the Turtle on the Page.</td>
</tr>
<tr>
<td><code>startup</code></td>
<td>Used as a procedure name; a <code>startup</code> procedure automatically runs when the Project is opened.</td>
</tr>
<tr>
<td><code>stopall</code></td>
<td>Stops all action.</td>
</tr>
<tr>
<td><code>talkto &quot;Turtlename</code></td>
<td>Activates or addresses a Turtle.</td>
</tr>
<tr>
<td><code>tto &quot;Turtlename</code></td>
<td>Activates or addresses a Turtle.</td>
</tr>
<tr>
<td><code>Turtlename,</code></td>
<td>Activates or addresses a Turtle.</td>
</tr>
<tr>
<td><code>who</code></td>
<td>Reports the name of the current Turtle.</td>
</tr>
</tbody>
</table>
Appendix 2

**MicroWorlds Pro Vocabulary**

### Graphics

<table>
<thead>
<tr>
<th>Command</th>
<th>Function 1</th>
<th>Function 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>back (bk)</td>
<td>newturtle</td>
<td>sety</td>
</tr>
<tr>
<td>bg</td>
<td>pd</td>
<td>shape</td>
</tr>
<tr>
<td>cg</td>
<td>pensize</td>
<td>size</td>
</tr>
<tr>
<td>clean</td>
<td>pos</td>
<td>snaparea</td>
</tr>
<tr>
<td>color</td>
<td>pu</td>
<td>snapshape</td>
</tr>
<tr>
<td>colorunder</td>
<td>restore</td>
<td>snapshot</td>
</tr>
<tr>
<td>distance</td>
<td>right (rt)</td>
<td>st</td>
</tr>
<tr>
<td>fill</td>
<td>setbg</td>
<td>stamp</td>
</tr>
<tr>
<td>forward (fd)</td>
<td>setc</td>
<td>towards</td>
</tr>
<tr>
<td>freezebg</td>
<td>seth</td>
<td>unfreeze</td>
</tr>
<tr>
<td>glide</td>
<td>setpensize</td>
<td>who</td>
</tr>
<tr>
<td>heading</td>
<td>setpos</td>
<td>xcor</td>
</tr>
<tr>
<td>home</td>
<td>setsh</td>
<td>ycor</td>
</tr>
<tr>
<td>ht</td>
<td>setsize</td>
<td></td>
</tr>
<tr>
<td>left (lt)</td>
<td>setx</td>
<td></td>
</tr>
</tbody>
</table>

### Objects

<table>
<thead>
<tr>
<th>Command</th>
<th>Function 1</th>
<th>Function 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>ask</td>
<td>newtext</td>
<td>talkto (tto)</td>
</tr>
<tr>
<td>freeze</td>
<td>opaque</td>
<td>textwho</td>
</tr>
<tr>
<td>get</td>
<td>remove</td>
<td>transparent</td>
</tr>
<tr>
<td>hidetext</td>
<td>set</td>
<td>turtlesown</td>
</tr>
<tr>
<td>newbutton</td>
<td>showtext</td>
<td>unfreeze</td>
</tr>
<tr>
<td>newslider</td>
<td>stamptext</td>
<td></td>
</tr>
</tbody>
</table>
### Text Editing

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bottom</td>
<td>eot?</td>
<td>settc</td>
</tr>
<tr>
<td>cb</td>
<td>fontsize</td>
<td>show</td>
</tr>
<tr>
<td>cd</td>
<td>found?</td>
<td>snaptext</td>
</tr>
<tr>
<td>cf</td>
<td>insert</td>
<td>sol</td>
</tr>
<tr>
<td>cleartext (st)</td>
<td>paste</td>
<td>tc</td>
</tr>
<tr>
<td>clipboard</td>
<td>print (pr)</td>
<td>textcount</td>
</tr>
<tr>
<td>copy</td>
<td>search</td>
<td>textitem</td>
</tr>
<tr>
<td>cu</td>
<td>select</td>
<td>textpick</td>
</tr>
<tr>
<td>cut</td>
<td>setfont</td>
<td>top</td>
</tr>
<tr>
<td>delete</td>
<td>setfontsize</td>
<td>unselect</td>
</tr>
<tr>
<td>eol</td>
<td>setstyle</td>
<td></td>
</tr>
</tbody>
</table>

### Screen Management

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cc</td>
<td>namepage</td>
<td>procedures</td>
</tr>
<tr>
<td>getpage</td>
<td>newpage</td>
<td>projectsize</td>
</tr>
<tr>
<td>getproject</td>
<td>pagelist</td>
<td>setfooter</td>
</tr>
<tr>
<td>merge</td>
<td></td>
<td>presentationmode</td>
</tr>
</tbody>
</table>

### Words and Lists

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ascii</td>
<td>fput</td>
<td>number?</td>
</tr>
<tr>
<td>butfirst (bf)</td>
<td>identical?</td>
<td>parse</td>
</tr>
<tr>
<td>butlast (bl)</td>
<td>item</td>
<td>pick</td>
</tr>
<tr>
<td>char</td>
<td>last</td>
<td>sentence (se)</td>
</tr>
<tr>
<td>count</td>
<td>list</td>
<td>word</td>
</tr>
<tr>
<td>empty?</td>
<td>list?</td>
<td>word?</td>
</tr>
<tr>
<td>equal?</td>
<td>lput</td>
<td></td>
</tr>
<tr>
<td>first</td>
<td></td>
<td>member?</td>
</tr>
</tbody>
</table>

### Disk Access

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>chdir</td>
<td>importtext</td>
<td>savepict</td>
</tr>
<tr>
<td>currentdir</td>
<td>loadpict</td>
<td>saveproject</td>
</tr>
<tr>
<td>directories</td>
<td>loadshape</td>
<td>saveshape</td>
</tr>
<tr>
<td>erfile</td>
<td>loadtext</td>
<td>savetext</td>
</tr>
<tr>
<td>exporttext</td>
<td>pictlist</td>
<td>textlist</td>
</tr>
</tbody>
</table>
Appendix 2  MicroWorlds Pro Vocabulary

<table>
<thead>
<tr>
<th>Files</th>
<th>Placepict</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getproject</td>
<td>Projectlist</td>
</tr>
</tbody>
</table>

## Flow of Control and Logic

<table>
<thead>
<tr>
<th>And</th>
<th>Forever</th>
<th>Run</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>If</td>
<td>Setinstruction</td>
</tr>
<tr>
<td>Carefully</td>
<td>Ifelse</td>
<td>Stop</td>
</tr>
<tr>
<td>Clickoff</td>
<td>Launch</td>
<td>Stopall</td>
</tr>
<tr>
<td>Clickon</td>
<td>Listen</td>
<td>Stopme</td>
</tr>
<tr>
<td>Dolist</td>
<td>Not</td>
<td>Touching?</td>
</tr>
<tr>
<td>Done?</td>
<td>Onreading</td>
<td>Waituntil</td>
</tr>
<tr>
<td>Dotimes</td>
<td>Or</td>
<td>When</td>
</tr>
<tr>
<td>Errormessage</td>
<td>Output(op)</td>
<td></td>
</tr>
<tr>
<td>Everyone</td>
<td>Repeat</td>
<td></td>
</tr>
</tbody>
</table>

## Workspace

<table>
<thead>
<tr>
<th>Recycle</th>
<th>Space</th>
</tr>
</thead>
</table>

## Assigning

<table>
<thead>
<tr>
<th>Clearname</th>
<th>Local</th>
<th>Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clearnames</td>
<td>Make</td>
<td>Projectvars</td>
</tr>
<tr>
<td>Createprojectvar</td>
<td>Name</td>
<td>Thing</td>
</tr>
<tr>
<td>Let</td>
<td>Name?</td>
<td></td>
</tr>
</tbody>
</table>

## Math

<table>
<thead>
<tr>
<th>+</th>
<th>Difference</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Exp</td>
<td>Quotient</td>
</tr>
<tr>
<td>*</td>
<td>Greater?</td>
<td>Random</td>
</tr>
<tr>
<td>/</td>
<td>Int</td>
<td>Remainder</td>
</tr>
<tr>
<td>=</td>
<td>Less?</td>
<td>Rerandom</td>
</tr>
<tr>
<td>&gt;</td>
<td>Ln</td>
<td>Round</td>
</tr>
<tr>
<td>&lt;</td>
<td>Log</td>
<td>Sin</td>
</tr>
<tr>
<td>Abs</td>
<td>Minus</td>
<td>Sqrt</td>
</tr>
<tr>
<td>Arctan</td>
<td>Pi</td>
<td>Sum</td>
</tr>
<tr>
<td>Cos</td>
<td>Power</td>
<td>Tan</td>
</tr>
</tbody>
</table>
### Input/Output

<table>
<thead>
<tr>
<th>announce</th>
<th>key?</th>
<th>question</th>
</tr>
</thead>
<tbody>
<tr>
<td>answer</td>
<td>mousepos</td>
<td>readchar</td>
</tr>
</tbody>
</table>

### Time

<table>
<thead>
<tr>
<th>resett</th>
<th>timer</th>
<th>wait</th>
</tr>
</thead>
</table>

### Sound

<table>
<thead>
<tr>
<th>note</th>
<th>rest</th>
<th>setinstrument</th>
</tr>
</thead>
</table>

### Special

<table>
<thead>
<tr>
<th>the name of a melody</th>
<th>the name of a text box</th>
<th>set combined with the name of a text box</th>
</tr>
</thead>
<tbody>
<tr>
<td>the name of a Page</td>
<td>the name of a slider</td>
<td>set combined with the name of a slider</td>
</tr>
<tr>
<td>the name of a sound</td>
<td>the name of a Turtle variable</td>
<td>set combined with the name of a Turtle variable</td>
</tr>
</tbody>
</table>
Index

", 55
(), 97
,, 103
[, 66
[, 97
<, 150
>, 150
Active Turtle, 73
   identifying, 79
   which, 74
Animation
   with Turtles, 77
back, 41
Background
   changing the color of, 139
Background text, 90
Bar
   on Slider, 118
bk, 41
Brush Shape Editor, 23
Brush Shapes
   changing, 23
Brush shapes, 22
Bugs, 159
Button
   as object, 59
   changing instructions, 61
   copying, 62
   creating, 59
   Deleteing, 62
   differences from HyperCard, 60
   editing, 61
   for moving objects, 64
   Help, 25
   moving, 61
   Procedure Layout, 25
   Project Layout, 25
   removing, 62
   resizing, 60
   selecting, 60
   stopping action, 65
   to make Turtle drawings, 62
   Turtle used as, 78
   using, 62
   Button tool, 26
Carriage return character, 103
cg, 41
Changing
   Button size, 60
   color of background, 139
   shape of Turtle, 47
   shape size, 49
   Turtle size, 49
Clean, 41
Clearing the graphics Page, 41
Cleartext, 98
Click and drag, 29
Clip art, 91
Color
   of background, 139
   Color Picker tool
      in Graphics tab, 36
Color tools, 23
Color viewer, 23
Colors
   attaching code, 127
   family of, 129, 141
   how many, 129
   Logo code with, 127
   names of, 129
   numbers of, 129
   programming, 127
   response to mouse click, 128
   response to Turtle, 128
   shades of, 129
Colors, 23
Comma
   to address objects, 103
Command
   loadshape, 57
Command center
   running instructions, 73
Commands
   keeping, 145
   running in Command Center, 73
Comments
- in procedures, 151
- on the Procedures tab, 149

Copying
- Buttons, 62
- Pages, 168
- problems with graphics, 133
- shapes, 169
- Sliders, 120
- text, 83
- Text box, 88

copyright, 137

Creating
- new shapes, 53
- Text boxes, 81

cr, 98

Cutting
text, 83
- Text box, 88

Debugging, 159
- by tracing commands, 20

Deleting
- Buttons, 62
- Pages, 168
- problems with text, 83
- Sliders, 120
- text in Text box, 83

Demagnifier tool, 27, 49

Design
- of Projects, 161

Dots
- changing, 37

Duplicating
- Pages, 168

Duration
- length of, 110

Edit menu, 11

Editing
- Buttons, 61
- shapes, 51

Editor
- Brush Shape, 23
- Turtle Shape, 24

Eraser tool
- in Graphics tab, 31

Error messages, 17

Eye tool, 27

Fat Bits window, 37

fd, 39

File menu, 11

Fill
- problems with, 142

Fill and setbg
- differences, 139

Filled Oval tool
- in Graphics tab, 32

Filled Rectangle tool
- in Graphics tab, 31

Fonts
- see type families, 13

forward, 39

Frame of Text box
- showing/hiding, 89

General editing tools, 25

General tools, 25

Graphics
- copying to other applications, 133
- format for sharing, 134
- Pict format, 134
- problems with copying, 133
- problems with sharing, 142

Graphics tab
- Color Picker tool, 36
- Eraser tool, 31
- Filled Oval tool, 32
- Filled Rectangle tool, 31
- graphics tools, 22
- Lasso tool, 36
- Oval tool, 32
- Paint Can tool, 33
- Pen tool, 30
- Pencil tool, 29
- Rectangle tool, 31
- Selector tool, 34
- Sliders, 30
- Spray tool, 33

Help
- getting, 14
- last message, 17
- menu, 14
- vocabulary, 16

Help Button, 25

Hiding
- Text box frame, 89
- Text box name, 89

Hyperlink tool, 26

Icon
- MicroWorlds Pro, 5

Ideas
- for Projects, 6

Independent processes, 75

Insert, 98
- differences from print, 103
- different from Print, 98

Instrument
- setting with instructions, 111

Keys to use
Index

in the Text box, 82
Lasso tool
   in Graphics tab, 36
Last message, 17
Launching independent processes, 75
   layering
      of Turtles and Buttons, 67
layering of Buttons, 67
layering of objects, 67
Layout Buttons, 25
left, 41
Limit
   on size of Turtle, 55
loadpict, 132
Loadshape, 57
lt, 41
Magnifier tool, 27, 49
Main procedure, 157
Map
   of Project, 163
Matching colors, 36
Melodies
   removing, 109
Melody tool, 26
Menus, 7
Merge, 169
Merging
   pages, 169
   procedures, 169
   shapes, 169
MicroWorlds Help Topics, 14
MicroWorlds Pro
   icon, 5
Modifying shapes, 52
Movie object
   adding to background, 113
Movies
   adding, 111
   QuickTime, 111
Moving
   Buttons, 61
   text, 83
   Text box, 88
Moving selection, 35, 36
Music
   creating, 107
   in Projects, 156
   with the note instruction, 110
Music Editor
   using, 107
Musical notation
   chart of, 115
Name of Project
   changing, 10
Name of Text box
   showing/hiding, 89
Names
   one word, 114
Naming
   Pages, 168
   Turtles, 75
Navigation
   using transitions, 166
New Page, 167
   creating, 167
   getting, 7
New shapes
   creating, 53
Note, 110
Notes
   chart of musical, 115
   duration of, 110
   editing in Melody Editor, 109
   frequencies of, 110
   pitch in Melody Editor, 107
   pitch of, 110
   playing in Melody Editor, 108
Object
   examining, 20
   tracing, 20
Object Creation tools, 26
Objects
   naming, 114
Online help, 14
Opacity slider, 23
Opening screen, 7
Oval tool
   in Graphics tab, 32
Page
   Delete or Backspace, 13
   procedures, 145
Pages
   automatic names, 167
   copying, 168
   creating, 13
   default names, 167
   Deleteing, 168
   duplicating, 13
   duplication, 168
   exporting graphics, 130
   first to open, 168
   importing graphics, 130
   in Projects, 8
   merging, 169
   moving among, 168
   naming, 13, 168
   new, 167
opening, 168
removing, 168
switching, 168
transitioning to, 166
Pages menu, 13
Paint Can tool
in Graphics tab, 33
Parse, 100
pd, 40
Pen
normal state, 142
original settings, 142
Pen color
changing, 138
Pen Down, 40
Pen size
changing, 137
Pen tool
in Graphics tab, 30
Pen up, 41
Pencil tool
in Graphics tab, 29
Pictures
editing, 37
Pitch
using note, 110
Pixels
editing, 37
plagiarism, 171
pr, 97
Primitive
definition, 15
Primitives
definition, 14
list of, 14
Print, 97
differences from insert, 103
Print and Insert
differences, 98
Printing
Projects, 43
the Page, 43
Procedure
as a key idea, 147
main, 157
more than one, 149
number of, 148
parts of, 146
startup, 168
top-level, 157
Procedure tree, 157
example, 156
rules for creating, 158
Procedures
merging, 169
Procedures area, 19
Procedures Page
accessing, 13
Procedures tab, 145
inserting comments, 149
Processes tab, 20, 159
Programming colors, 127
problems with, 141
Project
as MicroWorlds Pro document, 8
changing name, 10
closing, 10
design, 161
map, 163
new, 10
opening, 10
saving, 10
Project tab, 19
Properties
of Text boxes, 89
pu, 41
QuickTime Movies, 111
Quotation mark, 55
Random, 139
Random numbers, 139
Recording tool, 26
Rectangle tool
in Graphics tab, 31
Regular Pointer
in Shapes palette, 47
Regular pointer tool, 27
Remove, 109, 168
Page, 13
Removing
Buttons, 62
Pages, 168
sounds and melodies, 109
text from Text box, 98
Repeat, 66
Reporter, 139
Resizing
Buttons, 60
right, 40
Rotating shapes, 52
rt, 40
Running code
in Text boxes, 100
Save Project As
using, 10
savepict, 130
Saving
plan for, 43
Index

possible problems, 43
Projects, 10
Scissors tool
  using, 62
Scrapbook
  using, 133
Selecting
  Buttons, 60
  Sliders, 120
  Text box, 87
Selector tool
  in Graphics tab, 34
Setbg, 139
Setbg and fill
  differences, 139
Setc, 138
setinstrument, 111
setpensize, 137
Setsh, 55
Setsize, 55
Shade slider, 23
Shape Editor, 51
Shape of Turtle
  changing, 47
Shape size
  changing, 49
Shapes
  changing height, 54
  changing shape, 54
  changing size, 54
  changing width, 54
  copy error, 136
  copying, 51, 169
  creating new, 53
  editing, 51
  loadshape, 57
  merging, 169
  modifying, 52
  original, 51
  pasting, 51
  restoring original, 51
  rotation, 52
Shapes palette
  restoring, 56
Show balloons, 19
Showing
  Text box frame, 89
  Text box name, 89
Sizing
  Text box, 87
Slider
  changing slowly, 118
  opacity, 30
  shades, 30
  value of, 118
Slider tool, 26, 117
Sliders
  changing properties, 121
  changing size of, 120
  copying, 120
  creating, 117
  in Graphics tab, 30
  moving, 120
  names of, 118
  opacity, 23
  removing, 120
  selecting, 120
  setting maximum, 121
  setting minimum, 121
  shade, 23
  showing/hiding name, 121
  size of, 120
  using, 119
  value of, 118
Sound
  in Projects, 156
Sound effects
  using note, 114
Sounds
  built in, 105
  formats, 105
  in procedures, 148
  playing, 105
  playing with spaces in names, 106
  recording, 105
  removing, 109
  system, 105
Spaces, 43
Spray tool
  in Graphics tab, 33
Stamp, 55
 Stamper tool
  movie frame, 113
Stamping
  problems with, 50
  Turtle shape, 48
Starting MicroWorlds Pro, 5
Startup, 168
Stop tool, 27
Stopall, 141
Stopping
  action on a Page, 141
  Button, 65
Subprocedure, 157
Superprocedures, 157
Switching Pages, 168
Tab Area, 19
  brush shapes, 22
  color tools, 23
  color viewer, 23
colors, 23
Graphics tab, 21
Procedures tab, 19
Processes tab, 20, 159
Project tab, 19
sliders, 23
Talkto, 74
Text
copying, 83
cutting, 83
Deleting, 83
entering, 82
formatting, 84
in background, 90
moving, 83
on the Page, 82
printing in Text boxes, 97
removing, 98
Text box
copying, 88
creating, 81
cutting, 88
entering text, 82
formatting text in, 84
making active, 99
modifying properties, 89
Moving, 88
printing in, 97
properties of, 89
running code in, 100
selecting, 87
size of, 82
sizing, 87
too much text in, 98
transparent, 90
using names, 99
Text box frame
showing/hiding, 89
Text box name
showing/hiding, 89
Text Box tool, 26
Text menu, 12
Tool
Button, 26
De-magnifier, 27
Eye, 27
Hyperlink, 26
Magnifier, 27
Melody, 26
Recording, 26
regular pointer, 27
Slider, 26
Stop, 27
Text box, 26
Turtle Hatching, 26
Video, 26
Toolbar, 10, 25
De-magnifier tool, 49
Magnifier tool, 49
parts of, 25
Scissors tool, 62
Turtle Creation Tool, 39
Tools
general, 25
general editing, 25
Object creation, 26
Turtle Hatching, 26
Top-level procedure, 157
Tracing commands, 20
Transitions
using, 166
tto
with objects, 74
Turtle
active, 73
creating, 70
Deleting, 70
drawing with, 38
for moving objects, 64
inheritance, 71
names, 70
renaming, 70
setting the direction, 65, 66
which one active, 74
Turtle Creation Tool, 26, 39
Turtle dialog box, 69
Turtle drawing
with Buttons, 62
Turtle hatching, 39
Turtle name, 69
Turtle shape
stamping, 48
Turtle Shape Editor, 24
Turtle shapes
changing, 24
Turtle size
changing, 49
limits of, 55
Turtles
animation with, 77
as Buttons, 78
as objects, 59
layered, 59
naming, 75
programming, 77
Type families
available, 12
where found, 13
Up Arrow
to repeat instructions, 40
Value of Slider, 118
changing slowly, 118
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video tool</td>
<td>26</td>
</tr>
<tr>
<td>Vocabulary</td>
<td>16</td>
</tr>
<tr>
<td>finding</td>
<td>14</td>
</tr>
<tr>
<td>Wait</td>
<td>73</td>
</tr>
<tr>
<td>length of</td>
<td>73</td>
</tr>
<tr>
<td>who</td>
<td>79</td>
</tr>
<tr>
<td>Word wrap</td>
<td>82</td>
</tr>
</tbody>
</table>